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INTERMEDIATE INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

e Review and report on project information
¢ Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

¢ Manage quotes and use additional time-saving tools

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:
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Course Lessons

Lesson Topic

Lesson8  Quote Management
Lesson9  Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration
Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost ltem Assemblies

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Objectives  Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.
Step by Walk you through the “mechanics” of how to perform specific functions in the
Steps software. For each step by step, you will use the Training Job that comes pre-

loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.
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TIP Tips are for important notes and information you want to remember.

o= Notes are for critical information you need to know.

Ongoing Use
This manual is also designed to be a comprehensive reference guide you can use outside of the

classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 8 — QUOTE MANAGEMENT

Lesson Duration: 60 Minutes

Lesson Objectives

After completing this lesson, you will be able to:
¢ Create and publish RFQs
» Define quote pricing
e Compare and award quotes

e Create and analyze scope items

Lesson Topics
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8.1 QUOTE MANAGEMENT OVERVIEW

8.1.1 Quote Management Workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

TIP Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:
1. Creating and publishing Requests for Quote (RFQs)
2. Updating quotes with vendor/subcontractor pricing
3. Comparing and awarding quotes
InEight Estimate has a separate form to manage each step:
1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

Quote

Comparison
& Award

8.1.2 Quotes and Quote Groups

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.
2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

Resource Rate Register ©

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies Unique

oL oeon = it et
+ IECT Cooling Towers Process Equipment Install Standard Instaled Equipment Rate... | Each
+ IEFC Feeder Controls Landscaping Work Standard Installed Equipment Rate... | Each
+ IEHS Heating System Process Equipment Install Standard Installed Equipment Rate... | Each
+ IEPHP Pump High Pressure Commercial Work Standard Installed Equipment Rate...  Each
+ IERMT Raw Material Tank Concrete Materials Standard Installed Equipment Rate...  Each
+ IERS Recovery System Process Materials Standard Installed Equipment Rate... | Each
+ IEST separator Tank Process Materials Standard Instaled Equipment Rate... | Each

8.1.2.2 CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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257 = Description

Position Code =

Forecast

(T/c)
Quantity

1.00
1.00
1,00

1,000.00

200,00

1,000.00

8.2 REQUESTS FOR QUOTE

Estimate Intermediate User Guide

Unit of
Measure
Lump Sum
Each

Each

Linear Feet
Linear Feet

Square Feet

Quote Group T

Structural Painting
Process Equipment Install
Commerdal Wark
Guardrail Work

Guardrail Work

Sign Work

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or

services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the

line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 Request for Quote (RFQ) Register Overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

File Setup Estimate Quote

I ® (= Quote Group Tags @

I i
) Minority Setup
Address Reguest For | Quotes
Book Attachments Quate (RFQ)
Setup Quote Management

Execution System

A
5 [

Actions

Resources Cost Items

Quote Comparison & Award

[

Reports

Reports

¢ The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response

Deadline Date
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Cost Breakdown Structure (CBS) i Rate i | for Quote (RFQ) Register @ |

Drag columns here to group

Desaription = Status Response Response Published RFQ Buyer's

Deadline Date Deadine Time Date Instructions Spedial Terms D D2 foals o=

MNew 1f3/2020 11:00 AM D D D

8.2.2 Request for Quote (RFQ) Record

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Description = Status EE:IS‘I?::EDate
..... 0
. [3_Open
@ New
9 Delete
3 Cut
& Copy
I_'—}, Paste
IS Eill Down
L Link this field to Excel
&4, UnLink from Excel

Overview - Request for Quote (RFQ) Record

e e

1 RFQ Each record contains a Description, Deadline Date and Deadline Time
Description  fields to identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the
quote, terms & conditions, and the seller companies to receive the RFQ.

3 Statusand  The Status and Published Date let you know if it is new or published (sent
Published out), and when it was published.
Data
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Request for Quote (RFQ) Record & =

Description Status
Guardral Items New
Published Date
Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup |

Resources Cost Items

Drag columns here to group Saved views: | Standard View - ,D
CBS = Quote Group - Optional - .
Position Code = RECIE Tag = Code pescpc Quantity

= A1 o 6.1 Guardrail Work 1500 0100 Guardrail Typ... 1,000.00
6.2 6.2 Guardrail Work 1500 0200 Guardrail Typ... 200.00

Cancel New... < Prev Next =

8.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

¢ Create RFQ from scratch: This creates an empty RFQ Record for you to define

e Create RFQ from Quote Group Tag(s): This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once

¢ Create RFQ using Default Seller data: In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

Cost Item Identification

Usethe following field; CBS Position Code -

Please select from the following options:

D ipti
(@) Create RFQ from scratch Escription

() Create RFQ from Quote Group Tag(s)

Only show Quote Group tags that
are currently utilized in this job

On the resulting RFQ record, only
list resources with utilization
currently greater than zero

() Create RFQs using Default Seller data

This option scans the job for all
Resources and Quote Groups
utilized in the job. For any that are
listed inthe Address Book as
'Default Quotes’ for the Sellers you
select on the subsequent selection
register, a new RFQ record will be
added for each Seller listing their
default items.

Create separate RFQ records faor
each Quote Group, per seller?

Ok Cancel

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3.1 Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,

Quantity, Quote Group, Currency and other user-defined tags.

InEight Inc. | Release 24.3
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Response Deadline Date:

Line Items

Terms & Conditions

Resources

Cost Ttems

Drag columns here to group

cBs .
Position Code = RFQID
= 6.1 & 6.1
6.2 6.2

Quote Group _ COptional
Tag = Code
Guardrail Work 15000100
Guardrail Wark 1500 0200

8.2.3.2 Terms & Conditions

Description

Guardrail Typ...
Guardrail Typ. ..

Estimate Intermediate User Guide

/25 2003 - Respaonse Deadline Time: |11:00 AM

Vendor Companies Attachments Setup

Quantity

1,000.00
200,00

Unit of
Measure

Linear Feet

Linear Feet

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

Response Deadline Date: | 7/29/2009 -

Response Deadline Time: [11:00 AM

Line Items Terms & Conditions endor Companies Attachments Setup

Buyer's Spedial Terms & Conditions

‘ Any penalites assessed by the owner due to quality control compliance deviations by the supplier will be deducted from the supplier's payment.

RFQ Instructions

lease contact site super John Smith @ 623-555-6982 for delivery instructions.

8.2.3.3 Vendor Companies

New... < Prev Next >

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store all
of the pertinent contact information for each seller, including their fax number and/or email address

so that you can send them the RFQ.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

Cir=m e ireme Fere 20 Arenr
Drag columns here to group

Vendor Contact == Status ?thlal?'ll':SIQ-luan fties Vendor Phone
= 5UB18 SIB18 - Mel Blank Mew W 111-222-3232

sSUE4 SUE4 - Harry Belefony Mew o 111-222-1111

Venl3 Ven 13 — CARRIE Matty Mew W 111-333-3434
» ]

The following options are particularly noteworthy:

¢ Publish Item Quantities: If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

¢ Publish by Fax: If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

[l When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

¢ Publish by Email: If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not

give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 &AM
Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group Saved views: Previous View - ,C)
File Mame =N Description Location File Type File Size Attached By Date Attached
plumber quote.pdf plumber quote  Job Folder Adobe Acrob... 166875 Paul Trippi@ine...  7/31/2023 11:08:21 AM

=

8.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

Description

Guardrail Items

ResponseDeadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line [tems Terms & Conditions Vendor Companies Attachments Setup

Tag 1: Notes
Tag 2: -
Tag 3: -

RFQ Publication Settings
Cost Ttem Identifier: CBS Position Code -

Include RFQ Instructions

Include Buyer's Special Terms & Conditions
Include Notes

(] Include Attachments

Publish Ttem Quantities
Publish To File
Publish By Email
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8.2.6 Publish an RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ
Record ribbon.

Step by Step — Create and Publish an RFQ

Open your job.
From the InEight Estimate landing page, select the Quote tab.
Select Request for Quote (RFQ).

From the Actions tab, click on the New icon to create a new RFQ.

a w0 o=

Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
guote groups and resources that are being used.

6. Select a description from the panel.

InEight Inc. | Release 24.3 Page 27 of 257



8.2 Requests for Quote

Cost Item Identification

Usethe following fieldy CBS Position Code

Flease select from the following options:

() Create RFQ from scratch

Estimate Intermediate User Guide

(@ Create RFQ from Quote Group Taals)

Only show Quote Group tags that

are currently utilized in this job

On the resulting RFQ record, only

list resources with utilization
currently greater than zero

() Create RFQs using Default Seller data

7. Click OK.

This option scans the job for all
Resources and Quote Groups
utilized in the job. For any that are
listed inthe Address Book as
'Default Quotes' for the Sellers you
select onthe subsequent selection
register, a new RFQ record will be
added for each Seller listing their
default items.

Create separate RFQ records for

OoOoooooodoonon

o

Description

[Uncheck All]
[Blanks]

Asphalt Materials
Commerdial Wark
Concrete Materials
Guardrail Wark
Landscaping Work
Manhole Materials
Maone

Painting Materials
Pipe Materials
Process Equipment Install
Process Materials
Sign Wark
Structural Painting
Aggregates

]

¢ The Request for Quote (RFQ) Record is created with two aggregate line items

¢ The Description field is automatically filled with the name of the quote group
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Description

Agaregates

RezponseDeadline Date: | 12/27/2018 - Respaon:
Line Ttems Terms & Conditions Seller Companies Attact
Resources Cost Items

Drag columns here to group

Quote Group
Tag

= MBR Aggregates Aggregate B...
MDIRTE Aggregates Dirt Class B

8. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 2:00 pm).

Code = — Description

Response Deadline Date: | 7/29,/2009 - Response Deadline Time: |[11:00 &AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

9. Select the Terms & Conditions tab.
10. Create and type in any special conditions in the Buyer’s Special Terms & Conditions field.

11. Type in instructions in the RFQ Instructions field.

ResponseDeadline Date: | 7/29/2009 - Response Deadline Time: |11:00 AM

Line Items Terms & Conditions Wendor Companies Attachments Setup

Buyer's Special Terms & Conditions

Any penalites assessed by the owner due to quality control compliance deviations by the supplier will be deducted from the supplier's payment.

RFQ Instructions
| Please contact site super John Smith @ 623-555-6982 for delivery instructions.

12. Select the Seller Companies tab and click in the first blank row in the Company Name column.
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13.
14.
15.

16.

Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group

Vendor Contact = Status IPthla?'il':SSuanﬁﬁes Vendor Phaone

SUB13 SUE 18 -- Mel Blank Mew b 111-222-3232

SUB4 SUB4 - Harry Belefony Mew W 111-222-1111

Venl3 Venl1d -- CARRIE Matty Mew " 111-333-3434
s 1) 0

Click OK.
Make sure Publish to File is checked for all vendors.

Select the sellers to whom you want to send the RFQ.

Company First Last
Mame Mame Mame

Example Vendor 1 — Pat Roberts

Example Vendor 2 — Stan Mark

Example Vendor 4 DBE — Lester Slim

17. Under the Actions tab of the record, select Publish to create your RFQ document.

File Setup Quote Price Execution System Actions

=] Publish

@ Create Quote

Process

Cost Breakdown Structure (CBS) Regist R st for Quote (RFQ) Register Request for Quote (RFQ) Record ©
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¢ Select a location to save the RFQ.

@ save s X
<« A E] » ThisPC » Documents Search Documents
Organize = MNew folder Ez w o
" Mame Status Date modified Size
~ 3k Quick access
My Projects
[ Deskto -
P [I5Express
* Downloads My Web Sites
|| Documents # Snagit
=] Pictures -+ Visual Studic 2019
5 0SDisk (C)  # Visual Studio 2022
APIM Custom Office Templates
Estimate July 7 Camtasia

File name: | Example Vendor 1888 RFQ - Training Job - quote.doc
Save as type: | DOC files (*.doc)

# Hide Folders Cancel

e MS Word opens the file automatically for you to review; and from here you can either
print it or send it in an email as an attachment
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Estimate Intermediate User Guide

TO:

Name:
Company:

Phone:
Mobile Phone:
Fax:

Email:

REQUEST FORQUOTATION

Job:  Training Job Trairing Job - Maricopa County Mo, TM2324

Tom Cross

Example Prime Contractor 1
400 First Streat Suite 4000
Hometown, AZ 832004

111122111

FROM:

Fat Roberts Name:
Exampla Yendor 1 Company:
100 Tenth Street
Hometown, AZ B200G0
111-122-2134 Phone:

Mabile Phone:
2221231234

Email:

Fax: | 222-112-2211

Job Information:

Training Job
Training Job - Maricopa County No. TM2924

Owner: Example Owner

Job Type: Highway and General Engineering
Job Location: 1-10 MP 100 to MP 120
City: Phoenix

County: Maricopa

State / Province: Arizons

Country: United States

Bid Location: Engineer's Office

Bid Date: 1/8/2020

Bid Time: 10:00 Pt
Measurement System: English

Raniact far Dunta (REFND) Infarmatinn-

18. Click OK to save the RFQ Record.

8.2.7 RFQ Email Draft

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to

subs and suppliers.
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RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924 - Message (HTML)

File Message Insert Options Format Text Review Help @ Tell me what you want to do
[y ~ | TimesNewRov (12 v/ B T U & -~ A - == . = . & 3= r@p‘f‘ b & 1 L B B
F]
B> To Charlie Bravo
Send Ce
Subject RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924

REQUEST FORQUOTATION

Job: Training Job-1 Training Job - Maricopa County No. TM2924

TO: FROM:

Name: | Harry Belefony Name: | Tom Cross

Company: | Example Sub #1 Company: | Example Prime Contractor 1
600 First Street Suite 5000 400 First Street Suile 4000
Hometown, AZ 889006 Hometown, AZ 889004
Phone: | 111-222-1111 Phone: | 111-122-1111
Mobile Phone: Mobile Phone:
Fax: | 222-221-2212 Fax: | 222-112-2211

Email: | charlieb1234@example.com Email:

Job Information: Training Job-1
Training Job - Maricopa County No. TM2924

Owner: Cwmer
Job Type: Highway and ral Engi ng
Job Location: I-10 MP 100 to MP 120
City: Phoenix
County: Maricopa
State / Province: Arizona
Country: United States
Bid Location: Engineer's Office
Bid Date: 1/6/2020
Bid Time: 5:00 AM

Request for Quote (RFQ) Information:

Publication Date: &21/2020 3:57 FM

Response Deadline Date: 77292009 11:00 AM

8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.
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8.3.1 Sample Received Quote Scope Sheet

Overview - Received Quote Scope Sheet

I T S

1 Section one Scope item one includes 4 items the subcontractor has considered as
work to be done onsite. You may want to consider adding all 4 items as
individual quotes. Then creating a package identifying these quotes as
on-site work, totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as
work to be done offsite. You may want to consider adding all 3 items
as individual quotes. Then creating a package identifying these quotes
as offsite work, totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.
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8.3 Quotes

Received
Quote Scope Sheet

DATE: 12/19/2019
PROJECT: TRAINING JOB TRAINING JOB - MARICOPA COUNTY NO. TM2524
LOCATION: PHOENIX, AZ

SITE CONCRETE: FORM, SUPPLY AND INSTALL

ONISTE IMPROVEMENTS

Vertical Curb; Curb and Gutter; Valley Gutter w/ rebar

4" thick broom finish walk with wire mesh; ramp w/ domes
Flow-Through planer slab and walls

L=

colored aggregate finish (1 location only @ 16% street entrance)

Price: $203,300
OFFSITE IMPROVEMENT 5
1. Curb and Guiter
2. HC Ramps w/ domes; planter w/ rebar
3. 367 x 36" patterned finish walk w/ wire mesh
Price: $24,650
EXCLUSIONS:
1. Layout of Ii and grades
2. Site grading
3. Aggregate base and/or compaction; sand cushion
4. Sealants, caulking and waterproofing; precast items
5. Misc post footings and masonry wall footings
6. Supply of embedded iron or metal
7. Demolition
8. Traffic control and pedestrian protection

QUALIFICATION
1. Price valid for bl days

2. GC will provide a concrete pump washout area
3. 5% retention will be released 45 days after completion of our work

by others. Price based on rock being placed prior to piles, pilecaps and grade beams.
$24,100

This proposal is good for thirty (30) days from the data herein, after which time Summit Construction reserves the
right to review the proposal for any changes in price. Please call me if you need any further information.

Rick
Estimator

&" thick crosswalk paving with rebar 36" x 36" pattern broom finish and 18 x 36" pattern

Alternate Price to furnish and install 4" aggregate base under parking structure lab. Sand

8.3.2 Quote Register Overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the

Quotes icon on the toolbar.

InEight Inc. | Release 24.3
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Quote Register @

Drag columns here to group

Description - gzgcnphon S;l:‘es Seller Company ?;;‘I.‘E ?;\;:rl'dad Currency
Aggregates Aggregates Accepted Example Vendor 1 --PatRob... Example Vendor 1 $402,192.00  $402,192.00 U.S. Dollar
Agaregates Aggregates Accepted Examh Vendor 4 DBE - Les... Example Vendor 4 ... 40,00 0,00 U.S, Dallar
Aggregates Aggregates Accepted Example Vendor 2 -- Stan Mark  Example Vendor 2 £0.00 $0.00 .S, Dollar
/% asphalt Materials Accepted Example Vendor 1 - PatRob... Example Vendor 1 $1,115,97...  $1,102,50... U.S. Dollar
/% Asphalt Materials Accepted Example Vendor 2 -- Stan Mark  Example Vendor 2 §1,263,17... £13,671.00 U.S. Dollar
Electrical Work Electrical Work ~ Accepted Architectural Designs, Inc. —... Architectural Desig... $4,200.00 $0.00 U.S. Dollar
Electrical Work Electrical Work | Accepted HD Engineering Group -- Rog...  HD Engineering Gr... £4,450,00 £0.00 .S, Dollar

8.3.3 Quote Record Overview

The Quote Record establishes who the vendor is, along with quoted prices and all terms and
conditions. Once a requested quote returns, you can either create the quote in InEight Estimate from
scratch or convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each
Quote Record contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
guote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Overview - Quote Record

I T

1 Header  You can include detailed contact information about the supplier or
block subcontractor. This automatically fills when you select the seller from the
Address Book. The External Ref field can be used to access information
specific to the bid/quote.

2 Price The Price data block contains a breakdown of pricing information for the
block quote, including taxes, item conditions, and special conditions.

3 Quote The tabs at the bottom of the screen hold detailed information regarding the
tabs quote.

4 Default Data blocks include Special Terms & Conditions, Qualifications, Packages,
Data Taxes, Vendor's Profile, Setup, and Minority.
Blocks

Page 36 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide

Quote Record ©

Header o
Description: [ Pipe Materials Optional Code:

o

Total

Extended Price:
Ttem Taxes

Quote Tax:

Bond

Ttem Conditions:
Special Conditions:

Total:

8.3 Quotes

2]

$0.00
$0.00

$0.00

$0.00

Date: | 7/20/2023
Vendor: | 1128354 Aberta Ltd 0010 {t]| Vendor Name: 1128354 Alberts Ltd Vendor Phone: 780-920-3163 Source
Contact: | <Ad-Hoc Contact> 2 First Name: Contact Office: Currency: | U.S. Dollar
Primary Email | Last Name: | Contact Mobile: Status:  Incomplete
External Ref.: Ignore: [] Reason:
Resources | CostItems e Special Terms & Conditions
Drag columns here to group Saved views: | Standard Vie ~| S| Buyers special Terms & Conditions
Code=  RFQD QuoteGrowp = | 2% pescripton NoSpit  Free  Awarded  Duration
: i q p— 7 [ Vendor's Special Terms &Conditions
2 2 2 pay item 2 v
> & -
Special Conditions Adjustments:
Distribute Special Conditions: (O Evenly
Include Special Con:
. , | Special Terms & Conditions ~ Qualffications  Packages  Taxes

8.3.4 Header Block

ditions costs forunawarded quo

$0.00

Using

Vendor's Profle  Setup  Minority

Cancel New...

The Header block portion of the screen is where you enter in description information pertaining to the

quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote

attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

¢ Optional Code — a code used to reference the received quote.

¢ Date — date the quote is received.

e Source — this is the method by which the quote was received. The options are email, fax, hard

copy, phone, and other.

¢ Currency — system of money in general use for a particular country..

¢ Ignore — by ignoring the quote, and providing a reason, the quote will turn grey in the Quote

Comparison & Award screen.

8.3.4.1 Quote records

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with

Platform’s shared master data.

InEight Inc. | Release 24.3
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Quote Record ©
Header
Description: | Asphalt Materials
Vendor: | 1128354 AbbertaLt... {2l|| VendorName: 1128354 Alberta Ltd Vendor Phone: 780-920-3163
Contact: | Alberta - Frank Ma... iz First Name:  Frank Contact Office:
Primary Email: Frankmatty@gmail.com Last Name: Matty Contact Mobile:

External Ref.: Address Book Register - Library

x| Enter text to search..

Drag columns here to group

Vendor ID

Vendor Name

Vendor Type

Tax ID

Tax Jurisdiction

Address 1

> 0010087554 1 alliance Geomatics LLC 2001 451564451 4303300400 12614 120th Ave NE -
+ 1 NP-Vendor2 1 NP -Vendor2 1_NP Vendor 12345 abe 90th Street
+ 1 NP -Vendorl 1_Vendor1 1_NP Vendor
+ 1NP-Vendori  1_Vendorl 1_NP Vendor
0010099954 10X Engineered Materials LLC 2001 B24568213 1516913100 1162 Mancheser Ave
0010052554 10X Engineered Materials LLC 2001 824568213 1516913100 1162 Mancheser Ave
. »
Cancel

Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can

report on which vendors and contacts have been awarded quotes or run a report on how many RFQs

have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.

Examples include seeing how many subcontract agreements have been executed in InEight Contract,

or how many claims/issues a vendor has been involved with in InEight Change. The predominant value

for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

8.3.5 Price Block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item

conditions, and special conditions.

8.3.6 Quote Record Tabs

8.3.6.2 Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated

guantities and units of measure.
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e A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

¢ If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

» Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

¢ A note field is included for explanation changes

* A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

¢ You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

Find: | [SearchFor...] | saved views: | Previous Vien

Unit of e Extended
Price

Package = AFQD Qe n Ootond pesaiption NoSpit | Free  Awarded  Du Quantty  patet

31 3.1 3.1 Excavation, scrapers v 50,000.00  Cubic Yard $0.00 .00
P1 3z 3.2 3.1 Excavation, trucks v 50,000.00  Cubic Yard P1 PL  $200,000.00
P1 3.3 3.3 3.2 Embankment 7 50,000.00  Cubic Yard P1 P1L

v

P1 3.4 3.4 Rock Excavation 3,000.00  Cubic Yard P1 P

Cost item tags and user defined fields

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined
fields that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.

$30.200.00
om0

000

$30,200.00
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8.3.7 Data Blocks

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back

to the default setting, which shows all six data blocks.
Data Block tabs include:

¢ Special Terms & Conditions

e Qualifications

e Packages

e Taxes

e Vendor's Profile

e Setup

¢ Minority

File

.'-]‘: Package Entire Quote C r- -

Refresh Default | o
Data Blocks

Setup Estimate Quote Price

Actions
|

Edit Tools View /

The seven data blocks appear at the bottom right of the screen.
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Special Terms & Conditions

*
Buyer's Special Terms & Conditions
Vendor's Special Terms & Conditions
Special Conditions Adjustments: | SU.DEI|
Distribute Special Conditions:  (_) Evenly (@) Using Weighted Average
Include Special Conditions costs forunawarded quotes in Comparable Totals
Drag columns here to group Saved views: |i Standard View e | p
[Eow =2 Scope Item Quote Group = Included Amount % of Total MNotes
Number
%0.00

-

Special Terms & Conditions  Qualifications  Packages Taxes \Vendor's Profle  Setup  Minority

It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

Special Terms & Conditions

drag and move

Buyers Specia g & Conditions

Seller's Special Terms & Conditions

Drop the data block on top of an arrow where you wish to land the data block.
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Qualifications
Bond
|:| Vendor can provide a BOND for all work quoted

e ——
T —
sonangpones [

[[] addBond Costto the Quote
Costof BOND to be added to quoted price:

Rate/§1,000: -

$0.00

Bond Cost: $0.00

Insurance

[4] vendor's Special Terms &Condi

[[] vendoris INSURED as required by applicable law [

e compary: [

Qualifications Packages Taxes Vendor'sProfle Setup  Minority

Cancel

Special Conditions Adjustments: [_ v
e e [

New...

The data block will now reside on the left side of the screen.

Estimate Intermediate User Guide

< Prev Next >

Quote Record ©
Header
Description: | Pipe Materials Optional Code: l:
Date: | 7/20/2023
Vendor: | 1128354 Alberta Ltd -- 0010... EEI| Vendor Name: 1128354 Alberta Ltd Vendor Phone: 780-920-3163 Source:
Contact: | <Ad-Hoc Contact> iml First Name: I:I Contact Df‘ﬁce:l | Currency: ‘us.oolar
Primary Email: I I Last Name: ‘:I Contact Mobile: | | Status: Incomplete
External Ref.: I

| Ignore: [] Reason:

| Special Terms & Conditions

Buyer's Special Terms & Conditions

[ vendor's Special Terms & Conditions

Special Conditions Adjustments: $0.00
Distribute Special Conditions: () Evenly (@) Using Weighted Average

E Include Special Conditions costs forunawarded quotes in Comparable Totals

Drag columns here to group Saved views: | Standard View

Row

Number =1 Scope Item Quote Group = Included Amount % of Total

Resource g
-}m
Code = R
1 1
2 2
> &

Qualifications

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab

(like Special Terms & Conditions) and select close.
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Qualifications
Bond
DVendnr can provide a BOND for all work quoted

[[] Add Bond Costto the Quote
Cost of BOND to be added to quoted price:

Rate/§1,000: | $0.00
Bond Cost: 50.00
Insurance

DVendnris INSURED as required by applicable lav

Insurance Company:
Insurance Agent:
Packages

Taxes Vendor's Profile
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g Float
Dock

Spedal Terms & Co ol
Cloze

8.3.8 Data Block Tabs

8.3.8.3 Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.

Special Terms & Conditions b4

Buyer's Special Terms & Conditions

Vendor's Special Terms & Conditions

Special Conditions Adjustments: | SEI.IJE||

Distribute Special Conditions:  (C) Evenly (@) Using Weighted Average
Indude Spedial Conditions costs forunawarded guotes in Comparable Totals

Drag columns here to group Saved views:  |:Standard View i ,C)
Lo = Scope Item Quote Group = Induded Amount % of Total MNotes
Number

$0.00

4

Special Terms & Conditions | Qualifications Packages Taxes Vendor's Profle  Setup  Minority

8.3.8.4 Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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Qualifications X

Bond ~

Vendor can provide a BOND for all work quoted

Bonding Company: ' ‘

Bonding Agent: |American |

Bonding Phone: |

Add Bond Costto the Quote

Cost of BOND to be added to quoted price:

Rate/$1,000: $0.00 |
Bond Cost: | $330.00]
Insurance

[] vendoris INSURED as required by applicable law

Insurance Company: I

Insurance Agent: |A merican

Insurance Phone: |

License
[[] vendor is LICENSED to perform all work quoted

Licensor: ‘ ‘

ID: |EZ-Licinse-_&1 |

Class:

W

Special Terms & Conditions  Qualifications Packages Taxes Vendor'sProfle Setup  Minority

8.3.8.5 Packages

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package
code is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.

As an example, the following Civic Center Parking Structure quote has three packages defined in it. The
P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine the
package structure in the quote record. The vendor that submitted this quote shows detailed estimates
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defined for each of the three packaged items, but there is no breakdown provided in the quote of how
much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).

Civilworks Inc. Phone (758) 555-9854

125 Maple 5t

seonedale. A2 Civic Center Parking Structure
Dml!!r.llltf'l.lm Addendum 1-6
md’m Price
DEMOLITION, EXCAVATION AND GRADING (PARTIAL) $150,780.00
Site Clearing of trees and bushes
Demo of AC Paving, Concrete Curbs and Walks
Sawaut AC Paving and Concrete

Remaove storm drain, 55, CB's, MH & pole bases
P1 Rough grace parking structure pad, commerical pad
Place 12" non-expansive fll

Fine grade pads

Demo and remove 16th street curbs and paving
Grade for new roadway

Grade for exterior concrete sidewalks

2 mobilizations ’
Site Clearing of trees and bushes

P2 Demo curbs, excavate for paving

Demo median on 16th Street, place temporary paving section
Patch pave parking lot with 3° AC over 6" AB

PAVING (PARTIAL) $139,900.00
P3 Place aggregate base for AC Paving, curbs and walks
Place 5° asphalt conrete section
Key Exclusions: sturry seal, striping, fencing, concrete work
OTHER ITEMS
Load out stockplled dean spolls £26.00/CY
Grade, fabric, place 4 AB for contractor parking (63,000 SF) $0.85/SF
Excavate Duct Bank 45,900.00
Patch pave AC outside pave area (500 SF) $8.00/5F
STANDARD EXCLUSIONS:

Any permits, fees, inspections, plans, bond premiums, soll testing, elc.

Amy hard rock excavation. (Hard rock Is defined as unable to be removed by CAT D6 or CAT 325
Excavator)

Any trenching for footings of bullding or masonry structures.

Ay temporary fencing or trench plating,

Ary export of materials other than spedfically included offhauls.

Spoils over 127 in diameter will be offvauled at an additional agreed to cost.

Ary structure demolition or removal. (Concrete, asphalt, fencing, trees, bulldings, signs, masonry)
Arry and all landscape repadr, Installation, or removal

Any storm water pollution prevention or erosion control unless spedfically mentioned.

Base rock under concrete wallways or bullding slab areas unless spedifically mentioned

P b

SuRNMAL

-
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then

assign the price to that collection of packages. It then proportionally distributes the total package price

across all of the corresponding cost items when comparing and awarding.

Quote Register Quote Record ©

Header

Description: | Site work

Total

Optional Code:

Date: -
WVendor: | Civilworks Inc. - Ven 07 ® [8] Vendor Name: | Civilworks Inc. Vendor Phone: 480 555 5698 Source: -
Contact: | Civilworks Inc. - John Jacobs e First Name: | John Contact Office: Currency: | U.S. Dollar -
Primary Email: jacobs jacobs@civilworks.com Last Name: |Jacobs Contact Mobile: Status: Received
Bidernal Ref.: | Ignore: [] Reason:
Resources | CostItems Packages
o ] ] [ ——
Code = Description Amount
Package = Code = gr“;:s gg“:"a' Description No Split Duration Quantity Unit of Measure Unit Price E?i”d‘ad Curry P1 Demo,Exav,Grading 515'3-730‘DD|
T [p2 Assisted Parking Lot | $43,535.00 |
P1 13.1 131 Excavation M 1 50,000.00 CubicYard P P1 s10,780.00 US| " Pevng S13000.00
P1 142 1.42 Finegrade Subgrade R 1 400,000.00 Square Yard P1L P1 us. "
P1 15 3034263 Asphalt Concrete Hot v 1 3500000 Ton P1 P1 us.
P1 16 131 Grading v 1 1.00  Cubic Yard P1 P1 .S,
= P2 (Assisted Parking Lot)
P2 41 Process Equi... 700 Process Equipment v 1 100 Each P2 P2 $43,535.00 U.S.
P2 421 421 Remove & Dispose Co. v 1 2.00 Each P2 P2 us.
P2 511 0220 Site Preparation v 1 100 Lump Sum P2 P2 us.
= P3 (Paving)
P3 17 13.1 Paving v 1 100 Cubic Yard P3 P3  $139,000.00 U.S.
3

Step by Step — Create a packaged quote

>

Extended Price:
Ttem Taxes:

Quote Tax:

Bond:

Ttem Conditions:
Special Conditions:

Totalk

You have received a quote from a vendor for a project and need to enter the quote into the Quote

register as a Quote record.
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Description of Work Price
DEMOLITION, EXCAVATION AND GRADING (PARTIAL) $150,780.00
Site Clearing of trees and bushes
Demo of AC Paving, Concrete Curbs and Walks
Sawcut AC Paving and Concrete
Remove storm drain, 55, CB's, MH & pole bases
Rough grace parking structure pad, commerical pad
Place 12" non-expansive fill
Fine grade pads
Demo and remove 16th street curbs and paving
Grade for new roadway
Grade for exterior concrete sidewalks
2 mobilizations .
Site Oearing of trees and bushes
Demo aurbs, excavate for paving
Demo median on 16th Street, place temporary paving section
Patch pave parking lot with 3° AC over 6° AB

Exciusions: conarete work, lighting
PAVING (PARTIAL) $139,900.00
Place aggregate base for AC Paving, ourbs and walks
Place 5° asphalt contrete section

Key Exclusions: sturry seal, striping, fending, conarele work

1. From the InEight Estimate landing page, select the Quote tab.
2. Click the Quotes icon under Quote Management.

3. Double click on an item (for example, Site Work).

Cost Breakdown Structure (CBS) Register Quote Register @  Quote Record
Drag columns here to group
== = Quote Quote
Description = Status Vendor Vendor Mame Contact Total

| Site work Received Lewis Concrete — V187 Lewis Concrete Lewis Concrete —- Robert Cantor — £343,731.63
& Pipe Materials Received Example Vendor 4 DBE -- Example Vendor 4 .. Example Vendor... Example Vendor 4 DEE --Leste...  §263,281.20
& Pipe Materials Received Ven10 Ven10 Ven10 - Tony LM £259,058.00
& Asphalt Materials Received Lewis Concrete — AAL Lewis Concrete <Ad-Hoc Contact= £1,115,975...

4. In the Description field, enter or replace the description.

5. Inthe Vendor field, select the Vendor Quick Add button to add a vendor on the fly, or select the
Library Address Book to select and existing vendor.
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Cost Breakdown Structure (CBS) Register Quote Register Quote Record ©

Header

Description: | Site wark

Vendor: || <Ad-Hoc Vendor> (@ [2]|| Vendor Name: I:

Contact: | £Ad-Hoc Contact> [+ R First Mame: I:
Primary Email: | | Last Name: I:
External Ref.: |

6. Click OK
7. In the Contact field, select the Contact Quick Add button to add a vendor on the fly, or select the

Library Address Book to select and existing contact.

Cost Breakdown Structure (CBS) Register Quote Register Quote Record ©

Header

Description: | Site work

Vendor: |Lewis Concrete - V187 (@ 2| Vendor Name: Lewis Concr

Contact: | <Ad-Hoc Contact> [ O] | First Mame:
Primary Email: | Last Name:

External Ref.: |

8. Click OK

9. Select the Cost Items tab on the left side of the screen.

Resources Cost Items

Drag columns here to group

Optional

Code = Code Description Quantity Quote Group

10. Click on the Code field to show the CBS selection window. Multi-select the cost items that you
want to bring into the quote record, and then select OK.
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Resources | Cost Items
& Cost Breakdown Structure (CBS) Register - 5J- Training Job

Package = Drag columns here to group x [ Enter textto search...
pimm ke 8 s oo Sty AL mom O
7 & _‘snewmnmmwn 200 100 Each $4,126,570.91 %4, ~
\ + 11 Excel Import Test 6410100 10,00 Ace $970.40
+ 12 Clearing & Grubbing 2010102 10,00 Ace £3,918.50 ¢
2 L3 Undassified Excavation 2020183 50,000.00 Cubic Yard $3.05 B
T
I
=
= I+

400,000.00  Square Yard
143 45,000.00 Ton $2.17 [

35,000.00 Ton

15.2 35,000.00 Ton $3.19 $,

one

11. Right-click and then select Add a New Package to create the package on the fly.

Resources Cost Items

Drag columns here to group

Optional

Code = Description RFQ ID Quote Group Code

Mo 5

xcavation
| % Open
1.4.2 Finegrade Subgrade
6 Delete
1.5 Asphalt Concrete Hot Mix
" S Cut
& Copy
Paste
Fill Down

6=

Link this field to Excel

UnLink from Excel

0
u

Add to Mew Package

Q@

Refresh [tem

12. Create three Packages as follows:
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Code:x |P1 |

Description: |Dem0,Exa'.',Gradirlg |

Amount: | 5150,?su.uu|

e Code: P1

e Description: Demo,Exav,Grading
e Amount: $150,780.00

e Code: P2

e Description: Assisted Parking Lot
e Amount: $43,535.00

e Code: P3

¢ Description: Paving

e Amount: $139,000.00

The Packages tab will look like this:

Packages

Drag columns here to group

Code = Description Amount

P1 Demo,Exav,Grading = $150,730.00

P2 Assisted Parking Lot £43,535.00
= P3 Faving $139,000.00

13. Right-click a column header, select Go To Column, and then select the Package column.
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Go To Column

Column:

M Custom Caption
[ Include caly

Currency

Default Tax Rate

e Description
1 Each Duration
Extended Price
1 Lump Sum
MNote
Tadkage
*®

14. select P1, P2, or P3 under the Package columns for each of the cost items. The P# equals the

T Code =
= P3
P2

Default Caption
Currency
Default Tax Rate
Description
Duration

Extended Price

Description Amount

Paving £139,000.00

Assisted Parking Lot $43,535.00
Visible
Yes
fes
Yes
fes

package code that you will enter based on the type of work being performed.

Resources | Cost Items

Drag columns here to group

Code & Description Quantity Quote Group E:Eﬂd&d Package Awarded
13.1 Excavation 50,000.00 P1  $150,780.00 | P1
= 142 400,000.00 P1 P1
15 Asphalt Concrete Hot Mix T 35,000.00 P1 P1
16 Grading 1.00 P1 P1
17 Paving 1.00 P3  $§139,000.00 P3
4.1 Process Equipment 1.00 Process Equipment ... P2 $43,535.00| P2
421 Remove & Dispose Contents 2.00 P2 P2
5.1 Site Preparation 1.00 P2 Pz
a / =
of Wark Prics
DEMOLITION, EXCAVATION AND GRADING (PARTIAL) $150,780.00
Site Ciaring of trees and bushes
D of AC Paving, Concrete Cs and Walks
Saweut AC Paving and Concrete
Rermove stom dran, S5, CB's, MH & pole bases
P |  roush grade porking structure pad, commerical pad
Place 127 nurexpansiva Fl
Fine grade pads
Demo ad remove 168h street curs anel paing
Grasse fos new rasdvay
Gradie for esterior concree skdevalks
2 mobitzations
ASSISSTED PAR
Site Oearing of trees and bushes
P2|  vem s, cemte forpaving
on Léth Sireet, e
Patch pave parking kot with 3° AC over §* AB
£ su, striping, fancing, concrete work, ighing
PAVING (PARTIAL) . $139,900.00
P3| rrace auorcoats base for AC Prving, cubs and walks
Place 5" asphatt section
ey Exclusons: sy soa), sinping, fncing concrete work

15. Group your cost items by Package so that your view is arranged by the package code and the

associated cost items.

InEight Inc. | Release 24.3

Saved views: | Previous View
Duraion | UnitofMeasre  UnitPrice  Currency ?:f;“:te

1| Cubic Yard P1 U.S. Dollar
1 Square Yard P1 U.S. Dollar
1 Ton P1 U.S. Dollar
1 Cubic Yard P1 U.S. Dollar
1| Cubic Yard P3  U.S, Dollar
1 Each P2 U.5. Dollar
1 Each P2 L.5. Dollar
1 Lump Sum P2 .S, Dallar

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

8.3 Quotes

Packages

1 Code =

h p Drag columns here to group

Desaiption
Paving
Assisted Parking Lot

Demo,Exav,Grading
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Resources Cost Items

Package = L

Package = Code = Description Quantty Quote Group E:iﬁd'&d

= P1(Demo,Exav,Grading)

P1 1.3.1 Excavation 50,000.00 P1 £150,780.00
P1 1.4.2 Finegrade Subgrade 400,000.00 P1

Pl 1.5 Asphalt Concrete Hot Mix T ... 35,000.00 Pl

P1 1.6 Grading 1.00 P1

= P2 (Assisted Parking Lot)

P2 4.1 Process Equipment 1.00 Process Equipment ... P2 £43,535.00
P2 4.2.1 Remowve & Dispose Contents 2.00 P2

P2 51.1 Site Preparation 1.00 P2

P3 (Paving)

16. Click OK.
17. Under the Quote Comparison and Award ribbon, select Cost Items.

18. Under Quote Groups, select Commercial Work. See 8.1 Quote Management Overview on page
18 for more information on quote groups.

* Quote Comparison and Award shows the newly created quote with the associated
package quotes.

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Costitems ©
Quote Group(s) X Drag columns here to group
M Descripion = Reviewed cBs _ ) Forec ] Lewis Concrete
Position Code — PR {T/0) & petal Site work
v Commerdal Work
1.3.1 Excavation 5, 2 %86,157.33 | & P1  $150,750.00
142 Finegrade Subgrade 401 : $75,848.36 | & P1
1.5 Asphalt Concrete Hot Mix Type A : %$3,221,162.41 | & P1
1.6 Grading 1 %5,451.61 | & F1
17 Paving 5 $5,451.61 | & P3  $133,000.00
4.1 Process Equipment : $1,630,388.68 | & P2 £43,535.00
4.2.1 Remove & Dispose Contents / : %$9,595.41 | & P2
511 Site Preparation oo : $3,664.55 | & P2

Scope Ttems

>
Summary

Minority Type DBE

Quoted Total / 50 $5,037,719.98 $333,315.00

Comparable Total < 42 %5,037,719.98 $333,315.00
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 If necessary, you can modify the package price in the Quote Comparison and Award form

by selecting the Edit Package action in the Actions tab, or by using the right click context
menu.

& P3  $139,000.00

@PZ '-=.é Copy
w  Award
dic f&  Award And Lock
Lock
| Unlock

{2 Edit Quote
=5 Duplicate Quote

<R+

Ignore Quote

#3  Package Entire Quote
l":_"} Edit Package

Package Record - SJ- Training Job  —

:;-," Edit Cost ltem

Code:x

2] |

Description: |Assisted Parking Lot |

Amount: | £43,535.00|

8.3.8.6 Taxes

Iltem Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.

Taxes

Item Tax
Add Item Taxes to each Item's Price

Quote Tax
Add Taxes to the Quote

Taxes to beadded to Awarded Total as a Percentage of Total:

Total Tax: [ 5450.00

Special Terms & Conditions  Qualifications  Packages | Taxez | Vendor's Profle  Setup  Minority
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8.3.8.7 Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.

Vendor's Profile

Address Book Motes

Example....save for training as needed.|

Alternate Contact Information

[ mame:
[] Email:
[] phane:

[] Fax:
[] Mabile:

Special Terms & Conditions  Qualifications  Packages Tawes | Vendor's Profile | Setup  Minority

8.3.8.8 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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Setup x
Current Status
RFQ Status:
Last Update: 5/5/2020 7:05:03 FM
Quote Origin: WMFarr
Tags
Tag 1: | Pipe
Tag 2:

Tag 3:

Motes

Spedal Terms & Conditions ~ Qualificatons  Packages Taxes Vendor's Profile Minority

8.3.8.9 Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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Minoriby

Minority Business Enterprise

[J vendar qualifies as the fallowing type of MINORITY BUSINESS ENTERPRISE on this job;

DBE DBE Certification: [ |
MBE MBE Certification: [ |
WBE  WBE Certification: | |
OBE1 OBE1 Certification: |:|
OBE2 OBE2Certification:| |
OBES OBES Certifications| |
OBE4 OBE4 Certifications| |
OBES OBES Certification: |:|
OBE6 OBES Certification: | |
OBE7 0OBE7 Certification: |:|

Special Terms & Conditions  Qualifications  Packages Taxes  Vendor's Profile  Setup | Minority

TIP If any of your Data Blocks become deleted on a Quote Record, simply click the
Default Data Block icon.

Estimate Quote Price Execution System Actions

CC| @

Refresh Default
Data Blocks

Tools View

8.3.9 Create a Quote from RFQ

Walk through the steps of creating a quote from an RFQ.

TIP To create a quote from scratch, click the New icon on the Quote Register and fill in the
guote details and seller fields manually.
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Step by Step — Create a Quote from RFQ

Open your job.
From the InEight Estimate landing page, select the Quote tab.
Select Request for Quote (RFQ).

w0 o=

Open the RFQ record for which you’ve received quotes (e.g. Aggregates RFQ).

Cost Breakdown Structure (CBS) Register Request for Quote (RFQ) Register @ R

Drag columns here to group

= | Aggregates f| Published | 1/31/2020

Guardrai Items New 1/3/2020 11:00 AM

5. Select the Vendor Companies tab and select the vendor for whom you need to create quotes.

Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group
Vendor Contact - Stat
1128354 Alberta Ltd -- 0010106779  Alberta Ltd -- Tom Cross New

6. From the Actions menu, select Create Quote.
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¢ InEight Estimate will create quotes for each of the sellers you selected

I=:| Publish

=,! Publish All

(;:f' Create Quote

Process
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e A prompt indicates how many quotes were created, then click OK

RFO 'Aggregates’

Cuote(s] created: 3

K

7. Close the RFQ Record and the RFQ Register.
8. To open the Quote Register, select Quote from the InEight Estimate landing page.
9. Select Quotes from the Quote Management section.

e The quotes that you created from RFQ are now listed on the Quote Register

Quote Register &

Drag columns here to group

RFQ Quote

Description = Fee Status Vendor

= | Agaregates Aggregates Accepted Example Vendaor 1 — Pat Roberts
Aagregates Aggregates Accepted Example Vendaor 4 DBE - Lester Slim
Aggregates Aggregates Accepted Example Vendor 2 — Stan Mark

8.3.10 Enter Quote Details

Now that you have quotes created, you can enter pricing.

Step by Step — Enter Quote Details

1. Open the Quote Record for a seller.

2. On the Resources tab, make sure No Split is unchecked for all items.
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3. Also on the Item Resources & Cost Items tab, now enter the following unit prices for the

resources:

MBR Aggregate Base Rock $8.00
MDIRTB Dirt Class B $6.00

4. Click OK to close the Quote Record.

8.3.11 Use Unit Price or Extended Price on Quote Record Item

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which

makes entering quotes more efficient and results in less errors.

8.3.12 Duplicating an Existing Quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

Step by Step — Duplicate an existing Quote

1. From the InEight Estimate landing page, select the Quote tab.
2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.
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Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources  ©

Drag columns here to group

Find: | [Search For...]

Saved views: | Standard Vien

Example Vendor 4
o ol T S Tt |
MAAM ‘Asphalt Mix (Finish) 36,750.00 Ton 3150 $34.13 $35.70 $3413 #5413
MAFA Fine Aggregate 1,860.00 Ton $7.25 .19 §7.35 .19 58,19
= 12,600.00 | Linear Feet
Pipe 24"PVC SDR3S 3,000.00 Linear Feet 2205 5.5 & 2520 % & $2205
MPR36 PpeRCP 361 1,024.00 | Linear Feet &32.55 &a13 $3413 $5a13 013 & G150 3P $32.55
Scope Items:
Summary
Minority Type DBE
Quoted Total $1,406,973.75 5000 $1171,10070  $1,325646.00 $266,616.00 $271,471.20
Comparable Total < $1,406973.75  $1,A06973.75  $1308747.30  $1463,29260  $1,53594315 $1,540,798.35

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

2 Print % ByQuoteGroup | % Set Al to Reviewed o @ |52 Duplicate Quote | 3 Package Entre Quote | § Award Lok s @ Quoted Items

& Award And Lock Unlock el 5] nit Price:

[ 24

EdtResource | Edit Quote

£ Ignore Quote

EditPackage

R Freview 3 All Quote Groups. Set Al to NotReviewed
EditPrces:

& Export to Excel | $93 All Quote Items.
Resources

Print Layout Quote Group Status

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources  ©

Drag columns here to group

Example Vendor 1

721 Zera ltems

1, scope s

B Substitute Values (%) Ignored Quotes

View

Example Vendor 4

fesars = desrpton e i  cOM g Detad R, | o jerdol?  ppe Maters for st | DBE
improvemen e Materils
Y e nens) | ermmlm | sual sen| o o CENSESEN i)
aFA Fine gregate La0.0 Ton .5 B w5t w5 EE £ w15
MPP1D Pipe 10" PVC SDR21 12,600.00 Linear Feet. $13.65 $3.28 $3.28 $2.28 5.5 & s1260 § & $13.65
MPP24 Pipe 24" PVC SDR35 3,000.00  Linear Feet $22.05 $20.48 5204 $20.48 0.9 & 250 § & $22.05
MPR36 Pipe RCP 36In 1,024.00 Linear Feet $32.55 $34.13 $74.13 $34.13 33413 & 5150 § @ $3255
Scope Ttems
Summary
Minority Type DBE
Quoted Total $1,406973.75 $0.00 $1,171,100.70 $1,325,646.00 $266,616.00 $271,471.20
Comparable Total < $1,406973.75 $1,406,973.75 $1,308,747.30 $1,463,292.60 $1,535,943.15 $1,540,798.35

8.3 Quotes

» The resources and prices from the quote you previously selected have been copied

into a new Quote Record.

6. From the Header block, enter in any missing information.

» The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

» Check the default data blocks for any information you want to add to your duplicate

quote.
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‘Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources Quote Record © -
Header Total
Description: } ) ‘ optional Code: | ‘ Extended Price: $1,062,834.00
Quote Tax:
Company Name: | Mabile: | ] saurez: | -] Bond:
First Name: | ] P [ ] currency: [US, Dolar || tem conditions: 5000
Last Name: | Email: | Status: | Received Special Conditians:
xteral R | ores D Reosons [ ] $1,115975.70
Resources ‘ Cost Items ‘ ‘ Minority X
Drag columns here to graup Finds | saved views: | Previous view - Lo e A 2
[ seller qualifies as the following type of MINORITY BUSINESS ENTERPRISE on this job:
Optional
Code RFQID Quote Group = Description Mo Spit: Free DBE  DBE Certification: |:|

5 [u] [u] MBE  MBECetification: [ |
WBE  WEE Certfication: [ |
OBEL OBE1 Certification: I:l
OBE2 oOpE2Cettfication:| |
OBES 0BE3 Certfication:| |
OBEY OBE4Certfication:| |
0BES OBES Certification: l:l
OBEG OBES Certification:| | v

Spedal Terms 8 Conditions  Qualifications  Packages  Taxes  Seller'sProfile  Setup  Minarity I

[ox ][ concel | [ nNew. <Prev Next >

8. Once done, click OK.
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Exercise 8.1 — Quote Management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
InEight Estimate quote records. In this exercise, you will practice entering quote details. Enter the
following Quote Record details, using the Training Job:

Quote Name: Seller Name: Example Vendor 2 - Stan Mark

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)
Special Instructions Seller is NOT willing to split items.

Quote Seller Name: Example Vendor 4 - Lester Slim

Name:

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE
Special Instructions Seller is NOT willing to split items.

Resource Code Description Unit Price

Quote Name: Aggregates Seller Name: Example Vendor 4 - Lester Slim

Resource Code Description Unit Price
MBR Aggregate Base Rock $8.15
MDIRTB Dirt Class B FREE

Special Instructions Selleris NOT willing to split items.

You should end up with the following results
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Description gigcription Seller Contact Name ?:;‘Ie
Aggregates Aggregates Example Vendor 4 DBE -- Lester Slim  Slim, Lester $408,834.56

Aggregates Aggregates Example Vendor 2 -- Stan Mark Mark, Stan §373,719.94

Aggregates Aggregates Example Vendor 1 -- Pat Roberts Roberts, Pat $402,192.00

Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 Quote Comparison & Award Overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Overview - Quote Comparison and Award Form

e T

1 Resource and  You can show either your quoted resources or cost items.
Cost Item Filter

2 Quote Group This section provides checkboxes to further filter your items. The

Filter Quote Group Filter allows you to mark the quotes as reviewed.
3 Quote Your quotes display with the vendor name plus the quote description.
ezszrolftlon and * Awarded items have an award symbol X
If an item is designated as No Split, it has a chain link icon ¢
» Awarded and Locked items have a lock symbol next to the award
symbol =
4 Cost Source The cost source can either be a Plug or Detail type.
Type
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llzl 4 Quote Group Tags
1

@ Minority Setup

M AR & Y

Address RequestFor Quotes Resources  Cost Items Reports
Book Attachments Quote (RFQ)
Setup Quote Management Quote Comparison & Award Reports

Quote Comparison & Award - Costitems ©  Quote Register

(4]

Estimate Intermediate User Guide

o Find: | [Sez

Quote Group(s) X |l brag columns here to group
L] Desarption & Reviewed cas D Forecast Unit of it Cost Total Cost o ] Example Sub 22 Example Sub £1 H?ﬂsggi"EE”"g
Electrical Work Position Code (T/0) Quantity Measure (Forecast) Guard Rail Items Guard Rai Items e Erry
v Guardrail Work 18 Guardrail Type 2 1,000.00 Linear Feet $24.00 (D $24,000.... $25,000.00 5 & 2400000 & $25,000.00 & $50,000.00
sign Work 19 Guardrail Type 3A 200.00 Linear Feet $31.00 O $6,200.00 §7,000.00 $7.00000 § & 620000 & £6,000.00 %
Scope Ttems
- T N N A I S A
Minority Type
Quoted Total $32,000.00 50.00 $30,200.00 $31,000.00 $50,000.00
Comparable Total < $32,000.00 $57,000.00 $30,200.00 $31,000.00 $57,000.00

8.4.2 Edit Mode

You can make last minute modifications to the quote price directly in the Quote Comparison and

Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,

can be updated. You can modify the Unit price or the Extended price for each of the quote items that

are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time

allowing you to see the impact of the changes in the estimate.

Quote Comparison & Award - Cost items @
‘Quote Group(s) X || Dizg coumns here b group

rer —
ces . uritef Total st
Fostion Code: besaiion ) S st

Lancecaping Werk.

Hasonry
Plmong
Rebar Ingtall
Scaffolding
sheet etal
Sitework

Sterd

s | Standerd view

Mz Foreeast)
Z 342 place and finish 100 Lvp s s85,000.0 ) 428500000 $375,500.00 ERE T £58,567.00
Scope Items
Summary
Frishes (Div 3) Minority Type
ol Quetzd Total $3,656,700.00 5000 426500000 5252520000 $294,000.00 $2.865,807.00
Foundations ComparableTorl < $5,E56700.00 §2E1020000 281020000 281020000  $2,§19200.00 $2,865,807.00
HVAC

Case ConstiLction
Conereie Formnark.

8.4.3 Substitute Values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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HD Engineering
Group
Conaete, Sitewark

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 O $24,000.00 £25,000.00 & $50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 O $6,200.00 £7,000.00
20 Type 4 Signs 1,000.00 SquareF... s15.00 Y $15,000.00 § $15,000.00
27.1 Electrical Work 1.00 Each £5,000.00 & 65,000.00 § $5,000.00

When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

Duplicate Quote Package Entire Quote Award Lock '. @ Quoted Items =] Zero Items z'l’ Configure Totals
il
Ignore Quote Edit Package Award And Lock Unlock € H Unit Price [j Scope Ttems :D:I Set Substitute Ranking
Edit Quote Edit Prices  p== -
G Substitute Values @ Ignored Quotes  [[]T] Default Data Blocks
Quotes View

You can tell when it’s a substitute value because the price displays in italics.

HD Engineering
Group
Conaete, Sitewark

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 O $24,000.00 £25,000.00 & $50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 O $6,200.00 £7,000.00 £7,000.00
20 Type 4 Signs 1,000.00 SquareF... 51500 Y $15,000.00 § $15,000.00
27.1 Electrical Work 1.00 Each £5,000.00 & $5,000.00 § $5,000.00

InEight Estimate grabs the substitute value from one of four places:
1. Awarded splittable quote
2. Lowest splittable quote you’ve received
3. Detail (this only applies to quoting cost items)
4. Plug cost (the rate defined for that resource in InEight Estimate)
You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

@ Quoted Items = Zero Items f’ Configure Totals

Unit Price C Scope Ttems [ Set Substitute Ranking

8 Substitute Values (% Ignored Quotes Default Data Blocks

]
v
Edit Prices

View

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
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these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.

Awarded Splittable Quote [ |
Lowest Splittable Quote F Y
Detail [ ]
Plug |
T
oK Cancel

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute
value it displays the vendor whose substitute value has been used.

Example Yendor 1 Architectural
Pipe Materials for site  Designs, Inc.
improvement 2 Electrical Work

& PL $300,000.00
& P2 §125,000.00

&4 7 0
LU UL

N

HD Engineering Group
Lowest Splittable Quote

When you use a substitute value, it is included in your Comparable Total so you can have a more

realistic comparison of your quotes.
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h print (3 Quote Groups | 73 Set All to Reviewed Edit Quote Lack Quoted Ttems Scope Items [l Set Substitute Ranking T
R Preview 7 AllTtems Set Al to Not Reviewed Award Unlock 5] unit Price @ 1gnored Quotes LT
& Export to Excel £t Award And Lock Edit Package 5% Configure Totals Df;’:.;“;s
Print Layout Quote Group Status Cost Items Quotes View
Cost Breakdown Structure (CBS) Register Request for Quote (RFQ) Register Request for Quote (RFQ) Record Quote Register Quote Comparison & Award - Cost items  ©
Quote Group(s) X || Drag columns here to group
u Description = Reviened Forecast Unit
e Wk Somtoncode  Desabton - -} == Plug Deta
Electrical work 2 _lsnanbaiwpe 2 1,000.00 Linear.. $24.00 ¢ $24,000.00 $25.00
Electrical work 3 _I Guardrail Type 3A 200.00 Linear.. $31.00 (O $6,200.00 £35.00 835,00
v Guardrail Work 17 TollBeoth 100 Each  $40,00.. (O $40,000.00 §25,000.00  $25,264.55
| Pipe Materials Scope Items
sign Work o
Winority Type
Quoted Total $57,000.00 $25,264.55
| Comparsble Total <] $57,000.00 $57,264.55
Awarded Total 50.00 $0.00
Quoted Items Total $57,000.00 $25,264.55
Special Conditions 50.00 $0.00
> Last Update

8.4.4 Display Ignored Quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

) Session Recap

% Auto Award -

Tools

Example Sub #2

7/29/2009 2:21:...

8.4 Quote Comparison & Award

Find: [T

HD Engineering

Example Sub #1

Guard Ral Items (Glovd Pl E;febe, Sitework
16 smam o szson (NS
te  smm o sooo [

7 & sa0000.00

[ |
$30,200.00 s71,000.00 [ $56,000.00,
$55/464.55 (EZL ISR _
$30,200.00 s71.00000 |11 550,000.00|
sa00 soo0 [0 s000)

sz vo.. | S

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

Example Vendor 1 Example Yendor 4
Pipe Materials for site  DBE
improvements Pipe Materials

Example Vendor 2
Asphalt Materials

Award
T Award And Lock
Lock

Unlock

I-;E";- Edit Quote

‘= Duplicate Quote

¥?)  |Ignore Quote
2 Package Entire Quote

D Edit Package
%1,325,646.0

$1,463,292.6/

ﬁ; Edit Resource

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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Estimate Intermediate User Guide

Currency: | LS. Dollar -
Status: Ignored
Ignare: Reazon: -
M Description
Packages
IDn Mot Lse
Drag columns here to grg Non Compliant -
end Code = De
=
%.
)

J[eJ = If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.

% Award & Lok P Quoted Items =1 Zero Items
L3
¥a Award AndLock | (5 Unlock Unit Price 7, scope Items

5% Configure Totals

Ih Set Substitute Ranking

O Session Recap

% Auto Award ~

Edit Prices . —
Ba substitute Values [ Default Data Blocks

Ignored Quotes
View

S

Tools

pte Comparison & Award - Cost items @

\ .

Unit of Total Cost

Find:

Example Sub #3

Measure RERLEOSY (Forecast) Deial Sign Items
Linear Feet $24.00 (D $24,000.... $25,000.00 £25,000.00 £25,000.00
Linear Feet $31.00 (O $6,200.00  £7,000.00 £7.000.00 £7.000.00
square F... $13.00 (O $13,000.... $15,000.00 $13,000.00 | & $11,000.00
%
£500.00
%
%47,000.00 $0.00 $11,000.00
%47,000.00 %45,000.00 %43,000.00
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Example Sub #2 Ex;
Guard Rail Items

gd views: | Previous View -

g.5ub #4 DBE

3 Example Sub #1
Sign Ttem:

Guard Rail Items
% & $24,000.00
% &  $6200.00

$13,000.00

$30,200.00
$43,200.00
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8.4.5 Export Quote Comparison and Award to Microsoft Excel

The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the
estimators knew when they made determinations on which numbers to carry.

file  Home Insert  Pagelayowt Formulss  Data  Review Automate  Help  Developer O comments & Share ~
[mie Cae B Gencu I E R @EsE ety O[]
pase. LICoP - Bl 7 u- (- &-A- § - 9 9 %) J§ Conditonal Formatas Cel | insert Delete Fomat e Sot& Find& | Analyze | Sensitrvity
v < Format Painter L = - Fommatting ~ Table~  Styles » = = & Clear~ Filter ~ Select~ | Data -
Clipboard Ll Font Number ] Styles Cedls. Earting Analyis Sensitivity ~
Al CBS -
E i G H | J L3 L ™M N a
Total Cost 1_Vendorl ‘Cooper Outdoor Advertising Inc WonderBoys WonderBoy8
1 | UnitCost - (Forecast) - Plug - Detail = Guard Rail ltems = Guard Rail ltems ~ Guard Rail items ~ Guard Rail Items hd
2| §20.00%° $29.000.00  $25,000.00 $25,000.00 8 & $24,000.00 1 $24,218.75¢ $562,394,000,00 % $562,344,000.00
3 s31.005° $6,200.00  $7,000.00 5700000 & & $6,200.00 < ¥ 6,781,256 $145,272,200.00 & $145,272,200.00
4
5
]
7
8 $0.00 $0.00 $30,200.00 $31,000.00 $707,616,200.00 §707,616,200.00
) $0.00 $0.00 $0.00 50.00 50.00 $0.00
i) $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
1 $0.00 $0.00 $0.00 50,00 50.00 50.00
12 $0.00 $0.00 $0.00 50.00 $0.00 50.00
12 $32,000.00 $0.00 520,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
14 $0.00 $0.00 $0.00 $0.00 $0.00 50.00
15 $32,000.00 $0.00 $30,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
16 $0.00  $32,000.00 s $0.00 $0.00 $0.00 $0.00
17 $32,000.00  $32,000.00 530,200.00 $31,000.00 $707,616,200.00 §707,616,200.00
18 $0.00 $0.00 $30,200.00 $0.00 $0.00 $0.00
19 5/11/2023 2:38:01 AM 7/24/2023 11:24:01 PM 6/2/2023 12:29:38 AM 6/2/2023 12:37:37 AM
20
21
2
|z| -
Formatted Data | Raw Data C “ G
P e ——r—— L e S——

The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file name
for the Excel file, and then click Save.
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Estmate e Frice e e — fictons _

El Print (% ByQuote Group ~ C &', 2 Duplicate Quote S @ All items IE Unit Price Scope Iter
. 0O
B, Preview <3 Al Quote Groups | (b w & 1gnore Quote [ G2 Quoted Items B2 substitute Values (% Ignored Q
- Edit Resource | Edit Quote Edit Prices
@i‘ Export to Excel | 27 All Quote Items @ Unquoted [tems | [= Zero Items f’ Configure
Layout Resources View
n & Award - Resources ©
° Export spreadsheet to. \ X Baved views: | Standar
T ‘ s> ThisPC » Downloads (] Search Downloads
Organize New folder =+ @
5 OSDisk(C) # A Name Type Size ]
Git Projects
el v Yesterday (2)
[H InEight Control Columns List.xlsx Microsoft Excel Work.., 47
@ improved.xlsx Microsoft Excel Work... 16

~ Last week (1)

@ Contacts_09142023051609.xlsx Microsoft Excel Work... 10

~ Hide Folders

Save as type: | Excel files (" xlsx) ( ~

8.4.6 Additional Quote Comparison and Award functions

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Overview - Additional Quote Comparison and Award Functions

T T S

1 Asterisk nextto  An Asterisk (*) is displayed on a quote to indicate when that quote

Quote Item includes quote items appearing in other Quote groups.
2 Zero value Award quotes to Plug or Detail when its value is zero.
Plug/Detail
3 Updated Quote  Quote Item Tool tip displays details including:
Items Tool tip o Unit Price
» Extended Price
» Bond
o Taxes

e Special Conditions
 an indicator for a delta quote item
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8.4 Quote Comparison & Award

Quote Comparson & Award - Cost tems &

Forecast Unit of Total Cost o
] (T/0) Quanssty Measire o Forecast) P
Formuork 100 Lump Sum $2,339,113. 0 $2,39,11020  $3,281.200.00

Minerity Type

Detai

Ci Concrete
Construction, Inc.
Concrete Macement

&

place and finsh 100 Lump Sum oo & woo  gpmsson|f  see s £205,000.00
Scope Ttems
S 2

$2,810,200.00

Kinopo Construction
Concrete Farmmork

Find: | [SearchFar...] Saved views: | Prevous View

Morn Concrete

* Case Construcion

Conbractors
Concrete Form
Concrete Placemeny | ©0N o1 Formuork

$2,52%,200.00
& $294,000.00

$2.892.622.1%
$2.892,622.19

52,810,200.00

$2,819,200.00

8.4.7 Configure Totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by

selecting Actions > Configure Tools.

I'_@ Configure Totals
Caption Visible
= Seller +
Quote Description '
Minarity Type '
Motes b

Extended Price

Item Taxes

Quote Tax

Bond

Item Conditions

Quoted [tems Total

Spedal Conditions

Quoted Total v‘
Substitute Values

Comparable Total v‘
Awarded Total

Last Update

A Y
Options

Location: (O Top (®) Bottom

InEight Inc. | Release 24.3

Sort
MNone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Ascending
Mone

Mone

Cancel
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.

CES

Position Code Description
18 Guardrail Type 2
19 Guardrail Type 3A
20 Type 4 Signs
Scope Items
Mabilization
SurveyLayout

Temporary Traffic control de...
Summary

Minarity Type

Notes

Extended Price

Item Taxes

Quote Tax

Bond

Item Conditions

Quoted Items Total

Spedal Conditions

Quoted Total

Substitute Values

Comparable Total Z

Awarded Total: $43,200.00

Last Update

8.4.8 Adding Notes to Quote Comparison & Award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
guote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.
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Step by Step — Add Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.
2. Select the Resources icon under Quote Comparison & Award.

» Notice the absence of the Notes section. This is the default option until you follow the
next steps.

Select the Actions tab.

From the View section, select the Configure Totals icon.

& prit €2 By QuoteGrop | 2 Set Al toReviewed o @  Duplcate Quote | @3 Package Entre Quote | | Avard Lock o Doumdtens = zerotens © sessonRecap
& preview B Allquote Groups | 5 setal tototreviened | Y B tgnore uote Eatpodkace awerdandtock | 5 nock | (1 ] untprice T SetsubstiuteRarking | § AutoAwerd -
& Export toExcel | $3 All Quote Items EdtResource EXer® el @ Ignored Quotes [ Defauit Data Blocks
print Layout Quote Group Status | Resources Quotes view Tools
BS) Register i & Award - Resources ©
Drag coumns here to group | seved views: [ Previous
G = pesapion i A Ay o e ooty
maAM ‘Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 $34.13 R $3150 & 570
PP 10 Ppe 10"PYC SOR21 12,600.00 Linear Feet 1365 $.8 $228 s28 5328 &
MPP24 Pipe 24" PVC SDR35 3,000.00  Linear Feet <2205 0.8 $20.45 s20.48 s @
MPR36 Pipe RCP 361n 1,024.00 Linear Feet s32.55 34,13 $3413 5013 $34.13 @
Scope Ttems
Summary
Minrity Type oBE
Quoted Total $1,406,973.75 $0.00 $1,171,100.70 $1,325,646.00 $266,616.00 $271,471.20
Comparable Total < $1,406,973.75 $1,406,973.75 $1,308,747.30 $1,463,292.60 $1,535,943.15 $1,540,798.35

5. Select the check box in the Visible column for the Notes caption.

InEight Inc. | Release 24.3 Page 75 of 257



8.4 Quote Comparison & Award

Caption

Sef

ller

Quote Description

Minority Type

.

Extended Price

Item Taxes

Quote Tax

B

nd

I[tem Conditions

Quoted Items Total

Spedal Conditions

Quoted Total

Substitute Values

Comparable Total

Awarded Total

A

v

Options

Location:

6. SelectO

K.

O Top

Estimate Intermediate User Guide

Configure Totals — m] x

Visible

B IESHES AN

(@) Bottom

Mone

Ascending

Mone =

» The Notes section displays on the Quote Comparison & Award form.
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B5) Register & Award - Resources © -
Drag comns here to roup Find: [[BearchFor..] | Saved views: [ Previous View -
Example Vendor 1 Example Vendor 4
oL Y Pkl
MaAM ‘Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 $3413 R & $3150 & $35.70 $94.17 $34.13
MaFA Fine Aggregate 1,860.00 Ton $7.25 .19 819 2 & $7.25 & $7.35 $8.19 $8.19
MPP1D Pipe 10" PVC SDR21. 12,600.00  Linear Feet $13.65 .28 $2.28 $2.28 $3.28 & $1260 % & $13.65
MPP24 Pipe 24" PVC SDR35 3,000.00 Linear Feet $22.05 $20.48 $20.45 $20.45 w48 @ 2520 § & 52205
MPR36 Pipe RCP 36 In 1,024.00  Linear Feet $32.55 $34.13 $34.13 $34.13 9413 @ 5150 § & $3255
Scope Items
Summary
Minority Type DBE

| e e w1~ NS Y I T - N
Quoted Total $1,406,973.75 $0.00 Example Note| 5.00 $266,616.00 $271,471.20

Comparable Total

<

$140697375  $1406,973.75 260 5153594315 $154079835

ok || cancel
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8.4.9 All Quote Groups Layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

Estimate Quote Execution System Integrations
= Print (3 By Quote Group | (=3 Set All to Reviewed ET’ @ 2 Duplicate Quote | [ Package Entire Quote
o, Preview U All Quote Groups | 53 Set Al to Not Reviewed 20 Ignore Quote ¥y Edit Package
Edit Cost Edit Quote
@Eu:ﬂtmExce{ 2 All Quote Ttems Item
Print Layout Quote Group Status Cost Items

Quotes

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Overview - Quote Groups Layout

I T S

1 Totals per Quote Ability to see the Awarded Total Plug, Detail and Quote amount per

Group Quote Group
2 Total Awarded Visibility into the Total Awarded Amount per Quote Group
Amount

3 Comparable totals  Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the
quote items
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& Print (3 By Quote Group | 9 N & Duplicate Quote | (23 Package Entire Quote | § Award a P (& Quoted Items 27 Zero Items
R Preview 3 Al Quote Groups | b [ 4 ) Ignore Quote %y Edit Package Y& Award Andlock | 5 G Unit Price T#, Scope Ttems
& Export to Bxcel | ) All Quote Ttems BT | EHIEE EditPrices B substitute Values (=) Ignored Quotes
Print Layout .. | Resources Quotes View
Cost Breakdown Structure (CBS) Register ‘Quote Comparison & Award - Resources @
Drag columns here to group Find: | [Search For...] Saved views: | 5Y
Quote Group = Plug Detail Quote Quote Group Total
= = Asphalt Materials £0.00 £0.00 $1,171,100.70 $1,171,100.70 o
G = Deseton Can " Vassne e P et prciiari ey
MAAM asphalt Mix {Fiish) 36,750.00 Ton £31.50 $34.13 $3413 § & $3150 & $35.70
MAFA Fine Aggregate 1,860.00 Ton §7.25 8,19 w9 § & $7.25 & §7.35
Scope Items
Summary
Minority Type
Quoted Total o $1,269,327.15 $0.00 $1,171,100.70 $1,325,646.00
Comparable Total < $1,269,327.15 $1,269,327.15 $1,171,100.70 $1,325,646.00
o | Awarded Total: 51,171,300.70 $0.00 $0.00 $1,171,100.70 $0.00 |
EIPipe Materials £0.00 $0.00 $271,471.20 $271,471.20
Example Vendor 4
S on gl o g pes o e
MPP10 Pipe 10” PVC SDR21 12,600.00  Linear Feet £13.65 £3.28 $3.28 & s1260 § &2 $13.65
MPP24 Pipe 24" PVC SDR35 3,000.00  Linear Feet $22.05 $20.48 s0.48 | & $25.20 § & $22.05
MPR36 Pipe RCP 36 In 1,024.00 Linear Feet £32.55 $34.13 $34.13 | & BL50 § P $32.55
Scope Items
Summary
Minority Type o DBE
Quoted Total $137,646.60 $0.00 $266,616.00 $271,471.20
I Comparable Total < $137,646.60 $137,646.60 $266,616.00 $271,471.20
Awarded Total: $271,471.20 $0.00 50.00 50.00 $271,471.20

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.10 Compare and Award Quotes

To award an item, right click on that item and select Award.

Example Sub #3 Example Sub #2 Example Sub #4 DBE
Sign Items Guard Rail Items Sign Items

£25.000.00 : & %24,000.00 $25,000.00

£7,000.00 § &  $6,200.00 £7,000.00

Award And Lock
Lock
Unlock

$500.00
1%}

Edit Quote
Duplicate Quote T
lgnore Quote
Package Entire Quote

Edit Package

Edit Cost [tem
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The Award icon displays next to the awarded item(s).

Example Sub #2
Guard Rail Items

£24 000.00
$6,200.00

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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Faorec... Unit ] Total
EDB:ﬁUn Code Besamiin g:gg I?ﬂfa... gglstt ([:Foosrte...
17 Toll Booth 1.00 Each $40,000... (2 $40,0...
18 Guardrail Type 2 1,000.00 Linear ... $25.00 (D $25,0...
19 Guardrail Type 3A 200.00 Linear ... $30.00 (O %6,00...
20 Type 4 Signs 1,000.00 Sguare... $15.00 # %15,0...
7.1 Electrical Work 1.00  Each £5,000.00 # £5,000...
Summary
Minority Type
Quoted Total

Comparable Total
Awarded Total
Quoted Items Total
Spedial Conditions

Last Update

Estimate Intermediate User Guide

Example Sub #2 Example Sub #1

Plug Detail Guard Rail Items Guard Rail Items
$25,000.00  $25,264.55 % & $40,000.00
§25,000.00 & $24,000.00 § & $25,000.00
$7,000.00 £7,000.00 £,200.00 § &  $6,000.00

% $15,000.00

% $5,000.00
$77,000.00 $25,264.55 $30,200.00

%77,000.00

$0.00

$99,764.55

$25,264.55

$72,964.55

$30,200.00
$0.00
7/29/2009 2:21:...

$0.00

11/13/2019 9:0...

e =0 You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.10.1 Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
guote record, will turn the record back to gray.

Drag columns here to group

EBS_ Description Forecast Unit of
‘osition Code (T/D) Quantity Measure
18 Guardrail Type 2 1,000.00 Linear Feet
19 Guardrail Type 3A 200.00 Linear Feet
Scope Items
Summary
Minerity Type
Quoted Total
= Comparable Total <

8.4.10.2 Award Status

§ Total Cost
Unit Cost (Forecast) Plug
$24.00 Q %$24,000.... £25,000.00
$31.00 Q %6,200.00 £7,000.00
$32,000.00
$32,000.00

Detail

Find: | [Searc

HD Engineering

Example Sub #2 Example Sub #1

Guard Rail Items Guard Rail Items gro?#gate Sitework
5 & $24,000.00 &2 £25,000.00 | & $50,000.00
$7,000.00 : & $6,200.00 & £6,000.00 $7,000.00
$0.00 %30,200.00 %$31,000.00 4$50,000.00
$57,000.00 %30,200.00 %$31,000.00 4$57,000.00

The Award Status indicates whether or not all quotes are awarded within a quote group.

Quote Register Quote Comparison & Award - Cost items  ©

Quote Group(s)

eeeeeeee

v 17 Toll Booth 100 Each $40,000.00 O
7 18 Guardrail Type 2 100000 LinearFeet 52500 O
19 Guardrail Type 3A 20000 Linear Feet $30.00 O
20 Type 45igns 1000.00 SquareF. 51500 &
271 ectrical Work 100 Each $5,00000 &
> Summary
Minority Typs

Quoted Total
ComparableTotal <
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Example Sub £2

=] GuardRai Items

$40,000.00  $25,000.00  $25,264.55
52500000 2500000 & smomm
$6000.00  §7,00000 00 & %200
$15000.00  $15,000.00
5500000 $5,000.00
$77,000.00  $25,264.55 $30,200.00
$77,00000  $98,764.55 $71,96455

Example ub #1
Guard Ra Ttems

$40,000.00
% & s2500000
5 & $600000

$71,000.00
$87,500.00

E

&

Example Sub #4DBE
ion Ttems

$13,000.00

DBE
$13,000.00
$98,764.55

HD Engin
Gro

&  ssomm

& off $300,000.00

@ $3,500.00 & $3,700.00
$4/450.00 $50,000.00 $4,20000 $300,000.00
$96,764.55 $98,764.55 $98,964.55 $385,764.55
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8.4.10.3 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

Quote Group(s) b4
s Description = Reviewed
v Electrical Wark:
v Guardrail Wark W
v Sign Work:

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
guote group will be highlighted in yellow to indicate something changed since the last review.

Quote Group(s) »
b Description = Reviewed
o Electrical Wark
o Guardrail Wark o
o Sign Wark

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Step by Step — Compare and Award Quotes

1. Open the Training job, and from the main InEight Estimate landing page select Quote>Quote
Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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Execution Actions

System

) |
w il '#
an e |
Resources | Cost Items Reports

(Quote Comparison & Award Reports

3. Under Description, select Asphalt Materials.

Quote Group(s) »

] Description = Reviewed

/ggregat&s
o

Asphalt Materials

Fipe Materials

4. Review the quotes to determine the lowest bidder:

Estimate Intermediate User Guide

¢ Select the Configure Total icon in the tool ribbon to view additional captions

¢ Both vendors have no split items for both resources.
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Resource . tiliza ...
Code bt Ll Count ;

MAAM Agphalt Mix (Finish]) 36,750.00
MAFA Fine Aggregate 1,860.00

Scope Items

Summary
Minarity Type
Quoted Total
Comparable Total <
Awarded Total
Quoted Items Total

Spedal Conditions

Last Update

5. Example Vendor 1 has the lowest comparable amount, so award all to Vendor 1 by right clicking
on the Example Vendor 1 Asphalt Materials and selecting Award All.

Example Sub #3 Example Sub #2 Example Sub %4 DBE
Sign Items j i =MS
-
sogof A Award Al $25,000.00
”
s70 = Award And Lock All $7.000.00
- Lock All
$13,000.00
Unlock All
& # Edit Quote Iy
&5 \—" Duplicate Quote &
& /' Ignore Quote &
‘" Package Entire Quote
DBE

e By awarding Example Vendor 1 both resources, the award ribbon icon displays next to the

unit price.
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Example Vendor 1 E= cz.en

L= Asphalt Materials

Asphalt Materials

2273|3F  $3150 & £35.70
w191 § ¥ $7.25 & §7.35

¢ You could also change your mind and award Example Vendor 2 one of the resources. In
this case, award resource code MAFA to Example Vendor 2.

6. Right click on $7.35 under Example Vendor 2, and select Award.
¢ You now have awarded resource code MAFA to Example Vendor 2.

Example Vendar 1 Emzzianis

Detai Asphalt Materials

Asphalt Materials

$34.713 § & $3150 & §35.70

5. 19 | 9 $7.25 m(;? $7.35

8.4.11 Package Entire Quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.

% Set All to Reviewed M’ @ 2 Duplicate QquEI (7 Package Entre Quote I: Award i Lock # () Quoted Ttems [E! Zeroltems 57 Configure Totak () Session Recap

(3 Set All to Not Reviewed 7 Tgnore Quote. %y Edit Padage: $a Award Andlack | (5 Unlock e 5] urit Price. 17, Scope Ttems [ Set Substitute Rarking | § Auto Award -
EditCost | Edit Quote Edit Prices
Ttem B substitute values % Ignored Quates [T} Default Data Blecks

Quote Group Status Cost Ttems Quotes View Toals

v Quote Comparison & Award - Cost tems  ©
s hers to group Fing: | [Search For...] = | Saved views: | Previous View
= . Barton Concrete .

Tincon ™ owewen o wos RO ae o fmogeee secmecn SRS SRR,
a1 Sidewaks 4,54.00 SQFT 989 8 #9107 $94532.07 | $44,939.07 Pl 520600000 S Pl $242,500.00 & PL :
H1z Veub 000 LF $9a51 & £1,725.32 f1.72532 |} sars32 PR & fr
313 Curb and Gutter 1,28.00 LF 451 8 sw133.12 % 54313312 £P1 f£n &n e
314 Valley guiter .00 LF 451 8 §1,725.32 % siL7a532 2R &n fn & —
315 Handiap ramos 19,00 SQFT 98 & sne 5 % susTae7 ém &r &n e
36 Truncated domes 100 Lump Sum $2500000 & 6500000 § $2500000 52500000 &Pl &rL &n | ic= ik
317 Flow thru planter sab 15.00 (F 504 & $12,005.46 % 51200546 & FP1 &rn &
218 Flow thru planter wals 1500 WF $%.01 & s12,005.96 1 s1200546 FR1 &r &n
319 Median Infil 2500 oy $a.02 2 $9,230.60 om0 § $9,230.60 @ FP1 fn
2110 Rolled arb adjacent to 000 F s:51 8 s72532 % surs3 @n &rL
3111 Reinforong 261240 b 4450 & §12,000.00 § $12,000.00 $1,306.20 &£ P1 &P

Page 84 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide 8.4 Quote Comparison & Award

8.4.12 Incomplete Quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not
provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare
and Award form.

Package Entre Quote Awar 0 5 (2 Quoted Items 127 Zero [tems 5 Configure Totals 1) Session Recap
d Edit Package Award And Lod lock & Unit Price [, Scope 1tems o[ Set Substitute Rarking | § Auto Award ~
Edit Cost Edit Quote Edit Prices =
Ttem B5 substitute Values () Ignored Quotes [T} Default Data Blocks
Cost Items Quotes View Tools
Quote Comparison & Award - Cost items ©
T Find: | [Search For...] | Saved views: | Previous View
. *H.P. Construction
8BS Forecast Unit of Total Cost = Matomas Masonry, Inc. | Marquis Masonry
Position Code Descrption {T/0) Quantity Measure Unit Cost (Forecast) Pug Detal Masorry Masonry {:‘;S'ﬂmr
411 CMU Wals 100 | Lump Sum §485,922.27 (O  $485,922.27 $400,000.00 $900,000.00 § & P1 $512,648.00 |& $526,724.53 | & P1  §766,352.00
4.1.2 Precast Concrete Caps .00 | Lump Sum $14,577.67 O $14,577.67 $12,000.00 sizo0000 % P o $12,375.47 | & P11
413 Steel Embeds 1.00  Lump Sum $12,148.06 O $12,148.06 §10,000.00 $10,000.00 § £P1 & $0.00 | & F1
Scope Items.
Demolition o o o
Caulking, Sealants &. o o o
Scafolding o o =]
Shoring/Bracing §15,000,00 £12,000,00 o |
Testing/Inspection o o a
Summary
Minority Type MBE
Notes [% I By

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.

(3 EyQuoteGow | 3 Set Al to Reviewed Duplicate Quot= Package Enfire Quote Award Lock P ) Quot=d Ttems I 2 Zero liems I 57 Configure Totals ) Session Recep
o [oa e e || €1 Se Al i ra s TreEa St Package sward arctode | £ o | B Firitpnee T, Seope tiems setsbstiute ranrg | # A duare -
. EditCost | EditQuote EditPrices
5 Al Quote Ttems Tiem B Substitute Valies ) Ignored Quotes fautData Blocks
Layout Quote Group Status CostTtems Quotes View Tools
Cost Breakdown Structure (CBS) Register ©  Quote Comparison & Award - Cost items @
Quote Group(s) x rag coiumns here to grn sind: | [Search For...] wed wiews: | Frevious Visw
. Desaiption = 3 Forecast - c. | “HP. Comsiuctin 8 -
@ = s HTif.ﬁe e ?:égﬁ g =] Malomss Masorr, I | ;::S::J‘\IsyMu;nnrv
Conarete, Precast e Quantty " U mazonry
Conrete, Sitewark 211 oMU vrals 1.00 | Lump Sum §1,879,705.33 (O $1,679,705.33  $4,900,000.00  $1,708,525.67 § & P1 $512,648.00 7Pl §766,352.00 |2 0,00
Conerete, Struchral 412 Precast Conarete Ceps 100 Lump Sum $170,682.67 §  $170,6882.67 $12,000.00 srr006.00 % 2P &P 2 20.00
Docrs & Windows 413 Steel Embeds 100 Lump Sum $170,682.67 {0 $170,882.67 £10,000.00 $16,006.00 3 P M Fr1 & 20,00
Eectical Sompe Tems:
Frishes (Div 5) Demolten o o
Fre Protection Cauiking, Sealants & Backer Rod © il
Foundations Scafolding o a
Hvac Shoring/Bracrg. 415,000.00 a
Landscaping Vork Testing/Tnspection o a
v [ —
Minarity Type o MBE
Ranar Inctal Matcs &) ) ™
seaffoiding Guoted Total $4,422,000...  $1,708,826.67 $512,648.00 357476400 50.00
Sheet Metsl - Comparsbie Toial < $4/422,000... $1,730,826.67 $512,648.00 $574,764.00 5173082667
Sitzncrk
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8.5 SCOPE ITEMS

During the bidding process, it’'s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Overview - Quote Record - Scope Items

Seller’s By default, all scope items are considered included in the quote, and the Special
Special Conditions amount is $0.00. On the quote record, by selecting the checkbox, you
Terms & can indicate scope items and uncheck items that are not included. The amount

Conditions  associated with these items will then total up in the Special Conditions subtotal.
The person responsible for awarding quotes needs to update the Inclusions field
to correspond with what the subcontractor has agreed to include in the quote.
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Special Terms & Conditions b4
Quote Tax Item Tax
Add Taxes to the Quote: (O) Yes (@ No Add Item Taxes to each item's price

TAXES to be added to awarded TOTAL as a % of total :
Tax Rate: 0.00

Total Tax: £0.00

Buyer’s Special Terms & Conditions

Seller's Special Terms & Conditions

\

FIXED COST to beadded

Seller's awarded total (any combination of items) :

Distribute Special Conditionk: (@) Evenly () Usingweighted average

Include Special Conditionsiosts forunawarded guotes in Comparable Totals

Drag columns here to group Find: Saved views: | Previous View -
Eznmnlber - Scope [tem Quote Group Induded Amount % of Total Motes

> 1 Permits Electrical Work - -
2 Surveying and Layout Electrical Work > £500.00 14.29
3 Temporary Traffic Control Devices Electrical Waork o
4 Trench and Backfill for Electrical W...  Electrical Work b v

%950.00
4 3

Spedal Terms & Conditions ~ Qualifications  Packages  Seller's Profile  Setup  Minority

Overview - Quote Comparison and Award - Scope Items

1 Scope ltems Quote Comparison and Award checklist items for your quote that help with
evaluating subcontractor and supplier quotes in greater detail. This is
used to ensure certain items are either included (inclusion) or excluded
(exclusion) in the quote and accounted for by the entity awarding the
quote.

2 Scopeltem Maintained in Quote Record form. These are the Seller's Special Terms &
Inclusions Conditions scope items that the subcontractor is including in their quote
price. When the scope item contains a value, the subcontractor is
agreeing to perform the work.

3 Scope ltem Maintained in Quote record form. These are the Seller’'s Special Terms &
Exclusions  Conditions scope items price. If the Inclusions checkbox is blank, the
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Overview - Quote Comparison and Award - Scope Items (continued)

subcontractor is NOT agreeing to perform the scope items.

4  Scopeltem An entered value means that the subcontractor is excluding this scope of
value work. However, you may add an amount because this scope could incur a
cost. Once the bid is awarded, you may find another subcontractor to
perform the work. You are simply accounting for a cost for this scope of
work. In the example below, HD Engineering is not going to paint the
electrical equipment, but you know the cost is $150.00. You are showing
this cost to account the cost for this scope of work that needs to happen.

5 Seller's By default, all scope items are considered included in the quote, and the
Special Special Conditions amount is $0.00. On the quote record, by selecting this
Terms & checkbox, you can indicate scope items and uncheck items that are not

Conditions included. The amount associated with these items will then total up in the
Special Conditions subtotal. The person responsible for awarding quotes
needs to update the Inclusions field to correspond with what the
subcontractor has agreed to include in the quote.

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Cost items  ©

Quote Group(s) x Drag columns here to group

[ Description = Reviewed &3 Forecast Uit T e Architectural HD Engineering
Description B (T/o) of Plug Detail Designs, Inc. Group
v Electrical Work Position Code Quantity Me... (=3 (Forecast) Electrical Work Electrical Work:

Electrical work 2 71 Electrical Work 100 Each £4,200... O £4,200.00 £5,000.00 420000 § & $4,20000 & £4,450.00
Electrical work 3 Scope Items
Guardrail Work o Permits o] o]
Pipe Materials Surveying and Layout $500.00 $500.00
Sign Woark Temporary Traffic Control Devices o
Trench and Backfil for Electrical Work 9 u] o
Painting Electrical Equipment O $150.00
Temporary Power and Lighting O e $300.00
Summary
Minority Type
Quoted Total $5,000.00 $0.00 $4,200.00 $4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total $0.00 $0.00 $4,200.00 $0.00
Quoted Ttems Total $5,000.00 $0.00 $3,700.00 $3,500.00
= 6 Spedial Conditions £0.00 $0.00 $500.00 $950.00

Last Update 11/13/2019 1:0... 11/13/2019 3:5...

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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Quote Register ©

Drag columns here to group

- RFQ Quote Quote Awarded - Awarded
Description Description Status Seller Compary Tatal Total Currency Awarded Status
Electrical Work Electrical Work  Accepted Example Sub #5 MEE -- Chr... Example Sub #5 MBE £4,450.00 $0.00 U.5. Dollar None
Electrical Work Electrical Work  Accepted Example Sub #3 —Frank M... Example Sub #3 £4,200.00 $0.00 U5, Dollar Mone

The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

& Register Quote Comparison & Award - Cost items @
g columns here to group
gntﬁnn Code Description ?;g;ast ;Ifmt gzistt ?gféf;:tg Flug Detail ;recs':;:scf;l:‘zl Ell?oﬁgglneerlng
Quantity Me... Electrical Work Electrical Work
7.1 Electrical Wark 1.00 Each $4,200... O $4,200,00 §5,000.00 420000 § & $4,200.00 & §4,450,00
Scope Items
Permits a %)
Surveying and Layout §500.00
Temporary Traffic Control Devices ] %)
Trench and Badkfill for Electrical Work a %)
Painting Electrical Equipment m] £150.00
Tempoarary Power and Lighting [m] m
Summary

Minority Type
Quoted Total $5,000.00 $0.00 $4,200.00 $4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total $0.00 $0.00 $4,200.00 $0.00
Quoted Items Total $5,000.00 $0.00 $3,700.00 \53,500.00
Spedal Conditions $0.00 $0.00 £500.00 $950.00
Last Update 11/13/2019 1:0... 11/13/2019 3:5...

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 Scope Item Setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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Foundation Setup Data Register Quote Group Tag Record &

Description: * |Electrical Work

Award Status: Complete
Reviewed:
Last Reviewed:

Quote Last Changed:

Drag columns here to group

EE“ = Scope Item Amount %% of Total
1 Permits > §0.00
2 Surveying and Layout - £500.,00
3  Temporary Traffic Control Devices - 80,00
4 Trench and Backfill for Electrical Work: > £0.00
5 Painting Electrical Equipment > &0,00
6 Temporary Power and Lighting > £300,00

8.5.2 Scope Item Creation and Award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

Step by Step — Create and Award Scope Items

Open the Training Job.
Select the Setup tab.
Click on Foundation Data Setup in the Initialize section.

Select the Quote Group Tags tab to setup Scope Items within a Quote Group.

a K~ w0 N =

Create a new Quote Group Tag called Electrical Work and click OK.
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Foundation Setup Data Register ©

Account Codes Tags Wark Breakdown Structures Quote Group Tags L

Drag columns here to group
Description = ;‘gi:g gglgtids -

Aggregates Complete v
Asphalt Materials Complete J
Bridge Work: Complete
Commerdal Wark Complete
Concrete Beams Complete
Concrete Materials Complete

= Electrical Work Complete

6. Open Electrical Work and add the following Scope Items:
e Permits
¢ Surveying and Layout
e Temporary Traffic Control Devices

Trench and Backfill for Electrical Work

Painting Electrical Equipment
e Temporary Power and Lighting
7. Enter 500 in the Amount field for Survey and Layout, and 300 for Temporary Power and Lighting.

¢ If any of these default columns are missing, click on one of the headers, and right click.
Select Column Chooser and drag the item(s)over tto the header bar, then click OK
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Fow

Number Scope Item Amount %% of Total
1 Permits > §0.00
2 | Surveying and Layout - £500,00
3 Temporary Traffic Control Devices - &0.00
4 Trench and Backfill for Electrical Work > £0.00
5 Painting Electrical Equipment - &0,00
6  Temporary Power and Lighting - £300.00
8. Click OK.
9. Select the Estimate tab.
10. Click on Cost Breakdown Structure (CBS).
11. Change your Saved Views to Quote Group Setup View.
12. Create a cost item Entry Gate with a subordinate Electrical Work.
13. Assign Quote Group Electrical Work to the Electrical Work cost item.
Forecast
CBS -
" Y  Description (T/Q)
Position Code e
= 26 | Entry Gate 1.00
26.1 Electrical Work 1.00

14. Select the Quote tab.
15. Click Request For Quote (RFQ) to open the RFQ Register.
16. Create an RFQ for the Electrical Work cost item by selecting the New icon on the Actions tab.

17. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
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Cost Item Identification

Usethe following fields CBS Position Code

Flease select from the following options:

() Create RFQ from scratch

(®) Create RFQ from Quote Group Tag(s)

Only show Quote Group tags that
are currently utilized in this job

On the resulting RFQ record, only
list resources with utilization

currently greater than zero

(") Create RFQs using Default Seller data

This option scans the job for all
Resources and Quote Groups
utilized in the job. For any that are
listed inthe Address Book as
'Default Quotes' for the Sellers you
select on the subsequent selection
reqgister, a new RFQ record will be
added for each Seller listing their
default items.

Create separate RFQ records for
each Quote Group, per seller?

0K

18. Click OK.

19. Click on the Seller Companies tab and select the following Company Names:

InEight Inc. | Release 24.3

Description

[Unchedk All]
[Blanks]
Agaregates
Asphalt Materials
Commercial Work
Concrete Materials
Guardrail Work
Landscaping Work
Manhole Materials
Mone

Painting Materials
Pipe Materials
Process Equipment Install
Process Materials
Sign Work
Structural Painting
| Electrical Work

I I O

:

Cancel

8.5 Scope ltems
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¢ Architectural Designs
¢ HD Engineering Group
20. Highlight both companies and select Publish.

¢ Make sure the appropriate boxes are checked and fields filled out for publishing either by
fax or by email prior to publishing

i

=] Publish

'Ej' Create Quote
Process

Foundation Setup Data Register Quote Group Tag Recor

Description
Electrical Work

Response Deadline Date: | 1/2/2019 - Response De
Line Items Terms & Conditions Seller Companies Attachment

Drag columns here to group

Company & First Last
Mame Mame MName

Architectural De

21. Assuming that you’ve already received quotes back from both companies, create a Quote from
this RFQ for both companies by selecting the companies and selecting Create Quote.
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[=] Publish
E} Create Quote
Process
Foundation Setup Data Register Quote Group Tag
Description RFC 'Electrical Work'

Electrical Work
Quote(s) created: 2

Reznnn=e Neadling Date: TITA2019 T Bsnr

22. Click OK to close the RFQ record.
23. Select the Quote >Quotes tab to open the Quote Register.

* Note the 2 quotes that were just created for Electric Work

RFQ Quote
Description Status

S R e
EN— L e e

Description Seller

Aggregates Aggregates Received Example Vendor 1 --F
Aggregates Aggregates Received Example Vendor 4 DBE
Aggregates Aggregates Received Example Vendor 2 -5
Asphalt Materials Received Example Vendor 1 -—-F
Asphalt Materials Received Example Vendor 2 -5
crove,sewst [0 i oo
Electrical Work Electrical Waork Received Architectural Designs,
Electrical Waork Electrical Wark Received HD Engineering Group

24. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500, which is based
on the quote you received.

25. Select the Special Terms & Conditions tab and select the Seller’s Special Terms & Conditions
radio button.
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¢ You now have visibility for all of scope items for this quote

Flow

Number Scope Item Quote Group = Indusions
1 Permits Electrical Wark o
2 Surveying and Layout Electrical Waork o
3 | Temporary Traffic Cont... = Electrical Wark o
4  Trench and Backfill for E... Electrical Work o
5 | Painting Electrical Equip... = Electrical Waork o
6 Temporary Power andL... Electrical Work o

Amount

Estimate Intermediate User Guide

%% of Total

26. Assuming HD Engineering is excluding certain scope items from this quote, click on the Included

checkbox to exclude (uncheck) the following scope items:

¢ Surveying and Layout

¢ Painting Electrical Equipment

e Temporary Power and Lighting

Include Special Conditions costs forunawarded quotes in Comparable Totals

Drag columns here to group Find: | [Search For...] Saved views: | Previous View
R = Scope Item Quote Group Induded Motes
Mumber
1 Permits Electrical Work o

3 Temporary Traffic Contr...  Electrical Work \f

27. Type 150 in the Amount field for Painting Electrical Equipment.

¢ Notice how the 3 scope items you just excluded are now added to the Special Conditions

total for the quote
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lotal

Extended Price: £3,500.00
Item Taxes: £0.00
Quote Tax:

Bond:

Item Conditions: £0.00
Special Conditions: £950.00 |
Total: $4,450.00

28. Click NEXT to move to the other Quote Record for Architectural Designs.
29. Enter a Unit Price of 3,700.

30. Press Tab to move to the Special Terms & Conditions tab and select the Seller’s Special terms &
Conditions (at right) radio button.

31. Uncheck the Inclusions checkbox for Surveying and Layout

32. Add the amount 500.

ved views: | Previous View -

Amount %% of Total Motes

> 500,00 14,29

$950.00

33. Click OK.
34. Select the Quote tab.
35. Open the Quote Comparison and Award form, and select the Cost Items tab.

36. Under Quote Groups, select Electrical Work.
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Quote Group(s)
[ ] Description =
J Electrical Wark

Guardrail Work

Sign Work

Reviewed

Estimate Intermediate User Guide

¢ You will notice that scope items with inclusions and exclusions on the quotes are now
displayed in the Scope Items section. The Scope ltems button needs to be pressed in the
View section of the screen

e The total of all exclusions are now added to the Special Conditions section for each

subcontractor
$5,000.00  $3,700.00 $3,700.00 $4,450.00
$5,000.00 $0.00 $0.00 $0.00
$5,000.00 $0.00 $3,700.00 $3,500.00
$0.00 $0.00 $500.00 $950.00
TIP If your Special Conditions row is missing, click the Substitute Values icon on

the Action tab. You can also rearrange the sequence as desired.

(2 Quoted Items T3, scope Items

ﬁi Unit Price @ Ignored Quotes

85 Substitute Values z'? Configure Totals
View

Unit of
Measure

Total Cost

Unit Cost (Forecast)

.00 Each wo £ $0.01

Ih set Substitute Ranking

Caption

Minority Type
Quoted Total
Comparable Total
Awarded Total
Quoted Items Total
Spedal Conditions
Last Update

== ) session Recap

m

Configure Totals

Visible

V=

Sort

None
None
Ascending
None
MNone

None

SIS S SIS S

None

Cancel

TR
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¢ Most importantly, this comparison including scope items makes it clear HD

Engineering Group has provided a quote of $4,450, while Architectural Design’s
quote is $4,200

37. Right click on the quoted amount for Architectural Design and select Award to award the work
to Architectural Design.

Architectural HD Engineering
Designs, Inc. Group
Electrical Waork Electrical Wark:

Ta  Award And Lock
&l Lock
$50 Unlock
e ) Edit Quote
9 |00 Edit Cost ltem
) Edit Package
%) £300.00
%4,200.00 $4,450.00
%3,700.00 %$4,450.00
%0.00 $0.00

$3,700.00 %3,500.00

$500.00 $950.00

11/13/2019 1:0... 11/13/2019 2:2...

38. Click Yes, on the resulting prompt to mark the quote group as reviewed.
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¢ The Architectural Design’s quote is now awarded

Detail

Architectural
Designs, Inc,
Electrical Wark

%)
£500.00

LV Y Y

$500.00

11/13/2019 1:0...

HD Engineering
Group
Electrical Work

$4,450.00

&1

£500.00
%}
%]

£150.00

£300.00

$4,450.00
$4,450.00

$0.00

$3,500.00
$950.00
11/13/2019 2:1 |

8.6 QUOTE ITEM ADJUSTMENT

Estimate Intermediate User Guide

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.

Step by Step — Quote Item Adjustment

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison and Award section, select Resources.
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3. Locate the Example Vendor 3 column.

4. Select the quote you want to edit under the Example Vendor 3 column. In the Ribbon, select the
Actions tab.

5. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

Rcfdg““” Description Detail Example Vendor 3 E;E‘l'ﬂ! vendors
Pipe Materials Pipe Materials
$31.50 § & £32.55
R
= Award
Award And Lock
Lock
Unlock
Edit Quote ]
Duplicate Quote
Ignore Quote
Package Entire Quote

Edit Package

Edit Resource

6. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

Find: | [Search For...] m| Saved views: | Previous View -
= L]
Condition Adjustment Condition Adjustment |
Tax Rate P g " nt Total Price

ey g= If you enter a percentage, the amount is populated based on that calculation. This
is the same for entering a Condition Adjustment Amount.
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7. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

Resources Cost Items

Drag columns here to group

Code = ration Quantity Unit of Measure

MPP10 | 12,000.00 | Linear Feet

3,000.00 | Linear Feet

MPR36 1,024.00 | Linear Feet

Y Delete
< Cut
& Copy
B> Paste
I+ Eill Down

Link these fields to Excel

UnLink from Excel

i
Ll

8. As you populate the 10% discount adjustment to all of the items selected using the multi-edit
tool, the amount value changes to Varies. This is because of the variance in the unit rates for
each selected item.
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Description

Item
Line Number Code Quantity Unit of Measure

Tags
Quote Group Tag 1 Tag 2 Tag 3

Price & Setup Item Note | Seller Condition ‘
Setup Condition Adjustment
[ No split [ Free Amount: | Varies|
Percentage: I -lu.IJI}I
_ Price

Plug Unit Price: _ Unit Price: | \r‘ariesl

DBE Allowance %: _ Extended Price: l Uariesl
Default Tax Rate %: _ Tax Rate: l 5.00 |

Days Duration: | 1| Total: _

9. Select OK to save the changes to the line items in the Quote record and to save the Quote.
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Lesson 8 Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the

CBS Register
PBS

Quote Register

a o T o

RFQ Register

2. On a Quote Record, No Split means
a. The quote must be combined with other quotes from the same vendor
b. All items on the quote must be purchased from that seller

C. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed
b. No quotes have been awarded for that quote group

C. There are some quotes in the quote group that contain substitute values

Lesson 8 Summary

As a result of this lesson, you can:
¢ Create and publish RFQs
* Define quote pricing
e Compare and award quotes

* Create and analyze scope items

Page 104 of 257 InEight Inc. | Release 24.3



InEight’
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LESSON 9 — REPORTING

Lesson Duration: 30 Minutes

Lesson Objectives
After completing this lesson, you will be able to:

¢ Run reports from the Reports menu

e Create and run reports from register forms

Lesson Topics

InEight Inc. | Release 24.3
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9.1 REPORTS MENU

Estimate Intermediate User Guide

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,

that can help you review and analyze your estimate.

9.1.1 Non-Modal Report dialog box

The Reports dialog is docked along with the other forms and registers. You can continue to work with

your estimate without being forced to close the Reports dialog box.

Cost Breakdown Structure (CBS) Register Reports - Resource Changes &

Reports Settings: | Default

Print | Detals | Layout | HeaderfFooter | Resource Changes Report -Resource(s) Added to Job Folder

orp.
Job C: ob
Description: Training Job - Maricapa County No. TM2924

Cote  Descripion
NFPGS Pos 5 PUC SDR21

Resource Type: Installed Material Rite s ob

eDescipton Uit Ofeasre
Lnesr P

UnitCost Organizationd Casgory

Billing Rate 1
e

Geographic e WageZume  Quote Group
Quote Group T
Billing Rae2 Billing Rate 3
0 0w

GCode  Descrigion
MPFF! Ps 10°PVC, 45degbend
o5

b Tracking
Estimate Comparison Report
Audit

Job Register
> o Library Module

Unit Ofeasure

janizationd Casgory

Billing Rake 1
s

Geographic A WageZoe  Quote Growp
Quote Group Tag
Billng Rae2 Billing Ree
0 0w

Hinority Peoert
60008

Code  Descripion ResourceFileDexzipion  Unit Of Measre:
MPPF1 Ppci0'PVC, Odeghend  StandardMoteridRoeFfe  Each
o0

janizationd Casgory

Billing Fate 1
0

Geographic Ares WageZume  Quote Group
Quote Group Teg

Billing Rae2 Billing Rate .
1] om

Master Header fFooter Settings

If the report becomes undocked, the job code shows in the reports dialog box header.

9.1.2 Adjustable Reports

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting

format you need. Each report has its own set of output settings for configuring and formatting the

report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the

same report multiple times and choose different output settings based on what you want to see or

who the intended audience is.
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For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

e For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

» For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

¢ Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

Step by Step — Getting to the Reports menu

1. Open the Training Job, and select Setup tab.

e You access the Reports menu by clicking on the Reports icon

TIP You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.

Estimate Quote Price Execution System

B 2 B o &%LZx % a B

230, Equipment

Job Properties  Foundation  Pay Item &  Bid Wizard | Resource __ ) Resource CostItem  Standard Repaorts
- Setup Data ~ Proposal Rates = N Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.
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Estimate Intermediate User Guide

.._-""' Foundation Setup Da

= R
Y A ESOLrces

Resource Reqgister

Resource Changes

Print

Resource Rate Details

Resource Utlization

| e —— ) F | HERSE SN oty 1

¢ You will see a split screen with the reports available on the left side bar

e The side bar on the left of the Reports form contains a “tree” of all InEight Estimate

adjustable reports

- Reports
Job Properties
=*" Foundation Setup Data
v E Resources
Resource Register
Resource Changes
Resource Rate Details
Resource Utlization
Resource Utlization (Excel)
Resource Currency Comparison
Resource Assemblies
Cost Breakdown Structure
Quotes
Price Breakdown Structure
@ Pay Item & Proposal
» Biling R.ate Reports
¥ {E} Job Tracking

BT

w
[I
L]

L
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Settings: | Default - |

Print Details Layout Header Footer

{_J Print to Printer

Printer; AAdobe PDF

() Beport ta File

File:
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¢ On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

- Reports
[&] Job Properties
= Foundation Setup Data

~ gu Resources

Settings: | Default -

Print | Details Layout | Header/Footer

Resource Register () Print to Printer
Resource Changes
Resource Rate Details
Resource Utlization Printer: |Adobe PDF Change
Resource Utlization (Excel)
Resource Currency Comparison

» ';f Resource Assemblies

» .'.i Cost Breakdown Structure

» ‘Sb Quotes

» == Price Breakdown Structure () Bxport to File

» [@) PayItem &Proposal

»

»

Biling Rate Reports

{:r)- Job Tracking File:
Estimate Comparison Report Farmat: POF File Options
Audit
Job Register

4. Eachreport has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

Settings: | Default -

Details I Layout IIHeaderannterI

Y Print tn Printer

e There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
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reports

Estimate Comparison Report
Audit
Job Register
» n&" Library Module

Custom Reports

Saved Views

Budget Exports (®) Preview

Schedule Exports

Timesheet Exports

Format: |PDF File Options

w W w W

Timesheet Imports

Master Layout Settings
Master Header Footer Settings

9.1.3 Output Settings

This section provides a more detailed explanation of the output setting tabs.

9.1.3.1 Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

Print Preview

The Reports print previews opens in its own tab in the Report Dialog. This lets you keep the report
open while continuing to use other parts of the application.
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Reports - Resource Assembly Register  ©

9.1 Reports Menu

et

Detmds | Lajout

MeaderFoser

Resouroe assenty Utkzznen
Reenaie ety Guar ey G
« & CostEreshdown Stuchre

[ —

Siling Rt Raperts
Estmate Comparson Reart
Audt
Kb egater
» u Lbrary Mode

Custom Raperts
» Gaedems

Master Layeut Setsngs

Master Hesder Fogter Settrgs

AES0UCE Agsebly REgSEr SUTRErY

R
File Deserigtios
Sandard Assembl
Stmacard Assembl A
Stsdard Assembl Al
Stndard Anpembi A
Stasdard Assembl A
Staadard Assemby A
Stmndard Assembl Al
Smadard Assemb 7l
Fmadard Assemb 1
Swndard Assemby 4

-

Rancas Ass ety

Stadard Assembl A

Job Codke Training Job
Description Meriopa County Rosdesy Improvements
Gode Gezarpnan
coone Canrete Cron
coaaE Grading Crew
cHamT Equomest Manbanans
CHE Baireg Crae
o Pipecrew
e Fipe Fittng Assemnh (with matessl)
s ScraperCrew
CTRURC Truck Saeate-LoedHeul e
owin Welding o
= Anphelt Meneial Aoty [ el
MFE — — Standiard Anu
o008 DozerDg - DpEraL
OGRADMG | Grader 14G-Opented
OSCAAFST) | Scraperad - Cperated

Stmsdard Assemby

100
100
a0
Lan
Lan

Unit o

tach
Ton

P——

ni Cont
70
;T
2300
47828
s8¢
P
suuz

sE1eTz

s

Total ot
s
74T
s2n00
47624

£M354

a2

st
se0e
s
s

=08
§157482

Curreney

U, Dalar
U Dol
LS Dol
U5 Dol
s, belw

s, Dalw

AFERET

Us Dol
s pol
15, Dol
45, Dol
us. Dot
U, Dol

U, Dol

Organszatord
Category

Comcrte
Esrthwedc
Mechanic
Asphat
Pos

Poe
Esrthwctc
Earthwor:
e
Asphat
Comern
Exrthwca
Esrthwatc

Earths

Gengra
Are

You can also undock and float a report on a different form, or you can tile it side by side with another
register to view and compare them.

08 | L Som 45,318 57

Novigetion
v e
]

- FametonSeanten

Srngs: | befalt

P | ot Tiem Selection, | Detsie

=id
85 Camurey Commrien i 1
s

+ I3 Pros et Stucare

Py Dierw B Pceed
» [i] Mgt
Extrurte Carowrnan et
s
g
" Lbrar oie
Custom Rt
b e
s Lyt et
it e e 4o

B

T

L

85 Chstine Aepurt

Jon Coo T o
evempler Man

0

e Sty sy brrverreri

LA |
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Print Preview Ribbon

The Print Preview menu is displayed on its own ribbon. Menu commands are shown in the ribbon as a
contextual Print Preview menu when navigating to Reports > Print > Preview > Run.

Training Job - Extimate

(= = Bl Oy D & B PN Qa8 B @

Prnt  Quick Paremeters | Scale  Orientabon  Sie Find  Thumbnais fockmerks fdiing  Frst  Prevous  Next  Last | ManyPages ZoomOut Zoom Zoomln | PageColor Watermark | Export E-Mai
Frint - = - Fikls | Page  Page  Page  Page | O - - - Ta+ As<
Print Fage Setup Gl Havigation Zoom Page Background Export

Reports - CBS Summary ©
Reparts frint | Lsyout | Header/Foster — CostBreskdown Structure (CBS) Register Summary

[ Job Fropertes

Foundanon Setup Datm

Aesources

Resource Regeter

Cost Breakdown Structure [CES| Register Summary
Resource Changes InEight

Job Code:  Training Job

Resource Rate Detals Description: Maricopa County Restwsy Improvements

Resgurce Utizaton

Rescurce Utization (Excel) 'Dsmc:"sm Description Dm‘d (Tl’;?mﬂh‘ :!"I'Ez
Rescurce Currency Comparisan

» W& Resource Assembles Jos 20.00 Mie

« % CostEreshdown Structre Prime Bond PRIMEBOND 109 Lump Sum
CBS Summary Price % Add-On PRICE % ADD-0 100 Lump Sum

9.1.3.2 Apply custom Layouts and Headers/Footers to register reports

You can apply custom Layouts and header/footers to register based reports. Upon saving a view in any
register, select the option to save it as a corporate view and include the view in the reports dialog box.

Cost Breabdown Stucture (CB5) Register ©

= sesroten oy o Btaer
Ss -
Prime Bond e
Prce % Add-On TaEs
[ p ez o e s
I 7o comcocammsn [ umas | amm Csmmal neesese

EEY SITBwORK & BOADWAY

T bz

+az e & Grbiorg

=1 ncamed Evcmarnon

+ 1 Excrann

* 23z Erbanrent s -

LEY) fampeguBae 0o Ten s g [ ][ e
a1 Fuarinh & s s il

+ 1z

‘£ Breabdown Sinuctu (085 Acsiate 003 viow 1
wEgt

o Codes Training Jus
Dascrphor: Mancaps Cosy fnadey mprovamerts

Foveca ol
) Gty | Hemsue

a3
Poston Cade ==
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When selecting a Saved View from the Reports register you can use the Print tab to customize the
printing preferences, use the Grid Options tab to change the font type/size, use the Layout tab to
modify the design style, and use the Header/Footer tab to insert a header and footer to your report.

Reporis - (BSviewl ©

v Reports b
(2] 3ob Properties
.._" Foundation Setup Data

Settings: | Previous -

Print Grid Options Layout Header Footer J

-

=
da Resources

%5 Resource Assembies Settings: | Defeult

-

v mw Cost Breakdown Structure

CBS Summary

CBS Detals Fields - * Page Header
€8S Outline Report [t Primi ol
Estmate Summary

(8BS Currency Comparison

» 'S4 Quotes # of Pages #
» == Price Breakdown Structure
— Date Printed

v Pay Ttem & Proposal
Standard Proposal Time Printed
DOT Proposal — Report Header (first page only)

Report Title]
Pay Item Summary [Company Mame]
Pay Item Currency Comparison Version Job _':C_'de: [Jobr Cnde]_ i
Description: [Job Description]

Pay Item Price Breakdown Repart Tite

» [ Biling Rate Reports

. Company Name
Estimate Comparison Report

Audit Image
Job Register Yob Ovarvie
> w ) fErVIEW R E |
» 2 Library Module eport Footer (fast page only)
Custom Reports Job Code [Job Crastad ]
- Saved Views Job Description
v Cost Breskdown Striichure (CBS) R
CHS view 1 Job Currency
Cost Source View - Less Unassi Job Status
My view
Job Created by
My WEBS View4d
Page Footer
My WES View5 Job Tags
test 12345678

When you click on the Run button it will create a new register-style report. You can modify the layout
or header/footer directly in this register. You can also toggle between any of the four other tabs to
make modifications and see the changes on the saved view report.
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Reports - CBS view 1 @
v Repats * | settings: | Previous
[ Job Properties
" Foundation Setup Data
» £ Resources
» %3 Resource Assembies
~ §@ CostBreakdown Structure

Print | Grid Optons | Layout | Header/Footer | CostBreakdown Structure (CBS) Register CBS view 1

162022

CES Summary

Cost Breakdown Structure [CBS) Register CBS view 1
€S Detalls InEsght
Job Code: Training Job

CE5 Qutine Description:  Maricopa County Roadway Improvements

Estimate Summary

CBS Currency Comparison ces Optiond
» G Quotes Position Code S Code
» == Price Breakdown Structure 108
v Pay [tem & Proposal 4

Standand . Prime Bon FRIMEBOND

DOT Proposal Price % Add-On FRICE% ADD-ON

9.1.3.3 Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
Orientation, Margins, Font, and Number Format.
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Print Details

Layout Header Footer

Settings: | Default (Letter)

Orientation
(®) Portrait
() Landscape

Paper Size:

Font

Header Level 1z

Detail Level 1z

Header Level 2:

Detail Level 2:

9.1.3.4 Report Header/Footer Settings

Letter

Arial Marrow, &, Bold

Arial Marrow, 8, Regular

Arial Marrow, 8, Bold

Arial Marrow, &, Regular

Margins
Top:
0.50 =
Left:
0.50 =
Bottom:
0.50 =
Mumber Format
Decimal
Precision

Cost summary:
Unit cost:
Quantity:
Percent:

Usethousands separatar
[ ] Use currency symbal

[] Show zero values as blank

Currency: | AsEntered

9.1 Reports Menu

Header:

0,25 =

Right:
0.50 =

Footer:

0.25 =

Significant
Figures

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer

sections of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
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4. You can enter your own information as desired.

Settings: | Default - o

Print Details Layout Header [Footer

Settings: | Default -

Date Printed * Page Header
Time Printed

User Mame

Version o

Repaort Title

Company Name
=i Report Header (first page only)

Image Report Title] [Job Description][Job Currency][Job Created by]
[Company Name]
- Job Code: [Job Code]
v Job Overview Description: [Job Description] o

Job Code
Job Description

Job Currency

Cover Sheet fields and Job folder tags

In addition to the existing job code and job description tags in Job Properties, you can use the Cover
Sheet fields and Job Folder tags for your headers and footers in all standard reports.

Additional tag values such as contract numbers, work order numbers, PO numbers, company logos, or
any other tag fields can also be included. These additions help you customize headers and footers to
give the recipients more transparency in the reports.

INEIGH'@

o Mo Coaly . Tom Tk
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A Header and Footer field menu exists to the left of the Page Header and Page Footer grid, for all
standard reports. This lets you choose which fields from Job Folder Tags and the Cover sheet to include
in your report.

Reports - Resource Register ©

Reparts Print | Details | Layout | Headsr/Footer

[&] Job Fropertes =
=¥ Foundation Setup Data
¥ & Resources Fields ~ * | PageHeader
Resource Register
Resource Changes Report
Resource Rate Detale Job Overview
Resource Utlization
Job T,
Resource Utlization (Excel) =
Resource Currency Comparison Tagl Report Header (frstpage anly)
» %R Resource Assemblies — [Report Title] [User Name]
a0 Co N:
» @l CostBrekdown Structure [Company ::Icwe: TJob Code]
» &b Quotes Tag3 Description: [Job Description]
» £ Price Braskdown Structure rag4
» [B PayItem & Propossl
» ] Biing Rate Reports Tog § Report Foater Jast page only)
Estimate Comparison Report Tag6 [Company Name]
Audt
7
Job Register &
» w¥ Library Moduie Tag8
Custom Reports
e eper rags Page Footer
* Saved Viens [Dae Prined] [Time Printed] Copynght ©022 Inight hc All Rights Reserved. Page # of Pages )
Master Layout Settings Tag 10
Master Header Footer Settings rog 11 =

Run Close

You can customize your header and footer layout settings, save them, and re-use them in other
reports.

Settings: | Default

Print Details | Layout | Header/Footer

Settings: | Default
Custom
Default
Fields | 1 Save New Settings . O X
Repc 2
Header [Footer w Logo Name:

|Resource Rate Details option 1| |

P Header [Footer w Logo - Lundy

p/ InEight Header [Footer w Logo
| Ok || Cancel
LibraryJobProperties -

D
LibraryJobProperties2
IHREDOIT TTTE]

9.1.3.5 Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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Settings: | Default -

Print | Details Layout | Header/Footer

Show the below Pay item details
Line Number

Pay Item Number

Position Code

(] Subtotals

(] Running Totals

(] Suspended Items

Indude Additional Proposal pages
[] Cover Sheet

Estimate Intermediate User Guide

Filter by currency: Mo Filter

Show the below Proposal header items

[]3ob Cade [] Jab City
[] 30b Description [J 3ob County
[ Bid Date [J3ab state
[ Bid Time [J 3ob Country

[] JobLacation

Term for Document

(@) Proposal/Bid

[] Preferences Sheet () Tender

Unit Price precision (O Custom |
(@) Truncate values based on decimal precision

(O Do nottruncate values {show decimal precision)

Certification Text: (O) None (®) Custom

Signature Block:

(] submitted By

9.1.3.6 Save Output Settings

[] Include Signature Line

(] Include Title Line

[] Include Date Line

Once you’ve configured your settings for the report, you can save them as a custom version of that

report.
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- Reports
[=] Job Properties
.._-"' Foundation Setup Data

v 4m | FESOUMCES
Resource Register
Resource Changes
Resource Rate Details
Resource Utilization
Resource Utilization (Excel)
Resource Currency Comparison
> 'ﬁ' Resource Assemblies
w ."i Cost Breakdown Structure
CBS Surnmary
CES Details
CBS Outline
w Estimate Summary
F___| Estimate Summary - Foreman I
CBS Currency Comparison

9.1 Reports Menu

Settings: | Estimate Summary - Foreman v

Print | CostItem Selection Details Layout
@ Print a contiguous range of cost items:
From: 5.1

To: 6.2

() Select cost items to print from the register below:

Find:

[Search For..

Alternate Scenario:
BASE

Header Footer

J Saved

The following steps walk you through configuring the settings and formatting for two different reports.
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Step by Step — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup >Report>Resources.

[

Reports

Reports

- Reports
Job Properties
=*  Foundation Setup Data

Resources

w

-
3
[

I Resource Register I

Resource Changes
Resource Rate Details
Resource Utilization
Resource Utiization (Excel)

Resource Currency Comparison

2. Under Resources on the left side bar, select Resource Utilization.

' Reports - Resource Utilization

- Reports
Job Properties
.._-" Foundation Setup Data

= Q
v ES0LUrces

Settings: | Default - |

Print | Details Layout | Header/Footer

Resource Register () Print to Printer

Resource Changes o o
Resource Rate Detailz o

Resource Utilization Printer: |VWHDAZPrintServ.harddollar.local\Main Office Change

Resource Utilization (Excel)
Resource Currency Comparisan
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3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.

Print §| Details Layout | Header/Footer

() Print to Printer

Printer: | WHDAZPrintServ.harddollar. local\Main Office Change

() Bxport to File

File:

Format: |PDF File Options

(@) Preview o

4. On the Layout tab you can make adjustments based on your preferences.
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Print | Details Header [Footer o

Maragins
Settings: | Default (Letter, Landscape) - Top: Header:
. ) 0.50 = 0.25 =
Orientation
() Partrait
(® Landscape
Left: Right:
Paper Size: Letter w 0.50 = 0,50 =
Bottom: Footer:
0.50 = 0.25 |
Font Mumber Format
- Decimal Significant
Header Level 1: | Arial Marrow, 8, Bold Pracision T
Detail Level 1: Arial Marrow, 8, Regular Cost summary: 11
Unit cost: - |:| 1
Header Level 2: | Arial Narrow, 8, Bold -
Quantity: 11
Detail Level 2: Arial Marrow, 8, Regular
Percent: |:| 1

Usethousands separator
[ ] Use currency symbaol

[] Show zero values as blank

Currency: | As-Entered -

5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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Print | Details Layout Header Footer

Settings: | Default -

|@||:| Insert Field -

Page Header

Report Header (first page only) o

| Resource Ufilization |

oparty maime)
Job Code: [Job Code]
Description: [Job Description]

Report Footer (ast page only)

6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.

Settings: | Default o -

Print Layout | Header/Footer
Filter by currency: Mo Filter i -

Report Type

I@ Resource Utilization Summary Io

() Resource Utilization Summary with Employed Cost Items
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* You can choose to select the Hide Zero quantity/cost Resources Employments Details box

if you prefer to have your printed report not show any resources that have a dollar value
of zero

Details

[ ] Bxclude details and only show subtotals

|:| Show Currency Summary

Hide Zero quantity/cost Resource
ﬂD Employments

¢ You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

¢ If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

¢ You would select this if you wanted to see cost items and resources by the cost item

TIP The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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Group By Resource Type
[] Insert page breaks between the outermy, SUps Labar @
IResnurce Organizational Category Q R I e R e \‘_./
|:| Rented Construction Equipment
< no field selected = w
[] Installed Material
< no field selected > e (] Installed Equipment
< no field selected = W [ Supplies
] unigue
< no field selected = e
< no field selected = W

¢ For this example, you will not make any selections under Columns or Details

Columns Details
[] show Currency column BExclude details and anly show subtotals
Show plug rate for non-hourly resources [] Shaw Currency Summary

Show tax separately from plug rate for non-hourly resources

Show hours for non-hourly duration driven resources

e This is just one of many ways to organize and adjust your report.
11. Click Run to run the report.

¢ This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

Step by Step — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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[

Reports

Reports

- Reports
Job Properties
.._-" Foundation Setup Data

» = Resources
I

+ W% Resource Assemblies
'IE.: Cost Breakdown Structure
CBS Summary
CBS Details
CBS Qutline
¥ Estimate Summary
CBS Currency Comparison
» =h Quotes

» == Price Breakdown Structure

2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.

w Reports &
Job Properties
=*" Foundation Setup Data
¥ i Resources
Resource Register
Resource Changes
Resource Rate Details
Resource Utilization
Resource Utilization (Excel)
Resource Currency Comparisor
» &% Resource Assemblies
v i.i Cost Breakdown Structure
CBS Summary
CBS Details
CBS Outline
» | Estimate Summary |

CBS Currency Comparison
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

Settings: | Default ol Alternate Scenari

Print | | Cost Item Selection Details Layout | Header/Footer

4. The Cost Item Selection tab allows you to report on a selection of cost items:

e Print a contiguous range of cost items: Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

¢ Select cost items to print from the register below: Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, and Man-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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Estimate Intermediate User Guide

Print Cost Item Selection Details Layout Header [Footer
' Resource Employments
Filter by currency: Mo Filter i
- | Print Resource Employment Details
enera
F = (®) Print resources in row number order
: o Group w
() Print resources in alphabetical order
[ ] Show Suspended Items
Print resource costs
/| Motes
Print hours for hourly resources
Awardee o
Wheln filtering, only include terminal cost items in Resource ﬂfpes
tota

Fields o

[] Ad-hoc Employments
Labor

Costitem productionfield 1:

Costitem productionfield 2:

Cost item text field:

Employment text field:

Days - Construction EQuipment
[] Rented Construction Equipment
Tt - Installed Material
R i [] Installed Equipment
[] Supplies
Currency e [] Unique

[] Resource Assemblies

8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential —Internal Use

Only.

Page Footer

[Date Printed] [Time Printed]

Confidensal - Intemal Use Only [Page 2 ofPagss 2

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output

setting tabs.

Page 128 of 257

InEight Inc. | Release 24.3



Estimate Intermediate User Guide 9.1 Reports Menu

Print Cost Item Selection Details Layout Header Footer

Settings: | Default =

|@@||I|InsertFieldv Ik

11. Select the Save diskEI icon to save the new settings.

Settings: | Default

@ |8

Page Header

Custom

12. Type Estimate Summary — Manager.

13. Click OK.
Save Mew Settings — O it
Name: Estimate Summary - Manager]
QK Cancel

* Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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T LT P PR
¥ .'.i Cost Breakdown Structure
CBS Summary
CBS Details
CBS Outline
w Estimate Summary

Estimate Summary - Manager

CBS Currency Comparison
w =4 Miintec

9.1.4 Helpful Reports

9.1.4.7 PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

e Cost Categories
e Markup Rate
¢ Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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v Reports

[E] Job Properties
Foundation Setup Data
Resources

[ 11 i'\.

i Resource Assemblies

w
.

» .'.i Cost Breakdown Structure
» ‘S Quotes
w = = Price Breakdown Structure
PBS Summary
PBS By Cost Source
PBS Changes Reqister
» [Z) Pay Item &Proposal
» Billing R.ate Reports
-E_E} Job Tracking
Budget / Contract Changes Re|
Budget Variance Report
Cost Details
Job Status

Time and Expenses

<

Payment Approval
Estimate Comparison Report
Audit
Job Reqister
» .._-" Library Module
Custom Reports

Settings: | Default

Print | Details Layout

Header Footer

9.1 Reports Menu

v || M Target Price

v [/] &

Target Profit

V| % Indirect Cost Markup
+ | % Direct Cost Markup

v |+ | j& Total Cost

w |+ | =  Indirect Cost

w (v | =

SRS S]] S
EIEIEIEIEIEIEIEIEIEIEIEII*
ooo om

oW -

Business Overhead

Oooooooo

Unassigned Business Overhead
Indirect Cost Escalation

Direct Cost Escalation

Prime Bond

Price % Add-On

Job Financing

Indirect Cost Add-On

Job Cverhead

w |+ | gm Direct Cost
v | gm Unassigned Direct Cost (Work Plan)
+ | gm Assigned Direct Cost (Work Plan)

Cost Categories
Markup Rate
Percentage of Cost

[] Markup &nalysis

[] Price Status

[] Cost Source Analysis

[] resaurce Utilization Analysis

[J Minority Goal Attainment Analysis
[] subcantractorAnalysis

[ vendaraAnalysis

Run Close

TIP You can also select to show markup rate and what percentage the markup is of your cost.

9.1.5 Access Control

You can use the Access Control report to audit user permissions, command access, and various
restrictions without having to search through the Access Control register for this information.

InEight Inc. | Release 24.3

Page 131 of 257



9.1 Reports Menu

Reports - Access Control (Excel) ©

AutoSan
File Home Insert Page Layout  Formulas
c1 - I Ribbon Name
A B
1 |Tvpe Category
2 | Command
3 Command
Bauchit 4  Command
2o Register 5 Command Bond Cost Item Record
InEight Schedue Cost Risk (s 6  Command Bond Cost Item Record
v o Lbrary Mode 7 Command Cash Flow
Fresa - ———— 8 |Command Cash Flow
9  Command Cash Flow
Master Foundaton Setup Data 10 Command Cash Flow
» Master Resources 11 Command Cash Flow
Master Resource W 12 Command Cash Flow
Acoess Control (Exced) 13 Command Cash Flow
» Saved Views (Lbrary) 14 Command Cash Flow
Custam Reports 15 Command Column Captions
» Saved Views 16 Command Column Captions
. o N 17 Command Column Captions
18 Command Connected Analytics
AR oo o) A A A i
Access Control (Excel) Export

9.1.6 Standard Proposal

File name  C:\sersiPaul Downloads \AccessControlExport. dsx

Estimate Intermediate User Guide

Paul Trippi
Review  Wiew Automate Help U Comments
C o E =
|Ribbon Name |1_MR 719-R1  Account Administ

Actions > View > Default Data Blocks
/A

Actions = Print > Page Satup

Actions > Print > Preview

Actions = Print > Print

Actions > Tools = Cash Flow Options No Mo No
Actions > Tools > Display Settings No No No
Actions > Tools = Worksheet No Mo No
M/A

/A No Mo No

{Context Menu) = Change Caption...
(Context Menu) = Reset All Captions...
(Context Menu) > Reset Caption...
Actions > Tools > Auto-Update

Ambimmn n Tomle o nmnnli et

a4

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for

contractors required to submit a pricing proposal to a client. It lists all the pay items with the client

provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &

Proposal Register), cover sheet information, and a signature block.
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9.1.7 CBS Details

Proposa

Proposal
ACME Company

Job Code: Training Job

Description: Training Job - Maricopa County No. TM2924
Position Code LineNo.  PayltemNo. Descripion
Subtotal Deacripion

n 200 SITEWORK & ROADWAY
11 10 410100 Mobilizaion
12 20 2010102 Clearing & Grubbing
13 30 2020183 Unclassified Excaain
14 40 Aggregate Base
15 50 3034283 Asphait Concrete Hot Mic Type A
2 13 400 WATER & SEAER
21 50 413{B)0454 38 Inch RCP Culvert Cess I
22 70 8000220 10 Inch PVC Force Main (SOR21)
23 B0 8000330 24 Inch PVC Gravity Sewer (SDR35)
24 20 800 0400 4 Foot Diameter Manhoe

Quantity Unit of Measure

1.00 Lump Sum
10.00 Ace
50,000.00 Cubic Yad

40,000.00 Teon

38,000.00 Ton

1,000.00 Linear Fest

.

2,000.00 Linear Feet
,000.00 Linear Fest

16.00 Each

UnitPrice  Total Price
3,402,70040

395,600 39550000
5,90000 59,000.00
S50 27500000
4245 1,613,10000
718,550.00

9745 9745000
285 354,00000
8430 193,50000
4,50000 73,600.00

9.1 Reports Menu

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS

Register, including cost items with production, costs by category, shift arrangements, resources, and

notes.

Cost Breakdown Structure Details
INEIGHT - PAUL TRIPAI
Job Code: Training Job
Description: Training Job - Maricopa County No. TM2924
From Costltem: 1 To Costitem: 0.10
i Costhsm Unitand Totsl Casts by Cataqary
| cBS Pason cost Farscsst TI0] X ) )
| coas o1 Descripgon e Quantly un unitcost TotaiCost Lanar Owned Equipment Rented Equipment iz Suppies  Sunsoniadt
1 vioziizaion B 1.00 Lurmp Sum 190951 190951 24951 59000 am a0 [ am
244051 535000 am a0 aon am
Notse: Thew % 10 inas. Figue Lotin only. The next job willpick up the hicb out
Ace 3500 Conlingency Allcuanc in case e pemils % e
Payiem Azsignment 5410100 Mogiizaan]
Dstsut Progsriss: AocountCads CostCuris 131 T2 T3 Tag4 T35
1020 L Estmanr | mosteEy
opsonal cads Pnazs Cods wmers oy QuotGroup Quansy Driver winarity Aaw e avarie
110100 100 Fap 10000%
Defaurt Pay Rules: wage seaie 1 wage Seae 2 Wage S29 3 Resaurcs Wark Hra Resaurcs Paytra Detaurt snift Work Hraisnit snifailay Dayzrnves
10000 am am a0 am Arrangsmants a0 10 s
Fraducson
Dursfon Daye suifs Hours ManHaurs EquipHours Cast/ Durzfion CastDay costsnit Casttour CostMand.  CosEquipdr
100 000 @ 0 16000 119085 119095 188 1887 a3
M} Durson ussnif uHour UBMzn He UMEquipHr Durafon | UM suifaum Houraim Man UM Equip HraiUm
aw an agt am an 1200 1200 2w wnm 18200
Resaurcs Cods DeseripSon Quan¥y  PayHoura UM UniCost  TotlCost Unitand Tl Caste by Cateqary
zesmbty Cost Driver acoountCods T Tz T3 Warkers Coma % K
»
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9.1.8 Audit

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

e Zero Price Pay Items
e Zero-value cost items
e Pay items without Cost Items assigned

¢ Resources with a quantity of zero
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Exercise 9.1 — Run a System Report

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. Onthe Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 — 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results

ABC Contractors
Job Code:  Training Job
scription: Training Job - Maricopa County No. TM2924
From Ham: 303 4263 To Hem: 500 0220
payCasttn o vmcotoyoseey
Azmignad Dwmsd Ranisd

Code Descripfion Quanfiy UM Diract Cost Labor  Equipment  Equipment Watsrials Suppliss Subcontract Fess  Allowancs
03 4263 Aspnat ConcrEte Hot ME Tyoe A 56,00000 Ton 4252 an 643 om 1350 i) i) 158 i)
3 Aspnat ConcrEte Hot ME Type A 56,00000 Ton 161945035 an 643 om 1350 i) i) 158 i)
5.1 Fumish & Had Hot X 56,00000 Ton 149236218 143 477 om 1350 i) i) 158 i)
52 sl Ho ME Type & 5500000 Ton 127 4817 168 188 am am 0 0 000 000
A13E) ME4 35 Inch ROP Culvent Class 1,00000 Linesr Fest 6642 19.50 1348 0% 3052 i) i) 138 i)
& 36 Incn RCP Cuven Ciass 1,00000 Lines Fest B5A167T3 1950 13458 il 052 0 0 152 000
6.1 Fumizn RCE Maeias 1,00000 Linesr Fest 3236133 am (L] am 052 i) i) 154 20
62 Excaiae RGP TEnCn 1,515.00 Cutic Yam 518320 455 s om om i) i) 00 i)
53 sl AC Fipe 1,00000 Linesr Fest 11,7353 645 52 am am [iT:] [iT:] 000 000
64 Bacedll RGP Fipe 1,550.00 Cutic Yam 14,136.32 &351 455 il am 0 0 005 000
SUSTOTAL SITEWORK & ROADWAY 16858714 1T A0 25776656 920 122782031 i) i) 61437.35 i)
00 0220 10 Incn PG Foree Main (SDR21) 1200000 LinesrFest 251 455 472 am 1260 [iT:] [iT:] 053 [i1:]
7 10Inch PVC Fore Main (SDR21) 12,000.00 UnesrFest 27016537 455 472 om 1260 i) i) 053 i)
7.1 Fumizn 10 nch PVC Maeisis 12,000.00 UnesrFest 158,760.00 oM oM om 1260 i) i) 053 i)
72 ExcavanstEl-Eacil 10nen FVG 1200000 LinesrFest 11140557 455 472 am am [iT:] [iT:] 20 [i1:]
Extendsd Totals By Caisgory 195601051 19259907 31445616 92690 1,578,020 i) i) 58.997.35 i)
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Congratulations, you have completed this exercise!
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9.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

tup Estimate Quote Price Execution System
% Print ﬂ Mew % Copy Split Indent Link Field
'%_ Preview Delete Paste Split by Cost Type Dutdent Unlink Fie
&' Export to Excel Cut Fill Dowen t; Togale Suspended
Print Edit Workbook

Cost Breakdown Structure (CBS) Register ©

CB5S Tree (Filter Mode) = Drag columns here to group

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.
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Step by Step — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

Estimate Quote Price Execution System
* Al
B B ™ &% '3 A
T [ s o a
Job Properties  Foundation  Pay Item &  Bid Wizard | Resource, .= _ Resource Cost Ite
- SetupData = Proposal Rates I Materials  Assemblies | Assembli
Initialize 2. Labor Ass

#0  Construction Equipment

#%  Rented Construction Equipment
== Installed Materials

%% Installed Equipment
ﬂ' Supplies
&

Unigque

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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Saved views: | Previous View = .

Previous View

Acc, .. C
Code

Print View for Breakdown

A Utilized Resource View

4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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Maint. COrganizational Geogra...
Man-H... Category Area

- 21 Sort Ascending

Z1 Sort Descending

[}

C Clear All Sorting

[ :l: Group By This Celumn

( Hide This Column
Remove All Columns

Go To Column... (Ctrl+3])

C
Column Chooser

0 s+ Best Fit

[}

6. From the Customization window, drag-and-drop the Minority Percent, Unique Sales Tax, (Scale
2), and Maint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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¢ This sorts your items so the most utilized resources are at the top

Resource Utilization — Maint. Crganizational
Code Count Man-H... Category

+ LL2 8,946, 59 0.00  Laborer

+ LO2 4,734.02 0,00 Operator

+ LT1 3,611.05 0.00  Truck Driver - Team...
+ LO1 1,640.00 0,00 Operator

+ LO4 1,484.63 0,00 Operator

+ LC2 1,188.73 0.00 | Carpenter

+ LO3 889.33 0.00 Operator

+ LSSUPT a00.00 0.00  Supervision

+ LSSEC 200,00 0.00  Supervision

+ LSPE 200,00 0.00  Supervision

+ LL3 721.33 0.00  Laborer

+ LIW1 394.37 0.00  Iron Worker

9. Click on the Saved Views drop-down menu and select the Save disc M icon to save the view.
10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actions menu, select Preview to review the report before printing.
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Labor Register

INEIGHT - PAUL TRIPPI
E101 - Training Job KL--Sample Training Job

"o liten | Ui e | MROB s

Factor

Lo1 Operator Class 1 680.00 | Hour 0.00 0.00 0.00
L2 Laborer 590.00 | Hour 0.00 0.00 0.00
-LSSUF"I' Project Superintendent 560.00 | Hour 0.00 0.00 0.00
.LSSEC Secretary 560.00 | Hour 0.00 0.00 0.00
-L03 Operator Class 3 220.00 | Hour 0.00 0.00 0.00
LLS Labor Foreman 200.00 | Hour 0.00 0.00 0.00
-L04 Operator Foreman 110.00 | Hour 0.00 0.00 0.00
-LT1 Teamster 100.00 | Hour 0.00 0.00 0.00

9.2.1 Register Report Output Settings

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

9.2.1.1 Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:
* Page Size (legal, letter, etc.)
e Paper Width & Height
¢ Orientation (portrait or landscape)

e Page Margins (left, right, top, bottom)

9.2.1.2 Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Exercise 9.2 — Create a Custom Register Report

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in the Man-Hours (Total) and Man-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Cost Breakdown Structure (CBS) Register
ABC Contracting Inc
Training Job—Training Job - Maricopa County No. TM2924

Pnslttlznsr?[:nde Description [ngi’;;f;tt‘w ML‘L"E':SL M?;Ht:ll;rs Unit Cost Labor Total Cost a:ontraelccaasg btal m{all:‘;;'aolrl:tr:nann‘m Equipment Total Man[JHh:ursf Materials Total Cost|  Currency
JoB 20.00 | Mile 27,993.15 $306,883.14 §907,442.76| $§6,137,662.81 23,438.44 §1,062,750.40 $3,393,700.70 | U.S. Dollar
Prime Bond 1.00 | Lump Sum 546,686.14 $0.00 548,686.14 50.00 $0.00 | U.S.Dollar
Price % Add-On 1.00| Lump Sum $309475.27 $0.00 $309,475.27 50.00 $0.00| U.5. Dollar
Job Financing 1.00 | Lump Sum §0.00 §0.00 50,00 50,00 £0.00 | U5, Dollar
Indirect Cost Escalation 1.00 | Lump Sum §0.00 §0.00 £0.00 £0.00 £0.00 | U.S. Dollar
Direct Cost Escalation 1.00 | Lump Sum $11,026.79 $12,026.79 §11,026.79 50.00 {51,000.00) | U.S.Dollar
Indirect Cost Add-On 1.00 | Lump Sum §0.00 $0.00 $0.00 $0.00 §0.00 | U5, Dollar
JobManagement & Equipment 1.00| Lump Sum 2,400.00 §157,096.28 £91,176.28 §157,096.28 2,400.00 £65,920.00 2,400.00 £0.00| U.5. Dollar
General Expense 1.00| Lump Sum 0.00 $4,200.00 §0.00 §4,200.00 0.00 £0.00 0.00 $0.00 | U.5.Dollar
Direct Cost Add-On 1.00 | Lump Sum $109,544.08 $15,676.56 $109,544.08 $19,450.89 $66,546.70 | U.S. Dollar
1 Mobilization 1.00| Lump Sum 0.00 £75,000.00 £50,000.00 §75,000.00 0.00 £0.00 0.00 €25,000.00 | U.5. Dellar
2 Clearing & Grubbing 10.00 | Acre 0.00 £0.00 §0.00 £0.00 0.00 £0.00 0.00 $0.00 | U.5.Dollar
3 Unclassified Excavation 50,000.00 | Cubic Yard 3,964.29 §9.95 §110,467.00 $497,466.56 4,115.48 §302,999.56 0.08 $0.00 | U.5.Dollar
3.1 Excavation, scrapers 50,000.00 | Cubic Yard 1,250.00 $3.00 $33,170.48 $149,922.88 1,325.00 §116,752.40 0.03 $0.00 | U.5.Dollar

Congratulations, you have completed this exercise!
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Lesson 9 Review

1. The Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary
b. PBS Summary

C. Audit

2. The Report is a very important report to run during bid review to make sure
you didn’t leave anything out of the estimate.

a. CBS Details
b. Audit

C. Pay Iltem Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:

¢ Run reports from the Report menu

e Create and run reports from register forms
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LESSON 10 — DATA REPRODUCTION

Lesson Duration: 20 Minutes

Lesson Objectives
After completing this lesson, you will be able to:

¢ Create a job from an existing job or template

¢ Create a template

Reproduce estimate data using the Bid Wizard

Reproduce estimate data using copy/paste

Add cost items to a job using the CBS Bid Wizard

Utilize the Snapshot function

Lesson Topics

InEight Inc. | Release 24.3 Page 145 of 257



10.1 Copy an Existing Job Estimate Intermediate User Guide

10.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of

the existing job.

Using the Create a new Job from... Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

Step by Step — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

Library - Estimate

Estimate Execution System Integrations Actions

ile
A
’ I Ya = e . Labor pa
- 1 H] HH] (] i‘ ﬂ

23 Equipment
Job Properties  Foundation  Address  Trench shiftRate | Resource Resource CostItem Standard User Roles  Access Reports

SetupData~  Book  Calculator Calculator | Rates ~ 5 Materisls  Assemblies | Assemblies  Tables Contral
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

2. From the left side panel, select New, then select Existing Job.

Library - Estimate

Create a new Job from...

B F S EH F B EE

Scratch Template Existing Job Bid Wizard Archive Snapshot Primavera US Cost

Templates

Snapshots

Archive | Restore

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, click the ellipses and select a Core Project.
In the Code field, type Infra Job Copy with your initials.

6. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

» If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

7. Uncheck the check for copying the PBS Changes Log, Copy Quotes and Auto-Update Job in
Connected Analytics.

8. Click OK to create the new job.

New Job from "190002-1"

Core Project: ™ | 104257

Code: ™ |InfraJob Copy

Description: Infra Job Copy

Copy Cost Details
[ ] Copy PBSChanges Log

[ ] Copy Quotes

[ ] Auto-Update Job in Connected Analytics

Ok Cancel

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.
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This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

10.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

Step by Step — Create a Template

1. Click the File tab on the Estimate landing page.
2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.
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Templates

Template Register

Close All Jobs

4. From the Actions tab, select Create Template from Job.

Estimate Execution System

lﬂ Mew Iil_‘—_l

= Print

"%. Preview Delete
Create Template
@Y Export to Excel Load from Job
Print Edit Tools

¢ The Job Register opens for you to select the source job for the template
¢ Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.
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Estimate Intermediate User Guide

Selact the scwrce job:

Find: | [faand For...]
Ciode In Use Description
= JE11- Tranng Job i | Sarrpie Triarurg Job
Trairirgy Job o Training Job - Maricopa County Mo, TMZ

Spved views: | Previous View =

Schedule Locaton Gty

MoosoftProj . S0thStresthShes  Sootis
Mioosoft Prog..  [-30 MP 100 to MP Phoerix

Jlela You cannot create templates from jobs that are published to Job Tracking.

¢ The New Template From Job 'Training Job' with your initials prompt appears.

Hew Template from Job 'Training Job'

Organization: 5100000 - PKS Inc

Code: ™ |

Copy Cost Details

Copy PBS Changes Log

Copy Quotes

0K
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6. Click the ellipsis to the right of the Organization field.

Organization: S100000 - PKS Inc

Code: *

Description:

0K Cancel

The Organization Register Library opens.
In the Organization Register Library, select an organization and then click OK.
8. In the Code field, type Small Project Template[your initials].
¢ Leave Copy Cost Details and Copy PBS Changes Log checked
9. Click OK.
¢ The new template is created and opens to the Job Properties form

e You can add the description in addition to the code for any new job you are creating from

a template. This description is later added to the Overview tab of the new job on the Job
Properties form

Job Properties ©

Cverview Security Cower Sheet Cost Basis Minority Setup Fuel Cost Job Tracking
Code: 099KL

Description: | sample Training Job M———

¢ Back in the Templates Register, you can see the new template created
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Setup Estimate Execution
E,!l Print E Open Load ""j
o Freview O new  2; Cose =l
& Eport toExcel | ) Delete m’ﬂmu
Print Edit Tools

Template Register ©

ag columns here to group

Code 8 In Use Description Status Schedule

= Smal Project Template KL | Microsoft Proj

 Similar to copying an existing job, you can create a new job from a template
from the New menu in the Backstage View.

Create a new Job from...

Scratch Template Existing Job Bid Wizard

* You can also create a new job from a template from the New menu in the Bid
Wizard.

Create a new Job from...

- ¥ *
Scratch Template Existing Job Bid Wizard

10. Select Add to existing job
11. From Select Source Job, click the dropdown arrow

12. Click Next
13. Select a job that is shown as having a Template

14. Click OK
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Step 1: What would you like to do?

Code = Is Template Status Location
O Create a newjob:
. S 09K Bidding 90th Street &
E101 - Training Job KL 1 Bidding o). 90thStreet &
Smal Project Template KL Bidding 90th Street &

Biddng  MirosoftProj.. I-10MP 100t

Deseription:
existing job: [Select Source Job] - Training Job a L]

2

10.2.1 OBS filter tree

The Template register's organization tree filter shows the templates assigned to a selected
organization.

Library - Estimate

Integrations
&h print O new Close ET" E
A Preview Delete
Create Templatz | Organization
& Export to Excel Load from Job Tree Filter
Print Edit Tools View o
Template Register © / -
Organization x 6‘5; columns here to group saved views: L0
Name Code = InUse Description Status Schedule Location Ccity County State Country
MLQ-SUPPORTCASE1 (| Class 3 Microsaft Proj.
MLQ-SUPPORTCASE1-1 (| Perf sQLBuk Copy  Class 3 Microsaft Proj.
i J Bidding Microsaft Proj...
TiEn [1 atEnergy Bidding MicrosoftProj.. [-10MP 100 toMP .. Phoenix Maricopa  @Geo_.. United Stat
T1nf (| Bidding Microsoft Proj...  [-10 MP 100 to MP Phoenix | Maricopa @Geo_.. | United Stat
T2-0andG (| Bidding Microsaft Proj. Farah Afghanistan
»  SB2000 - Energy
> SB3000 - Infrastructure
> SBA400D - Mining
> SB5000 - Other
»  SB5000 - Home Office
z o
6
« LI »

Close Cancel

Just like the job register, the list of templates is filtered based on the selected organization. The
primary difference between the OBS tree filter in the job and template registers is that estimates are
associated with projects in the job register, and projects belong to an organization. In the template
register, templates belong to an organization.
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Organization x Drag columns here to group

Code

"

= |1
Ti€n

y
S
(

(

»  SB5000 - Other
»  SBS000 - Home Office

10.2.2 Archive and Restore Templates

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

Step by Step — Archive and Restore a Template

1. Click File to open the Backstage View.
2. Select Archive / Restore.

e Several options appear for archiving and restoring your jobs, templates, and library
3. Select Archive Template.

¢ The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.
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5. When prompted to include attachments, click Yes.
¢ The Save As window appears
6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.
9. Click Open.
¢ If the template already exists, a prompt will appear asking if you want to overwrite it
¢ To overwrite it, select Yes

* If you select No, you will be prompted to save it under a new Template Code

You can assign templates to specific organizational nodes in the OBS, grant permissions, and control
user access for templates.
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Organization Register - Library

Drag columns here to group f |i| ﬂ |Q

L L |
g

!IIIIIIII“““““S

Cancel |

For example, you can assign a template to a specific node level in the OBS that is specific to Power
Delivery. The OBS node structure assignment is useful for assigning estimators access to designated
templates as determined by an Estimate administrator.
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Drag columns here to group

Name Desaription

| Organization: | SF2042 -Fower Delivery =y
i_‘ Code: * |Pm'lul:\elvu'y5£ | i

Description: Underground power utlity install 5E distict

I [1].4 I Cancel | 1
Bidding Microseft Pre...
Bidding Microsoft Proj... 1 T i UL L LR TR § ]

Estimators with the appropriate Estimate/template permissions in Suite Administration > Roles and
Permissions > Master Data Libraries > Estimate, can use the templates in which they are assigned to in
their designated OBS node.
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fat  Suite administration / Roles and permissions

Roles and permissions >  Edit role

Estimate
[ Edit estimate library

Use templates
(*) Add template
[=* Edit template

(x) Delete template
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Step by Step — Assign Template to OBS

1. Open the Training Job, then select the Templates.

©
InEi
ES

Version: 23.10
Environment: 23,10

New

Open

Save

Close All Jobs Open a recent Job )

Jobs

orey ﬁ

Templates S1- Training Job .
5100000 - Test_Bu I:::E:LL

cniuienxei xeuxb ...

Snapshots

Archive [ Restore

Create a new Job f;
(1 @
Scratch Tempj

Settings

2. Select Template Register.
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Close All Jobs

Jobs

Library

Templates

3. Select New.
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Templates

[==]

Template Register
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System Integrations

=y - =

. By Preview

i Create Template
& Export to Excel from Job

| Print Tools

! Template Register ©

Drag columns here to group

Code Organization:

S100000 - PKS Inc

= | 1109-T1 Code: * |

555

1 Description:
555-666

AlA

I AL Proj
| AL Template from Texas DOT
AL Template X
i Test Template - Today
rest template - Today 2
IL Template from DOT Job

Ilinois

4. Click the ellipsis to the right of the Organization field.

Cancel

Organization: 5100000 - PKS Inc

Code: *

Description:

The Organization Register Library opens.

0K

Cancel

Status

Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding

10.2 Templates

5. In the Organization Register Library, select SF2090-Renewables, and then click OK.
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Organization Register - Library

System Integrations

=’ Drop ke here o prup x [prewtomede |[~][~] Q]
CreaﬁmTeJ'xlam Name Description
om
st Tols S smmel PowrEoneemg | one Eonesrs .
| smBPoeGeN  PowrGen)
Organization: | $100000 -PKS Inc 4 =-_-.
code: * | L wmeese s
Descrpion: . smeosw oS
L EE
= L | S -CGMaketg 8o, KEGHatketng §Froposcls
L1 weeoe vt e ST i P over Shared s I Pover shared Servies
O L e i v
L] | rewercine | eats-Egncaing SharedSer. Shored Service
BN e .
] new temp |
storg [ rnewtemp Cancel |

The new template will be set at the SF2090-Renewables node in the OBS. Users assigned to the
SF2090-Renewables level or above in the OBS will be permitted to use this template when
creating estimates.

6. The next step will be to create a new template code and a description to complete the new
template creation process.

Template Register ©

Drag columns here to group

New Template

Code

[

Organization: | SF2090 - Renewables |
= 1109T1 Code: * || |
555
555-666 Description:

AAA

AL Proj not at root org

AL Template from Texas DOT
T — | oK | Cancel

At _ T v s T W T L QT K Te

What's next: After the template is created you can start to create estimates using a
template.
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10.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

Step by Step — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

Library - Estimate

B o DY E L % AE O

JobPropertes  Foundation  Address  Trench  ShiftRate  Resource ) Resource CostItem  Standard UserRoles  Access
- Setup Data ~ Book Calculator  Calculator Rates = 55 Materials  Assemblies Assemblies  Tables Control

Reports

Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

2. From the left side panel, select New, then select Bid Wizard.
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Library - Estimate

F o B @

Snapshot Primavera US Cost

Close All Jobs

Jobs

¢ The Bid Wizard — Step 1 dialog displays

% x
Step 1: What would you like to do?

(® Create a new job:

Description: |
(O Add to existing job: [Select Source Job]

Next > Cancel

TIP Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.
4. Type Bid Wizard Example in the Description field.
9. Click the Next button.

¢ The Bid Wizard — Step 2 dialog displays

6. Choose Select cost items and click Next.
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@l Bid Wizard X

Step 2 of 5: What should fill the new Job?

from a source Job folder (orimpart them from an electrenic file), and optionally,

O select pay items copy their corresponding costitems.

(@) Select cost items from asource Jobfolder.

< Back Cancel

¢ The Bid Wizard — Step 3 of 4 dialog displays

* You use this step to indicate which source you want to pull your setup data from (the

library or your source job)
7. For all selections, select Copy from source job.
8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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Step 3 of 4: What would you like to do?

Job Properties
Job Properties contains the Overview, Security,
(O Copy from MasterJob Properties Cover Sheet, Cost Basis, Minority Setup and Fuel
Cost for the job.

(® Copy from sourcejob

Foundation Setup Data
Foundation Setup Data contains the Account Codes,

() Copy from Master Foundation Setup Data Taas, Quote Group Tags, Units of Measure,
Currencies, Resource / Assembly Files, Geographic

@ Copy from sourcejob Areas, Wage Zones, Organization Categories and
Weather Tags.

Resources and Resource Assemblies

Resources and Resource Assemblies that are
utilized by Cost Items in the source job(s) are
copied by default. Optionally, all Resources and
Resource Assemblies can be copied from the source
job(s) into the new job.

Copy utilized Resources and Resource Assemblies
from source job

Also copy allnon-utilized resources

Unassigned Cost Items and Markup
Unassigned Cost Items are those costitems in the

() Copy from Master CBS CBSthat are not assigned to specific pay items,
including Prime Bond, Job Financing, General
(® Copy from sourcejob Expense, and others.

Copy Markup

Workbook : = :

The workbook contains data thatis used to link

. fields in Estimate to cells in Excel. The

(O Copy from Library workbook containing the data that you want to
Copy from sourcajob use for linking with Excel can be copied from

® copy b the Library or the source job.

< Back Cancel

10. Click Next.
e The Bid Wizard — Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.

Page 166 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide 10.3 Bid Wizard

Bid Wizard

Step 4 of 4: Choose the source Cost ltems to copy.

Source Job: - I
|
| Drag columns here to group Find: | [Search For...] Saved views: | Standard View -
CBS o - Optional Forecast
nciiis Position Code = | BEEAE Code (T/0) Quantity
1 3

Toggle Include All < Back Cancel

e The Job Register opens
12. Find and select Training Job.
13. Click OK.

¢ This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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@l Bid Wizard O X
Step 4 of 4: Choose the source Cost ltems to copy.
Source Joh:| Training Job -
i
| orag columns here to group Find: Saved views: | Standard View -
Indude EBS = Desc... gg;:ignal ?}5; N H‘;i;;fl ggistt Eatsatl Curre... égcd?eunt
C Quan... (Fore...
1= 1 Mabilization 6410100 1.00  Lump Sum £11,909.51  £11,909.51 U.S. Dollar 020 +
2 Clearing & ... 2010102 10,00  Acre $3,793.70  §37,936.97 U.S. Dollar 1110
- 3 Undassifie... 2020183 50,000.00 Cubic Yard $4.79  §239,582.64  U.S. Dollar 1122
3.1 Excavat... 3.1 38,227.74 Cubic Meter £3.90 $149,236.48 U.5. Dollar 11224
3.2 Embank... 3.2 42,432.79  Cubic Meter $2.13  $90,346.15 U.5.Dollar 11222
= 4 Aggregate... 303 5912 45,000.00 Ton $15.15 $A81,696.99 U.5. Dollar 1120
1 Furnmish ... = 4.1 45,000,00 Ton $11.,54 §519,513.30 U.S. Dollar 1120.1
4.2 Finegra... 4.2 400,000.00 Square Yard 40,18  §73,352.35 U.5. Dollar 1180
= 4.3 Install A... 4.3 45,000.00 Ton £1.97  £88,831.33 1.5 Dollar 1120
4.3.1 Place... 4.3.1 45,000.00 Ton §1.55 €69,716.92 .S, Dollar  1120.2
4 >

Toggle Include All < Back Finish Cancel

15. Select the checkboxes to include Mobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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Step 4 of 4: Choose the source Cost ltems to copy.

Source Job:| Training Job -

|
Drag columns here to group

Find: | [Search Far...] Saved views: | Standard View -

Faorec...

Total

Indude EBS Descr... gop;ljgnal (/) ﬂ;i; ; f ggistt Cost Curre... g;cdzunt
C... Quan... (Fare...
V' 1 Mobilization 5410100 1,00 Lump Sum $11,909.51  $11,909.51 U.S, Dollar w020 -
' 2 Clearing &... |2010102 10.00  Acre 4$3,793.70  §37,936.97 U.5. Dollar 1110
rdil-! ' 3 Undassifie... 2020183 50,000.00 Cubic Yard 84.79 £239,582.64 LS. Dollar 1122
V' S.1 Excavat... 3.1 38,227.74 Cubic Meter $3.90 §149,236.48 U.S. Dollar 11221
' 3.2 Embank... §3.2 42,432.79  Cubic Meter $2.13  $90,346.16 U.5. Dollar 1122.2
= 4 Agoregate... 303 5912 45,000.00 Ton $15.15 $581,695.99 U.5. Dollar 1120
Sl Furnish ... | 4.1 45,000,00 Ton $11.54 §519,513.30 U.S. Dollar 1120.1
4.2 Finegra... 4.2 400,000.00 Square Yard 80.18  573,352.36 .5, Dollar 1180
= 4.3 Install A... 4.3 45,000.00 Ton $1.97  £88,831.33 U.5. Dollar 1120
31 Place ... | 4.3.1 45,000,00 Ton $1.55 $69,716.92 U.S. Dollar 1120.2
] 3
Toggle Include All < Back Cancel

17. Click Finish to add the new job.

¢ An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift

Arrangements of the copied cost items?”

e Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.

You have ordered one ormore costitems to be copied by the Bid Wizard.

Do youwant to adjust Pay Rules and shift Arrangements of the copied cost items?

() Keep the original pay rules and shift arrangements

(@) Adjust the pay rules and shift arrangements to match the destination

[] Mever ask me this question again

InEight Inc. | Release 24.3
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19. Click OK.

¢ A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

AN ﬂ

The new job has been created. Use the
ribbon tabs to nawvigate to any of this
job's data forms.

Mever offer this help again

21. Open the Estimate > CBS to see the three cost items that were brought in.
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Cost Breakdown Structure (CBS) Register @

S here w group

Really

10.3 Bid Wizard

EBS. ) Description Optional FiEesd (aEgh
ogition Code Cade (T/O) Quantity Measure
- H JOB 1.00  Lump Sum
Prime Bond PRIME BOND 1,00 Lump Sum
Price % Add-On PRICE %: ADD-ON 1.00  Lump Sum
Job Financing FINAMNCE EXPEMSE 1,00 Lump Sum
Indirect Cost Escalation INDIRECT COST ESCAL... 1.00  Lump Sum
Direct Cost Escalation DIRECT COST ESCALAT... 1.00  Lump Sum
Indirect Cost Add-On INDIRECT COST ADD-OM 1.00  Lump Sum
+ Job Management & Equipment JOB MAMAGEMENT &E... 1,00 Lump Sum
+ General Expense GEMERAL EXPENSE 1.00  Lump Sum
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum
+ 1 Mobilization 6410100 1.00  Lump Sum
+ 2 Clearing & Grubbing 2010102 10,00 Acre
= 3 Unclassified Excavation 2020133 50,000.00  Cubic Yard
ar i Excavation 31 38,227.74  Cubic Meter
+ 3.2 Embankment 3.2 42,432.79 Cubic Meter

10.3.1 Bid Wizard Updates

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item &
Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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10.4 COPY ESTIMATE DATA USING EDIT COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

Step by Step — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).
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3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

File Setup Estimate Quote Price Execution

EH Account Code Utilization & ResourceRates -

Ba Work Breakdown Structures 'EE Resource Utilization

|
Cost Breakdown -
Structure (CBS) & Resource Cost Details
Breakdown Structures Resources

Cost Breakdown Structure (CBS) Register @

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using the minimize icons of each job or utilizing Windows align functionality.

Saved views: | Standard View -

I Hruirs Hruirs
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» Note that the window caption identifies the CBS Register for each job

a a rice  Bxeaon  System
o Workbook | Schedude  Cash Fow o Workbook | Schedude  Cax eport
Res... | Workbook Schedule Res... | Workbook Schedule Reports
ure (CBS) Register © - CostBreake ucture (CBS) Register ©
Drag Find: | [Search For... Saved Previous Vi o Find: | [Search For... Saved views: Standard i
Really Really
s Forecast Unitof Total Cost cas 3 Forecast Uritof Total Cost
PositonCode = | Desaripton oot (/0) Quantty Measure UnitCOst | Forecast) M| | PositonCode = | Descrpton oot (/0) Quantty Measure UitCost forecssy A
>= 2.0 vie $3,633,147... $72,662,954.. 4| > B 100 Lump Sum $SEABO7L.  $5,643,07L88
PRIVE BOND 100 Lump Sum $7,119.07 $47,119.07 PRIME 5OND sz ssenn
PRICE % ADD-ON 100 Lump Sum 29537161 $295,37161 PRICE % ADD-ON 23,0054 23,0059
FINANCE EXPEISE 100 Lump Sum .00 s0.00 FINANCE EYPENSE .00 .00
Indirect Cost Escalation INDIRECT COST ESCAL. 100 Lump Sum .00 s0.00 Indirect Cost Escalation INDIRECT COST ESCAL .00 .00
Direct Cost Escalation DIRECT COST ESCALAT. 100 Lump Sum §19,5177 $19,13L77 Direct Cost Escalation DIRECT COST ESCALAT. .00 .00
INDIRECT COST ADD-ON 100 Lump Sum 5947659 $59,476.54 Indirect Cost Add-On INDIRECT COST ADD-ON S2016 $3,280.16
+ 108 MANAGEMENT &E. 100 Lump Sum S125896.28 $12589%.28 + Equipment aE S125896.28 $12589%.28
+ General Expense GENERAL EXPENSE 100 Lump Sum 5420000 $4,200.00 + General Expense GENERAL EXPENSE 42000 $4,200.00
Direct Cost Add-0n DIRECT COST ADD-ON 100 Lump Sum S10420316 $104,203.16 Direct Cost Add-0n DIRECT COST ADD-ON ss7mes ss7ms
+1 Mobilization 6410100 200 Lump Sum sieest 2381002 +1 Mobilization 410100 s1L90951  si1.900.51
+2 Clearing & Grubbing 010102 000 Ade S $379%.97 +2 Clearing & Grubbing 010102 S $379%.97
=3 Undlassified Excavation 020183 50,000.00 | Cubic Yerd sa84 w011 =3 Undlassified Excavation 020183 50,000.00 | Cubic Yerd sa7 som,58264
+ a1 Excavation 31 3,227.74 | Cubic Meter 10 $156,55496 + a1 Excavation 31 3,227.74 | Cubic Meter 90 s199,2%.%8
+ 32 Enbankment 32 42,432.79 Cubic Meter 213 0366 + 32 Enbankment 32 42,432.79 Cubic Meter 213 3%
54 Aggregate Base 035912 45,000.00 Ton $15.15 $681,6%6.99

5. On the CBS of the Training Job, click the row header on cost item 4 — Aggregate Base and press
Ctrl+C to copy the cost item.

4 Aggregate Base

SR Furnish & Haul Base Material
4.2 Finegrade Subgrade 4.2
4.3 Install Aggregate Base 4.3
4,3.1 Place Aggregate Base 4,3.1
4,3.2 Blue Top Agaregate Base 4,3.2

+ + W + +im

TIP When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

+ 1 Mobilization 5410100 1.00  Lump Sum
+ 2 Clearing & Grubbing 2010102 10,00  Acre

=2 3 Unclassified Excavation 202 0183 50,000.00  Cubic Yard
+ 31 Excavation 3.1 38,227.74  Cubic Meter
+ Embankment 3.2 42,432.79  Cubic Meter
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7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.

Attention

You have ordered one or more cost items to be copied and inserted as subordinates to
to the Cost Item at CBS Position Code <]0B:>.

Do youwant to adjust Pay Rules and Shift Arrangements of the copied cost items?

() Keep the original pay rules and shift arrangements

{®) Adjust the pay rules and shift arrangements to match the destination

[] Mever ask me this question again

& | (=]

e You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

Schedde Cash Fon . Reports Schedie Cash Flow Reperts
8 2y lemates 8
Schedule Alternates Reports de Report
Find: | [Search For...] Standard Vi
Really Forccast it Total Cost. Really Forccast it Total Cost.
Cpuy (7/0) Quantty (Forecast A Cpuy (7/0) Quantty UnitCost | (Forecast) 4
Coce Coce
$3,633,147...  $72,662,954... * = 1.00  Lump Sum $14,870,33...  $14,870,330.
PRIME BOND $47,119.07 $47,119.07 PRIME BOND $12,328.94 $12,328.94
PRICE % ADD-ON $295,371.61  $295,371.61 PRICE % ADD-ON $60,524.65 $60,524.65
FINANCE EXPENSE $0.00 $0.00 FINANCE EXPENSE $0.00 $0.00
Indir INDIRECT COST ESCAL. $0.00 $0.00 In Escalation INDIRECT COST ESCAL. $0.00 $0.00
Direct Cost Escalation DIRECT COST ESCALAT. $19,131.77 $19,131.77 Direct Cost Escalation DIRECT COST ESCALAT. $0.00 $0.00
Indirect Cost Add-On INDIRECT COST ADD-ON $59,476.54 $59,476.54 Indirect Cost Add-On INDIRECT COST ADD-ON $11,005.99 $11,005.99
+ Equif it E. $125,896.28  $125,896.28 + Equif t E. $125,896.28  $125,89.28
+ General Expense GENERAL EXPENSE #2000 $4,2000 B General Expense GENERAL EXENSE 2000 $4,2000
Direct Cost Add-On DIRECT COST ADD-ON $104,203.16  $104,203.16 Direct Cost Add-On DIRECT COST ADD-ON $19,422.52 $19,422.52
v Mobilzation 6410100 susmst  smemo v Mobilzation 6410100 susmst  sisosst
+2 Clearing & Grubbing 21012 s sweest v 2 Clearing & Grubbing 21012 s sweest
=3 Undlassified Excavation 2020183 $494  $246,901.12 =3 Undlassified Excavation 2020183 $479  $239,582.64
+ a1 31 san 1565549 + a1 31 s sw26e
+ 52 sz 21 s + 52 sz 215 w036
= 54 3035912 $15.15  $681,696.99 - 3035912 $15.15  $681,696.99
+ a1 ] 41 sise 59,5130 + a1 ] 41 sise 59,5130
+ a2 a2 00,0000 Square Yerd 08 s + a2 a2 00,0000 Square Yerd w8 s
= 43 43 45,000.00  Ton $1.97 $88,831.33 = 43 43 45,000.00  Ton $1.97 $88,831.33
+ et 431 500000 Ton s1ss s 7692 + et 431 500000 Ton S5 s769
+ a2 232 00,0000 Square Yerd 005 si1a92 + a2 432 00,0000 Square Yerd 005 si1a92
=5 Asphalt Concrete Hot Mix Type A 303 4263 35,000.00  Ton $42.62  $1,491,580.59 *

TIP You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

TIP Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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Reports

Reports

10.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

Step by Step — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.
2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS
4

. Highlight the New row.
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3512 45,000.00 | Ton
a1 45,000.00 Ton
a2 400,000.00 Square Yard
a3 45,000.00 Ton
431 45,000.00 Ton
432 400,000.00  Square Yard
| 1.00 | Each

5. To open the CBS Bid Wizard, click the Bid Wizard icon on the More Actions tab.

2 -
File Setup Estimate Quote Price Execution System Integrations Actions More Actions
schedule Selecti 4 » Swap ~ % Bid Wizard Unit / Total Confirmati = |
&= Schedule Selection wap T Bid Wizar Z nit / Total Confirmation » v @
Unschedule Selection Q Remove - Subtotal Calculator C:} Refresh Benchmarks
o ) ] Add Level One  Add Subordinate Import /
=g Caloulate Plug Days C Update - Quantity Checking @ Add Quote Cost Items = Cost Items = Update CBS -
Schedule Batch Operations Tools Data Source

¢ The Bid Wizard window opens

o

Click in the Source Job column on the New cost item row.

Place Agaregate Base 45,000.00 Ton [5elect Source Job]
Blue Top Aggregate Base 400,000.00 Sguare Yard [5elect Source Job]

I N

: [Select Source 1.,

From the Source Job drop-down list, select Training Job.

Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

e A source CBS Register window appears

9. Select CBS position code 5 — Asphalt Concrete Hot Mix Type A from the register.
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Drag columns here to group Find: | [Search For...] = | Saved views: | Previous View -
CBS_ _ - Description gizlulzuynal Unit of Forecast _
Position Code Code Measure (T/O) Quantity
4.2 Finegrade Subgrade 4,2 Square Yard A
=2 4.3 Install Aggregate Base 4.3 Ton
4.3.1 Flace Agaregate Base 4.3.1 Ton
4.3.2 Blue Top Aggregate Base 4.3.2 Square Yard :
5.1 Furnish & Haul Hot Mix 5.1 Ton
5.2 Install Hot Mix Type A 5.2 Ton
= 6 36 Inch RCP Culvert Class III 413(B) 04964 Linear Feet
6.1 Furnish RCP Materials 6.1 Linear Feet
6.2 Excavate RCP Trench 6.2 Cubic ¥ard
6.3 Install RCF Fipe 6.3 Linear Feet
6.4 Backfil RCP Pipe 6.4 Cubic Yard v
-1 -
Cancel
10. Click OK.

11. Click Finish on the Bid Wizard.
¢ An Attention prompt displays, asking if you want to make adjustments

¢ Keep the default options selected: Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

2] Attention

s, or just their details, o be copied by the Bid

¢ You can see that cost item 5 and its subordinates are now imported into your existing job.

e You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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=2 43 Install Aggregate Base
+ 431 Place Aggregate Base
+ 4.3.2 Blue Top Aggregate Base
F _ Asphalt Concrete Hot Mix Type Al
+ 51 Furnish & Haul Hot Mix
+ 5.2 Install Hot Mix Type A

10.6 SNAPSHOTS

10.6 Snapshots

4.3 45,000.00  Ton
4.3.1 45,000,000 Ton
4,3.2 400,000.00 Square Yard
5.1 1.00 Ton
5.2 1.00 Ton

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

10.6.1 Snapshot Register

The Snapshot Register is where you will view individual snapshots for specific jobs.

Step by Step — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.
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Estimate Intermediate User Guide

S

Snapshots
Hew
[ == |
Open m ﬂ
Save
Close Job Create Snapshot Snapshot Register

Close All Jobs

Jobs

Library

Templates

Snapshots

Archive | Restore

Setlings

Exit

3. To view individual snapshots for specific jobs, click the
the list of snapshots.

icon next to the desired job to display

Code = Description

= D E101 - Training Job KL Sample Training Job

Training Job Training Job - Maricopa County Mo, TM2924
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10.6.2 Creating a New Job Snapshot

Step by Step — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.
| File Setup Estimate Execution System
IE!! Print Load & Create Job Snapshot f’ ' ' C Refresh
'%. Preview Edit .':: Delete All Job Snapshots ” » n Create New Job from Snapshot
Expand / Filter to Jobs Clear
Delete Collapse =  with Snapshots  Filter
Print Edit View Tools
Snapshot Register @
Drag columns here to group
Code = Description fast Version In Use Status
Saved
E101 - Training Job KL Sample Training Job 11122019 2:23:1... | 19.2.0.27
Training Job Training Job - Maricopa County Mo. TM2924  11/13/2019 7:40:1...  19.2.0.27 Bidding

2.

If an existing job is open select Save, if you haven’t already done so
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l':'f:{l Attention

T

LInsaved data will not be stored in the snapshot. Save the job
beforetaking a snapshot?

E101 - Training Job KL

] 4 Cancel Unselect &ll

3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

e If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

¢ If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

» If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

¢ If you want to Specify User Access restrictions for this Snapshot (default selection), select

this option

¢ Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

New Job Snapshot [E101 - Training Job KL]

Job: |E101 - Training ] Job Description: |Sample Training Jaob

Snapshot || <add comment here|
Comment:

ﬁ' Include all Attachments that have been stored in the Job Folder with this Snapshot

User Access
() UseJob's current User Access restrictions forthis Snapshot
() Remove all User Access restrictions for this Snapshot

(®) Specify User Accessrestrictions forthis Snapshot

user - karen.loftus @ineight.com Add...
user - paul, trippi @ineight. com

Remove

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.

Success!

Successfully created Job Snapshot for Job: "E101 - Training Job KL

[ ] Mewver offer this help again

OK
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10.6.3 Editing a Job Snapshot

Step by Step — Edit a Job Snapshot

1. From the Snapshot Register, click the = icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

= — E101 - Training Job KL Sample Training Job

Snapshot Comment
ﬂ.' é ':: L1 1
E LDEIj
Trainin T
_Ean

fﬁ’ Delete
Exy

Create Mew Job from Snapshot

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

e |f you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

e If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

¢ If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

* If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

¢ Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.

Page 184 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide 10.6 Snapshots

10.6.4 Deleting a Job Snapshot

Step by Step — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select
Delete.

Code =4 Description

= — E101 - Training Job KL sample Training Job

Snapshot Comment E
= <add d romment here
HYTTTTI I T I Ll:lad
Comm =
Edit
Training Job
Delete

P Create New Job from Snapshot

3. Click OK

Delete Job Snapshot

Are you sureyou want to delete this Job Snapshot?

<add updated comment... [E101 - Training Job KL_201911

Unselect All

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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Execution System
=h Print Load gl Create Job Snapshot /f
%_ Preview Edit ::: Delete All Job Snapshots
Expand [ Filter t4
Delete Collapse = with Sna
Print Edit Vie

Snapshot Register ©

10.6.5 Loading a Job Snapshot

When you load an existing Snapshot, it loads into Estimate as any other job.

Step by Step — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the = icon next to the desired job to display the list of snapshots.
4

Right-click on the individual snapshot you want to load and select Load.

Code = Description fast Version InUse
Saved
= — E101-Training Job KL Sample Training Job 11f13/2019 8:25:3... 19.2.0.27 W
Snapshot Comment =  Date Created Version
<add updated comment here> 11/13/2019 3:31:54 FM 19.2.0.27
e Comment 2 11;13!2[) 19 3: -m
: Load 3
Training Job Training Job - Maricopa County No, TM292 7
Edi 1
f& Delete
P Create New Job from Snapshot
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To identify a snapshot in Estimate as a read-only snapshot:

10.6 Snapshots

¢ The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

e Ared banner shows the specific snapshot information at the bottom of the screen

MeJ = A snapshot can be modified, but it cannot be saved as it is read-only.

SHAPSHOT: Training Job - Estimate

InEight Inc. | Release 24.3

Actons
B print @ rew  EHcoy Spiit Indent Link Field Cost Item
A Preview Delete Paste Spit by Cost Type Outdent Uniink Field | = Subordinate Cost Item | &%
@ Export to Excel cut Fil Down T Togdle Suspended £ Dependent Cost Item
print Edit Workbook
Cost Breakdown Structure (CBS) Register ©
CBS Tree (Filter Mode) X || Drag columns here to group
Forecast
Code Description s -
Fosttion Code = Desaription (/o)
v 108 Quantity
g8 Prime Bond - = 108 20,00
g8 Price % Add-On + Prime Bond 1.00
[E]  1bFinancing + Price % Add-on 100
oo
o Indirect Cost Escalation + Job Financing 100
88 Direct Cost Escalation 4 e am
oo
& Indirect Cost Add-On N i o0
= Job Management & Equipment
+ Indirect Cost Add-On 100
[=] General Expense . N
Job Management & Equipment 100
oo Direct Cost Add-On = =
¥
IR vosizaton General Expense 100
[E/2 | clearing & Grubbing - Direct Cost Add-on Lo
> @@ 3 Undassified Excavation 1 Mobilization 00
> a4 AcgregsteBase + 2 Clearing & Grubbing 10.00
> @5 Asphalt Concrete Hot Mix Ty, =3 Undlassified Excavation 50,000.00
> @u/8 | 36 InchRCP Culvert Class I + 31 E=ar 50,000.00
> @@ 7 10InchPVCForce Man (SD e e 50,000.00
> @@ B | 24Inch PVC Gravity Sewer oa 45,000.00
> @&/8 | 4FootDiameter Manhole
+ 41 Furnish & Haul Base Materia 45,000.00
> @@ 10 | Stuctural Excavation & Backfil . 5 .
42 Fegrade Subgrade 400,000.00
> @11 SteelReinforcement — =
> @@ 12 | Retaining Wal - 106
R e
As-Entered Currency  As-Entered Units  Minimum Example  EIVE SIOMRRI: Job (snapshot

Assembly

Subordinate As

Insert

Unitof
Measure
vile

Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Age
Cubic Yard
Cubic Yard
Cubic Yard
Ton

Ton

Square Yard

sssembly

Unit Cost

$292,094.58
$46,950.91
$293,858.20
$0.00

0.00

$0.00

$0.00
$157,006.28
$4,200.00
$104,301.10
$11,909.51
$3,918.50
468

$3.00

$1.68
s15.40
$11.54
$0.19

Resource e
n

Resource Assembly

Expand /
Collapse ~

Total Cost

Forecast) | Alocted

$5,841,891.55 [
s46,950.81
$293,858.20
$0.00
s0.00
$0.00
$0.00
$157,006.28
$4,200.00
$104,301.10
$11,909.51
$39,184.97
s233,915.81
$149,922.88
$83,992.94
$692,928.09
$519,513.30
$75,848.36

$5,841,891...

W W st

Fiter  Clear
- Fiter

View

Allocation
Source

us,

Currency

Dolar

Dolr

. Dolar

Dolar

Dollar

. Dolar

Dolar
Dollar
Dolar

Dolar

. Dolar

Dolar

Dolar

. Dolar

Dolar

Dolr

. Dolar

Dolar

/" Expand cBS Tree

Cost
Adjustment

Accrued Costs OFF

Optional
Code

PRIME
PRICE
Fman
noR
bIREC
noR
108M

DIREC
5410:
010
020:
34
32
EEES

42

»
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Exercise 10.1 — Data Reproduction

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

—_—

10.

11.

12.

13.

. Open the Bid Wizard by clicking the Bid Wizard icon from the More Actions tab.

Choose the Create a new job radio button.

Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

Choose Select cost items.

For all selections, choose Copy from source job.

Select the Also copy all non-utilized resources checkbox.

Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

Find and select Training Job and click OK.

Use the Toggle Include All button to exclude all selections.

Select the checkboxes to include Cost Items 4-7.

Click Finish to add the new job.

Select Adjust the pay rules and shift arrangements to match the destination.

Open the CBS to see the cost items that were brought in.
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Exercise 10.1 — Data Reproduction

14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results

CBS
Position Code

Li
1.2
13
L3l
1.3.2

21
22

31
J2
&3
34

4.1
4.2

Sl
Sll
& 1.2
5.2
53

6.1
6.2

+ +0 + + + + @30+ + @0+ + + + 0+ +'0+ + @0+ +0

Description

Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On
Job Management & Equipment
General Expense
Direct Cost Add-On
Aggregate Base
Furnish & Haul Base Material
Finegrade Subagrade
Inztall Aggregate Basze
Flace Aggregate Base
Blue Top Aggregate Base
Asphalt Concrete Hot Mix Type A
Furnish & Haul Hot Mix
Install Hot Mix Type A
36 Inch RCP Culvert Class IT1
Furnish RCP Materials
Excavate RCP Trench
Install RCP Pipe
Backfill RCP Pipe
10 Inch PVC Force Main (SDR21)
Furnish 10 Inch PVC Materials
Excavate-Install-Backfill 10 Inch PVC

24 Inch PVC Gravity Sewer (SDR35)

Excavate 24 Inch PVC
Excavate 24 Inch PVC 0-& ft Depth
Excavate 24 Inch PVC 6-10 ft Depth
Furnish & Install 24 Inch PVC
Badkfill 24 Inch PVC
4 Foot Diameter Manhole
Furnish 4 ft Manhole Materials
Excavate-Install-Backfill Manhole

Optional
Code

INDIRECT COST ESCAL...
DIRECT COST ESCALAT...

INDIRECT COST ADD-ON
JOB MANAGEMENT &E...
GENERAL EXPENSE
DIRECT COST ADD-ON
303 5912

4.1

4.2

4.3

4.3.1

4.3.2

303 4263

5.1

5.2

413(B) 0464

6.1

6.2

6.3

6.4

800 0220

7.1

7.2

800 0330

8.1

811

.12

8.2

8.3

800 0400

9.1

9.2

Forecast

(T/0) Quantity

1.00
1.00

1.00

1.00

1,00

1.00
45,000.00
45,000.00
400,000.00
45,000.00
45,000.00
400,000.00
35,000.00
35,000.00
35,000.00
1,024,00
1,024.00
1,858.56
1,024,00
1,587.20
12,000.00
12,000.00
12,000.00
3,000.00
3,000.00
1,390.00
3,610.00
3,000.00
4,520.00
16.00
16,00
16,00

Congratulations, you have completed this exercise!

Unit of
Measure

Lurmp Surm
Lurnp Sum
Lurnp Sum
Lurnp Surm
Lump Sum
Lurnp Sum
Ton

Ton
Square Yard
Ton

Ton
Square Yard
Ton

Ton

Ton

Linear Feet
Linear Feet
Cubic Yard
Linear Feet
Cubic Yard
Linear Feet
Linear Feet
Linear Feet
Linear Feet
Linear Feet
Cubic Yard
Cubic Yard
Linear Feet
Cubic Yard
Each

Each

Each
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Lesson 10 Review

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

Scratch
Template
Import
Existing Job

Historic

-~ & o o T o

Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost
items you want to import into your new job?

a. Template

b. Bid Wizard
C. Existing Job
d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard
b. CBS Bid Wizard
C. Template

d. Existing Job

Lesson 10 Summary

As a result of this lesson, you can:

¢ Create a job from an existing job or template

e Create a template
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Reproduce estimate data using the Bid Wizard

Reproduce estimate data using copy/paste

Add cost items to a job using the CBS Bid Wizard

Utilize the Snapshot function
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LESSON 11 — EXCEL INTEGRATION

Lesson Duration: 20 Minutes

Lesson Objectives
After completing this lesson, you will be able to:
e Export data from InEight Estimate to Excel
e Link a field in InEight Estimate to Excel
e Update a linked InEight Estimate field with Excel data

Lesson Topics

11.1 EXPORT TO EXCEL

InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.

InEight Estimate includes a worksheet export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data
from an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other
uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.
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11.1 Export to Excel

Step by Step — Export Data to an Excel Workbook

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

o
File Setup Estimate Quote Price Execution System Integrations

= Print @ vew G copy split Outdent | M Link Field CostIi

'%. Preview Delete E Paste ﬁ Togale Suspended &4, Unlink Field E Suborg

ﬁ’ Export to Excel Cut Fill Dawn Indent H Depen
Print Edit Workbook

Cost Breakdown Structure (CBS) Register ©

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

¢ The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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¢ Notice that the columns are formatted, with column headers and filtering turned on

AutoSave (® off) CBS Export - Bxcel Karen Loftus

File Home Formulas Data i View Help Acrobat £ search | 13 Share | ‘ 7 Comments

En = 22 Text -| | Ef Conditional Farmatting - ’ o
PastDe - . R El- | §-% 9 | romatasTabler Cells | Editing | Ideas | ShareThis Webex
- ‘ e A~ |0/. <0 00 [ Cell Styles - - - File -

Clipboard 1 Font o Aignment ml Number & Styles Ideas Webex ~

\ | | | | | |

il CBS Position Code | ~ | Description ~ | Forecast (If[)] 1~ | Unit of Measure | ~ |Unit Cost |~ Total Cost [Fmecast] ~ |Currency =
JoB 20.00 Mile $292,316.18 $5,846,323.66 U.S. Dollar
Prime Bond 1.00 Lump Sum $46,974.12 $46,974.12 U.S. Dollar
Price % Add-On 1.00 Lump Sum $294,067.09 $294,067.09 U.S. Dollar
Job Financing 1.00 Lump Sum $0.00 $0.00 U.S. Dollar
Indirect Cost Escalation 1.00 Lump Sum $0.00 $0.00 U.S. Dollar
Direct Cost Escalation 1.00 Lump Sum $0.00 $0.00 U.S. Dollar
Indirect Cost Add-On 1.00 Lump Sum $0.00 $0.00 U.S. Dollar
Job Management & Equipment 1.00 Lump Sum $157,096.28 $157,096.28 U.S. Dollar
General Expense 1.00 Lump Sum $4,200.00 $4,200.00 U.S. Dollar
Direct Cost Add-On 1.00 Lump Sum $104,301.10 $104,301.10 U.S. Dollar
Maobilization 1.00 Lump Sum $11,909.51 $11,909.51 U.S. Dollar
Clearing & Grubbing 10.00 Acre $3,918.50 $39,184.97 U.S. Dollar
Unclassified Excavation 50,000.00 Cubic Yard $4.68 $233,915.81 U.S. Dallar
Aggregate Base 45,000.00 Ton $15.40 $692,928.99 U.S. Dallar
Asphalt Concrete Hot Mix Type A 35,000.00 Ton $42.62 $1,491,580.59 U.S. Dollar
Furnish & Haul Hot Mix 35,000.00 Ton $39.27 $1,374,562.54 U.S. Dollar
Install Hot Mix Type A 35,000.00 Ton $3.34 $117,018.05 U.S. Dallar
36 Inch RCP Culvert Class 11l 1,024.00 Linear Feet $67.54 $69,159.49 U.S. Dollar
Furnish RCP Materials 1,024.00 Linear Feet $33.48 $34,286.70 U.S. Dollar
Excavate RCP Trench 1,858.56 Cubic Yard $4.51 $8,379.59 U.S. Dollar
Install RCP Pige 4

Formatted Data [GERHNES ®

I

N
=

1«

4
Y
7

B

EIHEEHE

11.1.1 Cell Select

To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel
Spreadsheet.

Step by Step — Cell Select

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.
2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon).
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¢ This puts you in “cell-select” mode, so you can select cells to copy in the same way you
would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.

Resource Rate Register @

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies Unique

Drag columns here to group

S oesrpton v zzmﬁm az‘;::re
+ LEC1 Carpenter Apprentice
LC2 Carpenter Journeyman 3
LC3
LF1
LF2

LF3

m -

LL2 3
LL3

LMECH

LO1

LO3 Operator Class 3 889,33
LREM 01 i

LREM 05
LSPE ginee B00.00
LSSEC
LSSUPT
LT1
LT2
LWD
= LWDA i m Hour

o+ F o+ o+ o+ F o+ o+ o+ +

6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.
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a
10
1
12

8. Click OK.

A
1 Carpenter Apprentice
2 |Carpenter Journeyman
3 |Carpenter Foreman
4 |Finisher Apprentice
5 |Finisher
6 | Finisher Foreman
7 | Iron Worker
8 |Iron Worker Foreman
Labor Apprentice
Laborer
Labor Foreman
Mechanic
Operator Class 1
Operator Class 2
Operator Class 3
Operator Foreman
Principal Eng/scientist
Field Technican
Project Engineer
Secretary
Project Superintendent
Teamster
Teamster Foreman
Welder
Welder Apprentice

Sheet1

Estimate Intermediate User Guide

¢ The fields you copied from InEight Estimate paste into the spreadsheet

B C
594.3650794 Hour
1188.730153 Hour
594.3650794 Hour

0 Hour
594.3650794 Hour
0 Hour
594.3650734 Hour
0 Hour

0 Hour
8963.733879 Hour
721.3333333 Hour
418.4398946 Hour
1800 Hour
4019.732279 Hour
889.3333333 Hour
1421.768 Hour

0 Hour

0 Hour

800 Hour

800 Hour

800 Hour
3056.768 Hour

0 Hour

0 Hour

0 Hour

11.1 Export to Excel

e To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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11.2 LINKING TO EXCEL

11.2.1 InEight Estimate Workbook

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new

embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the

Workbook section.

2

File Setup Quote Execution System Actions More Actions
ﬂ !-H Account Code Utilization an Resource Rates ~ — | f [:| |:]
'.2 Work Breakdown Structures E‘;‘_ Resource Utilization D D
Cost Breakdown - ) Workbook Schedule Cash Flow Indirect
Structure (CBS) & Resource Cost Detail - v Cost Iter
Breakdown Structures Resources Workbook Schedule

Cost Breakdown Structure (CBS) Register ©
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e The embedded Excel workbook for the job opens.

o U (emmbimEmm  © o

InEight
ESTIMATE

Take Off & Analysis
Worksheets

el and Estimate, you can update all linked fields by
n Estimate.

Instructions:

Table of Contents

Instructions | Table of Contents | AHaul Cost | B_Hauler Calculator | C_HaulTake Off | D_Production Rate Calculator | E+

11.2.2 Linking to and from Excel

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.

=6 36 Inch RCP Culvert Class IIT 213(E) 0464 | 1,024.00 | Linear Feet
+ 6.1 Furnish RCP Materials 6.1 1,024.00 Linear Feet
+ 6.2 Excavate RCP Trench 6.2 1,858.56 Cubic Yard

The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.
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Step by Step — Link Estimate to Excel

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

Concrete Foundation 1.00 CY

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following

fields:
A B C . D | E | F | G
1 |Concrete Take-off
2
3 |Length 10 yards
4 'Width 10 yards
5 |Height 0.5 yards
E | |
T —
B —
g —
10
11
12
r Instructions Table of Contents Concrete Take-Off |_

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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A B C
1 |Concrete Take-off
2 W ———————
3 |Length | 10lyards
4 Width 1 101yards
5 Height | 0.5lyards
6 |Volume |=sum(B3°B4°B5)
7

¢ Your Volume Total should be 50 cubic yards

A B C
1 |Concrete Take-off
2
3 |Length 10 yards
4 |Width 10 yards
5 |Height 0.5 vards
6 |Volume 50 CY |

F

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

Volume 5 9
A C

1 |Concrete Take-off

2

3 |Length 10 vards
4 |Width 10 vards
5 |Height 0.5 vards

6 |Volume | 50]cY

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

¢ You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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Suspended

the Water

Integrations

B, Link Field

&4, Unlink Field

= Indent

Outdent

Workbook

Optional
Code

00420

03210

09640

12510

15300

16510

1500 0100
1500 0200
1000 0230
co1
UMASSIGMED DIRECT C...
UMASSIGNED
LUMASSIGMED
LUMASSIGMED
UMASSIGMNED

Estimate Intermediate User Guide

Training Job - Estimate

Actions

== Cost Item

More Actions

"= Subordinate Cost Ttem

H Dependent Cost Ttem

Forecast

(T/C) Quantity
.00
.00
1.00

Unit of

=+ Assembly

f= Subordinate Assembly

Insert

Unit Cost

Measure

Lurnp Sum
Lurnp Sum

Lurnp Sum

£2,100.00
£1,000.00
£1,800,00

pAIY
o Resource

%% Resource Asseml

Finc
Total Cost
(Forecast)
$2,100.00
£1,000.00
£1.800.00

1.00
1,00
1,00

1,000.00

200,00

1,000.00

1,00

= O
I z |_8
E =

Fill Down

1.01
1.0

1.00
1.00
1.00
1.00
1.00

1.00
1.00

ey o0

Link this field to Excel

loip ¢ ¥ o=

=0

s il il

UnLink from Excel

Indent

Cutdent

Inzert

Insert Subordinate

Insert Dependent Caost [tem

Insert Cost ltem Assembly

Insert Cost ltem Assembly as Subordinate

Split

9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh ic button for the

field name to display).
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X Link to Excel - m] x
When linking to Excel you can choose to have the data in

Excel update an Estimate field or have the data in
Estimate update a named cell in Excel.

(® Update Estimate Field from Excel F’P

(O Update Excel Cell from Estimate g

Field to Link: Forecast (T/0) Quantity

O_Item1VolCY_StructuralConcTakeOff A
O_Item2AreaSF_StructuralConcTakeOff
O_Item2VolCY_StructuralConcTakeOff
O_Item3AreaSF_StructuralConcTakeOff
O_Item3VolCY_StructuralConcTakeOff
O_Item4AreaSF_StructuralConcTakeOff
O_Item4VolCY_StructuralConcTakeOff
O_ItemSAreaSF_StructuralConcTakeOff
O_ItemSVolCY_StructuralConcTakeOff
O_TotAreaSF_StructuralConcTakeOff

¥_StructuralConcTakeOff
[ .

|:| Prorate to Superior Item Quantity

[] Group Cell Names by Worksheet

C D?uﬁor-‘lRefrah Pick from Excel
el ames
Goncel
11. Click OK.

11.2 Linking to Excel

e The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

CBS

Position Code = Descplicy

26 Concrete Foundation

Forecast

(T/0) Quantity

50.00

Unit of
Measure

CY

11.2.3 Update Links

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs. Simply select one of the following options from the Workbook drop-

down list on the Estimate tab.
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Estimate

Quote

Price

Execution System

Actions More Actions

Estimate Intermediate User Guide

‘_—_ Account Code Utilization

'ﬁ Work Breakdown Structures

akdown Structures

wn Structure (CBS) Register ©

re to group
de = Description
JoB
Prime Bond

Price % Add-On
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-
4 Resource Rates - m — | f E E =
Ez Resource Utilization %
— Workbook Schedule Cash Flow Indirect
&~ Resource Cost Details h' - Cost Items E
AT E4  Open Job Workbook P
f_f Update Current Job From Workbook !
ﬂj Update All Open Jobs From Workbook
Optio g:“ Update Workbook From Current Job ol
Code| Bsu
65‘ Update Workbooks From All Open Jobs
PRIME €9 Delete Broken Links in All Open Jobs D!
PRICE e RDD=ON T00Tomp !
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Lesson 11 Review

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. In order to link an Excel field to InEight Estimate, the Excel field must be:
a. Named
b. Highlighted
C. Tagged
d. Selected

Lesson 11 Summary

As a result of this lesson, you can:
e Export data from InEight Estimate to Excel
e Link a field in InEight Estimate to Excel
e Update a linked InEight Estimate field with Excel data
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LESSON 12 — SCHEDULE INTEGRATION

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:
¢ Set up scheduling options
e Update schedule from InEight Estimate
e Update InEight Estimate from schedule

e Manage changes between estimate and schedule

Lesson Topics
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12.1 MICROSOFT PROJECT

12.1.1 Set Up Scheduling Options

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the

proper settings are in place.

12.1.1.1 Job Properties Schedule Tab

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

e At the top of the Schedule tab, the Integrated Schedule must be set to Microsoft Project

e As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

Job Properties @

Qverview Security Cover Sheet | CostBasis | Minority Setup | Fuel Cost | Job Tracking Job Folder Tags | Competitors Pricng | Schedule I Cash Flow Eguipment

Integrated Schedule: Microsoft Project - [ Always use Plug Days when updating Estimate from the schedule

Schedule Currency: .5, Dollar
Cost Item Roll Up

[ Automatically calculate Plug Days when rolling up costitems for scheduling purposes
@ Longestscheduled days amang all rolled up costitems

Total scheduled days for all rolled up costitems

Note: When rolling up cost items for scheduling purposes, the Plug Days of the superior costitem
will be recalculated when a change is made to the scheduled days of a subordinate.

To forceimmediate recalculation of Plug Days for superior costitems, use the Recalculate Plug Days'
button or the 'Calculate Plug Days... command on the *Tools’ menu in the CBS Register.

Recalculate Plug Days

12.1.2 Schedule Cost Items

Before you can integrate with Microsoft Project, your cost items need to be marked as Scheduled in
InEight Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views
drop-down list in the CBS, the Schedule Setup View displays all of your schedule-related columns.
There are a couple to keep in mind when you schedule your items:
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e Scheduled: This column tells you which of your items are selected to be included in your
Primavera schedule

¢ Roll Up Schedule: This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

Esgﬁm Code = Description Scheduled E;EELCII?JIE
+ 1 HMobilization J

+ 2 Clearing & Grubbing +

2 3 Unclassified Excavation J v
+ 3.1 Excavation u

+ 3.2 Embankment u

= 4 Aggregate Base o

ST Furnish & Haul Base Material o

+ 4.2 Finegrade Subgrade o

= 43 Install Aggregate Base o

The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

Saved views: | Schedule Setup View -

¢ In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

¢ If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then

press Tab.

EDE:ﬁDI'I Code = Description SirEirE :;EELQI?JIE
a JoB J

Prime Bond

Price %o Add-On

Job Financing

Indirect Cost Escalation

Direct Cost Escalation

Indirect Cost Add-On

Job Management & Equipment
+ General Expense

Direct Cost Add-On
+ 1 Mobilization o
+ 2 Clearing & Grubbing v
=2 3 Unclassified Excavation v‘
+ 31 Excavation ¥
+ 3.2 Embankment '
= 4 Aggregate Base
+ 4.1 Furnish & Haul Base Material
+ 4.2 Finegrade Subgrade

Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.
2. From the Saved Views drop-down list, select Schedule Setup View.

e To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

TIP To schedule all cost items, highlight the JOB row
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4. Right click on the selected rows and select Schedule Selection.

Cost Breakdown Structure (CBS) Register @
Drag columns here to group

CBS

Position Code = Description

= KR

Bl p Aggreg e
Asphalt Concrete Hot Mix Type A
Furnish & Haul Hot Mix

ipe
10 Inch PVC Force Main (SDR21)

106

&
Fi
[=4=]
-
-
=
=
=
=

T
=g

Re A il il

1

Copy
Paste

Fill Down

Link these fields to Excel
UnLink from Excel

Indent

Outdent

Insert

Insert Subordinate

Insert Dependent Cost ltem
Insert Cost ltem Assembly

Insert Cost ltem Assembly as Subordinate

Toggle Suspended

Go To Cost Allocation ltem

Schedule Selection, |

As-Entered Currency  As-Entered Units

wig

' Add Quote...

D.0000030
Unschedule Selectiof® ——

Calculate Plug Days...

Subtotal Calculator

¢ On the Schedule Cost Items dialog, you can select whether or not you want to roll up the

selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click

OK.

@ Schedule Cost Ttems

To rollthe selected cost items up to a specificlevel of the CBS for scheduling
purposes only, choosethedesired level below,

i@ Schedule selected cost items and their subordinates without rolling them up

i) Schedule selected cost items rolled up to CBS level: |1

[ oK ] [Canc&l]

¢ Your scheduled cost items will import into Primavera the next time you update Primavera

from InEight Estimate.
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12.1.2.2 Roll Up Schedule

For cost item 3 — Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.
2. From the Saved Views drop-down list, select Schedule Setup View.
e Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

gg:ﬁun Code = Description Scheduled Egllelﬂille
+ 1 Mobilization W

+ 2 Clearing & Grubbing W

=3 Unclassified Excavation v
+ 3.1 Excavation

+ 3.2 Embankment D

= a4 Aggregate Base v

+ 41 Furnish & Haul Base Material v

+ 4.2 Finegrade Subgrade o

E 43 Install Aggregate Base W

+ 4.3.1 Place Agaregate Base v

+ 4.3.2 Blue Top Aggregate Base W

12.1.3 Update Microsoft Project from InEight Estimate

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.

When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project
Project Data Job Code Project Name
Activity Data CBS Position Code 01-CBS Position Code
Description Description
Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new

schedule.

Step by Step — Update MS Project from InEight Estimate

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

Training Job - Estimate}

System Integrations Actions More Actions
ﬁ e Account Code Utiization & Pz Resource Utiization m - f oo Job Finance ——— & pirect
Ea: Work Breakdown Structures - £ Resource Cost Details - oo 94 Price % Add On et ) ndire
Cost Breakdown Resources Workbook Schedule  Cash Flow Indirect X Price Breakdown
Structure (CBS) = £5] Resource Employments = = CostItems (%) Prime Bond Structure (PBS) = Datal
Breakdown Structures Resources Workbook | m Open M5 Praject (Cost Overhead and Proi
Cost Breakdown Structure (CBS) Register @ | s& Update Estimate from Praject
Drag columns here to group | &®  Update Project from Estimate
cBs _ beasint Optional Export Copy of MSProject File | otal cost E—
Position Code = SELLILL Code o QuanTTy WiEasUre (Forecast) Ly=eaeis
= B JOB 20,00 Mile §294,138.13  §5,882,762.51
Prime Bond PRIME BOND 1.00  Lump Sum §47,148.68 $47,148.68
Price % Add-On PRICE % ADD-ON 1.00  Lump Sum §295,638.13 $295,638.13
Job Financing FINANCE EXPENSE 1.00  Lump Sum $33,105.26 $33,105.26
Indirect Cost Escalation INDIRECT COST ESCALATION 1.00  Lump Sum §2,131.11 $2,131.11
Direct Cost Escalation DIRECT COST ESCALATION 1.00  Lump Sum §15,048.80 %15,048.80
Indirect Cost Add-On 1.00  Lump Sum §5,388.67 $5,888.67 $294,433.42
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum §104,088.34 $104,083.34 $5,204,417.24
=21 SITEWORK & ROADWAY 200 1.00 Each $2,464,161.56 §2,464,161.56
+ 11 Mobilization 5410100 1.00  Lump Sum §11,909.51 $11,909.51

¢ Your job automatically opens in Microsoft Project

¢ The Work Breakdown Structure Layout displays for the project
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¢ You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

e |Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

H - = Training Job.mpp - Project Standard GANTT CHART TOOLS RN x
FILE TASK RESOURCE REPORT PROJECT VIEW FORMAT Bhavna Gupta ~ x
L~
“D Vo Fa— WO NS OS B )y on Track L= P v MTask - El m # -
B - _ - summary & -
o oS BT U DA TS e e Prepeames (e B W hione TG TR
View Clipboard Font & Schedule Tasks Insert Properties Editing ~
GJE'EEE"S e January 1 March 1 May 1 =
0 . - Description ~ | Duraton  w Stat Finish - | t218 nz 28 e 45 =3 S3M
o[ ] 0|4 JoB 45 days?| Mon 2/3/20 Fri 4/3/20 P—
1 1 Wobilization 10 days? Won 2/3/20 Fri 211420 )
2 2 Clearing & Grubbing 10 days? Won 2/3/20 Fri 211420 i
| s Unclassified Excavation | 1 day?| Won 2/3/20 Mon 2/3/20° |
e 4| 4 Aggregate Base 45days?|  Mon 2/3120 Fri 413i20 P——
41 Furnish & Haul Base Material 45 days? Won 2/3/20 Fri 413720
42 Finegrade Subgrade 40 days? Mon 2/3/20 Fri3i27/20
43 4 Install Aggregate Base 40days?|  Mon 2/3/120 Fri 3(27120 —
8 431 Place Aggregate Base 30 days? Won 2/3/20 Fri 31320
9 432 Blue Top Aggregate Base 40 days?, Won 2/3/20 Fri 3127/20.
10 5| 4 Asphalt Concrete Hot Mix Type A 2917 days?|  Mon 21320 Fri 313120
E 1" 51 Furnish & Haul Hot Wi 29.17 days? Won 2/3/20 Fri /1320
g 2 52 Install Hot Mix Type A 23.33 days? Won 2/3/20 Thu 3/5/20
=3 6 4 36Inch RCP Culvert Class Ill 9.92days?|  Mon 213120 Fri 211420
Z 8.1 Furnish RCP Materials S days?| Won 2/3/20 Fri 207120 ]
@ 15 62 Excavate RCP Trench 4,65 days?| Won 2/3/20 Fri 207120 ]
1 63 Install RCP Pipe 4.1 days? Won 2/3/20 Fri 207720 ]
1 6.4 Backfil RCP Pipe 9.92 days?| Won 2/3/20 Fri 21420 i)
l
-
—
4 » 4

v
READY =, NEW TASKS : AUTO SCHEDULED B B #H £ -———=+

12.1.4 Update InEight Estimate from Microsoft Project

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate
Activity Data  Start Dates Start Dates
Finish Dates Finish Dates

Hours Hours
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Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.

Step by Step — Update InEight Estimate from MS Project

1. Open your version of the Training Job project in Microsoft Project.

¢ In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

Fde- s Training Job.mpp - Project Standard GANTT CHART TOOLS FREt x
FE AS<  RESOURCE  REPORT  PROJECT  VIEW FORMAT Bhavna Gupta - x
o = Task - .
0 Lo cho | mEmESmES Tk - - Taske E Lo i
G bae 27 Manually [ BE- Psummary scoll
antt  Paste Blru H-A- %57 5G9 Respect Links anual uta N nfarmation . Scro
Chat- - ¥ - - i Schedule [Schedulel 7~ W Milestone B toTask [B1
View Clipboard Font I Schedule Tasks Insert Properties Editing -~
o Link the Selected Tasks (Ctrl+F2) January 1 Warch 1 ey 1 1=
ﬂ Position ¥ Description ~ | You can link tasks so one can't start Finish - 1218 | 112 29 318 45 53 5131
o - oon until the other has finished. = —
1 1] Mobiization You can also link tasks in other Fri 211420 =
2 2 Clearing & Grubbing ways, such as a Start-to-Start link Fri2/1a20| =
3 £l Mnclas=ined Excavaton when two tasks need to start at the m 1
5 ti -
4 4| 4 Aggregate Base smetime Fri 4/3720]
5 41 Furnish & Haul Base Material 45 days? Mon 2/3/20 Fri 4/3/20
1] 42 Finegrade Subgrade 40 days? Mon 2/3/20 Fri 3/27/20|
7 43 4 Install Aggregate Base 40 days? Mon 2/3/20 Fri 3127120
& 431 Place Aggregate Base 30 days? Mon 2/3/20 Fri 313720
9 432 Blue Top Aggregate Base 40 days? Mon 2/3/20 Fri 3/27/20|
10| 5 4 Asphalt Concrete Hot Mix Type A 29.17 days? Mon 2/3i20 Fri 3/13/20|
E 1" 5.1 Furnish & Haul Hot Mix 29.17 days? Mon 2/3/20 Fri 3/13/20|
E 12} 52 Install Hot Mix Type A 23.33 days?. Non 24320 Thu 3/5/20
': 13 6 4 36 Inch RCP Culvert Class Ill 9.92 days? Mon 2/3i20 Fri 2/14/20|
E 14 6.1 Furnish RCP Materials 5 days? Mon 2/3/20 Fri 27120
0 45 62 Excavate RCP Trench 465 days? Non 24320 Fri 27720
16 63 Install RCP Pipe 4.1 days? Mon 2/3/20 Fri 27120
17| 6.4 Backfil RCP Pipe 9.92 days?| Mon 2/3/20 Fri 2/14/20|
=
< il »
READY E) NEW TASKS : AUTO SCHEDULED

¢ Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.
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Training Job - Estimate]

ﬁ !_-_ Account Code Utilization e E; Resource Utlization m
!_g Work Breakdown Structures - 2 Resource Cost Details
Cost Breakdown Resources Workbook
Structure (CBS) - ézl Resource Employments -
Breakdown Structures Resources Workbook
Cost Breakdown Structure (CBS) Register @
Drag columns here to group
SUE:ﬁUFI Code = Do gg;igﬂd
=+ B JoB
Prime Bond PRIME BOND
Price % Add-On PRICE % ADD-ON
Job Financing FINANCE EXPENSE
Indirect Cost Escalation INDIRECT COST ESCALATION
Direct Cost Escalation DIRECT COST ESCALATION
Indirect Cost Add-On
Direct Cost Add-On DIRECT COST ADD-ON
B 1 SITEWORK & ROADWAY 200
+ Al Mabilization 6410100

—

= | BB

Schedule  Cash Flow Indirect
= Cost Items

ﬂ‘, Open MS Project

Job Finance ='= EP;\ Direct
]
% Price % Add On EE; Indire
Price Breakdown |
[=#] Prime Bond Structure (PBS) = Datal
Cost Overhead and Prof

I 9‘ Update Estimate from Project

5?9 Update Praject from Estimate

Export Copy of MS Project File

\erorsanay— e (oecmy | SblectCost
20,00 Mie $294,138.13  §5,882,762.51
1,00 Lump Sum $47,148.68 $47,143.68
1,00 Lump Sum $295,633.13 $295,638.13
1,00 Lump Sum §33,105.26 $33,105.26
1,00 Lump Sum §2,13L.11 §2,131.11
1,00 Lump Sum §15,048.80 $15,048.80
1,00 Lump Sum $5,888.67 $5,888.67 $294,433.42
1,00 Lump Sum $104,088.34 $104,088.34 $5,204,417.24
100 Each $2,964,161.56  $2,464,161.56
1.00  Lump Sum $11,909.51 $11,809.51

e On the Schedule Setup View, you can see the Start and Finish dates updated from MS

Project.
goBgﬁon Code Decere EER = E?ar!};: IE;I;l:h Ié‘::t Il;‘ianﬁ:h
+ 1 Mobilization 232020 2j14/2020  Z3/2020 2142020 (32020 2/14/2020
+ 2 Clearing & Grubbing 2/17/2020  2f28/2020  2(17/2020  2(28/2020  2/17/2020  2/28/2020

N T T —

+ 31 Excavation 3/2/2020  3/2/2020  32/2020  3(2/2020  3(2/2020  3(2/2020
+ 3.2 Embankment 3/2/2020  3f2/2020 322020  32/2020  3[2/2020  3{22020
= 4 Aggregate Base 3/3/2020  10/5/2020 332020  10/5/2020  3(3/2020  10/5/2020
+ 41 Furnish & Haul Base Material 3/3(2020  5/4/2020  33/2020  5/4/2020  3(3/2020  5/4/2020
+ 42 Finegrade Subgrade 5/5(2020  6/29/2020  §/5/2020  6/29/2020  5/5/2020  6/29/2020
B 43 Install Aggregate Base 6/30/2020  10/5/2020  &(30/2020  10/5/2020  6/30/2020  10/5/2020
+ 431 Place Aggregate Base 5/30/2020  8/10/2020  6/30/2020  §/10/2020  ©/30/2020  §/10/2020
+ 432 Blue Top Aggregate Base 8/11/2020  10/5/2020  §/11/2020  10/5/2020  8/11/2020  10/5/2020
=5 Asphalt Concrete Hot Mix Type A 1062020  12/17/2020  10f6/2020  12/17/2020 10/5/2020  12/17/2020
+ 51 Furnish & Haul Hot Mix 10/6/2020  11/16/2020 10/6/2020  11f16/2020 10/5/2020  11/16/2020
+ 52 Install Hot Mix Type A 11/16/2020  12/17/2020  11f16/2020  12/17/2020 11/16/2020 12/17/2020
B 6 36 Inch RCP Culvert Class III 12/17/2020  1/20/2021  12/17/2020 1/20/2021  12/17/2020 1/20{2021
+ 6.1 Furnish RCP Materials 12/17/2020  12/24/2020  12/17/2020  12/24/2020 12/17/2020  12{24/2020
+ 6.2 Excavate RCP Trench 12/24/2020  12/31/2020  12/24/2020  12(31/2020 12/24/2020  12{31/2020
+ 6.3 Install RCP Pipe 12/31/2020 162021 12/31/2020  1f6/2021  12/31/2020  1/6/2021
+ 6.4 Badkfil RCP Pipe 1/6/2021  1/20/2021  1f6/2021  1/20/2021  1/6/2021  1/20/2021

12.1.5 Export Copy of MS Project File

If your project’s schedule is integrated with MS Project, you can export a copy of your MS Project file.

This can be advantageous if a preliminary schedule is needed for a starting point schedule, as the
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project goes into execution. Recreating the schedule from scratch can be time consuming and error

prone, as the existing schedule details might not be properly captured in the beginning stages.

Estimate Price

File Setup

Quote

Execution

System

Integrations

Training Job - Estimate]

'_.-_ Account Code Utlization [

T

'ﬁ Work Breakdown Structures - f Resource Cost Details
Cost Breakdown Resources Workbook
Structure {CBS) - é:l Resource Employments -
Breakdown Structures Resources Workbook
Cost Breakdown Structure (CBS) Register @
Drag columns here to group
I?oa:hon Code = == A gapélgna\
5 = 108
Prime Bond PRIME BOND
Price % Add-On PRICE % ADD-ON
Job Financing FIMAMCE EXPENSE
Indirect Cost Escalation INDIRECT COST ESCALATION
Direct Cost Escalation DIRECT COST ESCALATION
Indirect Cost Add-On
Direct Cost Add-On DIRECT COST ADD-ON
21 SITEWORK & ROADWAY 200
+ 11 Mobilization 6410100

E; Resource Utilization

X|

—rem
— z EE Job Finance —— ) Direct
el
% Price % Add On LE' Indire
Schedule  Cash Flow Indirect Price Breakdown |
- Costltems 28] Prime Bond Struchie (P55) 4 Datal

Cost Overhead and Proi

m, Open MS Project
83" Update Estimate from Project
5.3 Update Project from Estimate

| Export Copy of M5 Project File l

Total Cost

(Forecast) Subject Cost

20,00 Mile $294,138.13 $5,882,762.51

100 Lump Sum §47,148.68 §47,148.68

1.00  Lump Sum 5$295,638.13 $§295,638.13

L00  Lump Sum $33,105.26 £33,105.26

100 Lump Sum §2,131.11 $2,131.11

1.00  Lump Sum $15,048.30 $15,048.80

1,00 Lump Sum $5,388.67 $5,888.57 $294,433.42

L00  Lump Sum £104,088.34 £104,088.34 $5,204,417.24

1.00 Each $2,464,161.56  $2,464,161.56

100 Lump Sum $11,909.51 §11,909.51

12.1.6 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and

dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.1.6.3 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity

may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want

those extra days to drive the costs in your estimate, since your crews won’t be working on the activity

on those extra days.

TIP
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Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

Estimate Intermediate User Guide

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in

Primavera (7 days).

CBS

Position Code  —

Days

Description (Duration driven)

Schedule
Plug Days

Plug
Days

2 6 36 Inch RCP Culvert Class ITI 18.66 V' 26.01
+ 61 Furnish RCP Materials 0.00 W 5.00
I+ 6.2 Excavate RCP Trench 4.65 W ?.DDI
+ 6.3 Install RCP Pipe 4,10 41‘:?
+ 6.4 Backfill RCP Pipe 9.92 9.92

¢ This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the

schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to

production in InEight Estimate.

12.1.6.4 Update Microsoft Project with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.

Step by Step — Update MS Project with InEight Estimate Changes

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

¢ In this scenario, there is a scope change for your Excavation requiring you to change all of

your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.

Page 218 of
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Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

¢ As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

e |f prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

You have changed the quantity for a cost item that already contains costs.
Would you like the TOTAL cost to change or the UNIT cost?

i@ Change TOTAL cost

7) Change UNIT cost

I Deactivate this confirmation for quantity changes FOR ALL JOBS
and ALWAYS change the TOTAL cost

To re-activate this confirmation, choose Tools = Activate UnitfTotal
Confirmation for Quantity Changes.

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

¢ The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

¢ You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
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adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

01-CBS
Position

0 Code ~ Description - Duration « Start - Finigh -
0 0 2 JOB 23951 days? Mon 2/3/20 Fri 171721
1 1 Mobilization 10 days? Mon 2/3720 Fri 2420
2 2 Clearing & Grubbing 10 days? Mon 2M7/20 Fri 2/28/20
3 3 Unclassified Excavation 1 day? Mon 3/2/20 Mon 3220
4 4 4 Aggregate Base 155 days? Tue 3320 Mon 10/5/20
5 41 Furnigh & Haul Base Material 45 days? Tue 3/3/20 Mon 5/4/20
6 42 Finegrade Subgrade 40 days? Tue S/5/20 Mon 6/25/20
7 43 4 |nstall Aggregate Base 70 days? Tue 6/30/20 Mon 10/5/20
2 431 Place Aggregate Base 30 days? Tue 6/30:20 Mon 81020
9 432 Blue Top Aggregate Base 40 days? Tue 811420 Mon 1045720
10 5 4 Asphalt Concrete Hot Mix Type A 37.56 days? Tue 100620 Thu 11/26/20
" 5.1 Furnish & Haul Hot Mix 20.83 days? Tue 10/6/20 Tue 114320
12 52 Install Hot Mix Type & 16.67 days?| Tue 11/3/20 Thu 11/26/20
13 6 4 36Inch RCP Culvert Class Il 26.01 days?  Thu 11/26/20 Fri 11i21
14 6.1 Furnish RCP Materials S days? Thu 11/26/20 Thu 12/3/20
15 I 6.2 Excavate RCP Trench 7 days?l Thu 12/3/20 Mon 12M4/20
16 6.3 Install RCP Pipe 4.1 days? Mon 1214720 Fri 121820
17 5.4 Backfill RCP Pipe 992 days? Fri 12/18/20 Fri 111721

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.

nghon Code Description Start Fn Ei;lr‘; E;:; Ié‘:ahft tllan‘::h

+ 2 Clearing & Grubbing 2(17/2020 | 2f28[020 | Y1F[A020 | 2B/(A020  21T[H00 | 2{28{2020
E 3 Undassified Excavation 3/2/2020 3f2f2020 | 3/2/020 | 322020 3f2f2020 | 3{2{2020

+ 31 Excavation 3/2/2020 3/2/2020  3/2/2020  3f2{2020 3f2/2020 | 3{2/2020

+ 3.2 Embankment 3/2/2020 3/2/2020  3/2/2020  3f2{2020 3f2/2020 | 3{2/2020

= 4 Aggregate Base 3/3/2020 10/5/2020 | 3/3/2020 | 10f5/2020  3f3/2020 | 10/S{2020
+ 41 Furnish & Haul Base Material 3/3/2020 5/4/2020 | 3/3/2020 | 5[4/2020 332020 | 5/4/2020

+ 42 Finegrade Subgrade 5/5/2020 5/29/2020 5/5/2020 6/29/2020 5/5/2020 6/29/2020
B 43 Install Aggregate Base 6/30/2020 10/5/2020  6/30/2020 10/5/2020  6/30/2020 10/5/2020
+ 431 Place Aggregate Base 5/30/2020  8/10/2020  §/30/2020 | 8/10/2020  6/30/2020 8/10/2020
+ 43.2 Blue Top Aggregate Base 8/11/2020 10/5/2020  B/11f2020 10/5/2020  8/11/2020 10/5/2020
E 5 Asphalt Concrete Hot Mix Type A 10/6/2020 11/26/2020  10/6/2020 11/26/2020 10/5/2020 11/26/2020
+ 51 Furnish & Haul Hot Mix 10/6/2020 11/3/2020 10/6/2020 11/3/2020 10/6/2020 11/3/2020
+ 5.2 Install Hot Mix Type A 11/3/2020  11/26/2020  11f3/2020  11f26/2020 11/3/2020 @ 11/25/2020
E 6 36 Inch RCP Culvert Class TTI 11/26/2020  1/1/2021  14/26/2020  1f1/2021 11/26/2020 | 1/1f2021

+ 6.1 Furnish RCP Materials 11/265/2020  12/3/2020 | 11/26/2020 | 12/3/2020  11/26/2020 | 12f3/2020
+ 6.2 Excavate RCP Trench 12/3/2020  12/14/2020 | 12/3{2020 | 12/14/2020 12/3/2020 | 1214/2020
+ 6.3 Install RCP Pipe 12/14/2020  12/18/2020 | 12f14/2020 | 12/18/2020 12/14/2020 = 12f18/2020
+ 6.4 Backfill RCP Pipe 12/18/2020  1/1/2021  12/18/2020  1/1/2021 12/18/2020 | 1/1/2021
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Lesson 12 Review

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit
b. Expense Costs

C. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs
C. Resource data
d. Cost data

€. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

Lesson 12 Summary

As a result of this lesson, you can:
e Set up scheduling options
¢ Update Schedule from InEight Estimate
e Update InEight Estimate from Schedule

e Manage changes between estimate and schedule
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LESSON 13 — CASH FLOW

Lesson Duration: 25 Minutes

Lesson Objectives

After completing this lesson, you will be able to:
¢ Interpret cash flow and resource utilization on the Cash Flow graph
¢ Select Cash Flow Options

¢ Change Cash Flow Display Settings

Lesson Topics
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13.1 CASH FLOW OVERVIEW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Overview - Cash Flow Form

1 The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.
e The x-axis measures time
* The left y-axis measures amounts
» The right y-axis measures quantities (when resource utilization is displayed)
» All graphs depicted on the Cash Flow form can be displayed based on Pay
Quantity or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.

» You can display total costs and price or specific cost categories
* You can also set the display settings to report on Resource Utilization

3 Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost
of money.
4 Click the Excel icon to export the numerical data represented on the graph into an

Excel spreadsheet where you can run additional analysis.
5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset
Zoom button to restore the graph to its original state.
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File Setup Estimate Quote Price Execution System Integrations Actions

IEI'! Print [&7 Cash Flow Options 3

'i Preview ﬁ Display Settings o
@ Page Setup E Worksheeto

Print Tools
CashFlow @ o =
$8,000.000.00
$6,000.000.00 P
'c:/_ I I
o
'
£4,000.000.00 - - £ Ff
o
— ,
£2,000.000.00
g
| L
£0.00 4 |
(2,000,000.00) 3 2
E/ e 2 T, . . £ & & g [
! .= & 3 % i T T = e
%, @‘;’07 ée% %07 %o ‘%’77 % %97 %V‘é) % %% %‘% %%, % %’07 %
% ¥ v ¥ 7 ¥ e ¥ e % r % 7 . ¥ %
Schedule Last Updated: %/25/2013 9:34 PM Finance Cost: $3,007.32
... Total Cast .. Total Price — Total Cost _—_ Total Price Cash Flow = Finance Cost
(Forecast) {current) (Forecast) - Cash (current) - Cash
Date Range Cost Item Range Click and drag in the graph Include Finance Cost in this Job's Target Price
Start: Start: area to zoom in manually
art: || - art: - (O calculate automatically according to the Cash Flow graph
- - Reset Zoom
End: ~| End: - (® Enter a plug number directly in the PBS
As-Entered Currency  As-Entered Units  v19.1HD_19.1_QA2016  Training Job Accrued Costs OFF

13.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options - icon in the Tools section of the

Actions tab.

TIP You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing: Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing: Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

\[e] 2 To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money: Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/0)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.

Page 226 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide 13.2 Cash Flow Options

Setup Estimate Quote Price Execution System Integrations

B ¥ BB &L % a 3B @

23 Equipment

JobProperties  Foundation  PayItem & Bid Wizard | Resource ) Resource | Costltem Standard | Reports
- Setup Data ~ Propaosal Rates = 8 Materials Assemblies = Assemblies  Tables
Initialize Resources Assemblies Reports =
Cash Flow Job Properties @ =
Overview | Security | Cover Sheet | CostBasis | Minority Setup | FuelCost | JobTracdng | Job Folder Tags | Competitors | Pridng | Schedule r
1
Bills are submitted to the owner: Average calendar days elapsed from billing to collection: days

(O) At the end of the job Amount of each billing that is withheld by owner as retainage: %
Every month on this day|25 Retainageis released: At the end of the job
Ty |
O Every D weeks () 0On a specific date: -
() Every l:l days [] Spread revenue using the same Cost Curves as the contributing Cost Items

== 2 )

Bills are received from subcontractors Average calendar days elapsed from receipt ofinvoice to payment: days
and vendors:

Amaount of each invoice received thatis withheld by you as retainage: %
() At the end of the job

Retainageis released to At the end of the job
@ Every month on this day 5| e ey O

(O On a specific date: B

() Every l:l weeks
Oty [I__] dmye Apply cash timing rules for all procurable cost categaries (non labor and equipment),

even if their cost source is not set to "Quote™?

Cost of money

Average annuaEintErest rate paid to borrow maney (when cost exceeds

=10

() Pay Quantity
Average annual interest rate earned (when revenue exceeds cost): (®) Forecast (T/0) Quantity
e v =10
Period setting for cashflow: | Day - Early Start /Finish =

13.2.0.1 Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

Step by Step — Cash Flow Options Setup

1. Inthe E101 - Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

Cash Flow Job Properties

Overview Security Cover Sheet | CostBasis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors Pricing Schedule Cash Flow E L

* You will see the default options already there
¢ You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.

InEight Inc. | Release 24.3 Page 227 of 257



13.2 Cash Flow Options Estimate Intermediate User Guide

¢ The average calendar days from billing to collection should be set to 25 days

Overview Security | Cover Sheet | Cost Basis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors Pricing Schedule Cash Flow

evee s | @)

Bills are submitted to the owner: | Average calendar days elapsed from billing to collection: days
() At the end of the job Amount of each billing thatis withheld by owner as retainage: %
I (®) Every month on this dayl Retainage s released: (@) At the end of the job
O Every El weeks () On a specific date: -
() Every l:l days [[] Spread revenue using the same Cost Curves as the contributing Cost Items

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

¢ Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

Cost timing o

Eills are receivad from subcontractars IA\.'erage-:aIendar days elapsed from receipt of invoice to payment: 30 daysl
and vendors: ——
Amount of each invoice received thatis withheld by you as retainage: 5.00| %
(") At the end of the job :
Retainageisreleasedto (@) At the end of the job
I (@) Every month an this day|25 I subcontractors and vendors:
(O 0On a specific date: -

() Every |1 weeks

Apply cash timing rules for all procurable cost categories (non labor and equipment),
1
O Every days even if their cost source is not set to "Quote™?

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

Cost of money o

Average annual interest rate paid to borrow money (when cost exceeds 10.00| %4

Average annual interest rate earned (when revenue exceeds cost): %%

5. Leave all remaining options as originally defaulted.
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13.3 CASH FLOW DISPLAY SETTINGS

13.3.1

13.3.2 Cost Items and Cost Categories

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings = icon in the Tools section.

Overview - Cash Flow Display Settings - Cost Items and Cost Categories

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include: Day,
Week, Month, Quarter, and Year.

3 Under the Cost Items section, you can select:

 Total Cost (Forecast): The total cost of your scheduled cost items, based on
when your costs are accrued (when your cost items are scheduled). This is
displayed as a dashed line on the graph

» Total Price (current): The total revenue of your pay items, based on when the
revenue is earned (when your cost items are scheduled). This is displayed as
a dashed line on the graph

 Total Cost (Forecast) - Cash: The total cost of your scheduled cost items,
reflecting the cost timing you specify in the Cash Flow Options. This is
displayed as a solid line on the graph

 Total Price (current) - Cash: The total revenue of the pay items, reflecting the
revenue timing you specify in the Cash Flow Options. This is displayed as a
solid line on the graph

« Cash Flow: Displays the difference between your Total Cost - Cash and Total
Price - Cash values, so you can see if you are making or losing money

» Finance Cost: Displays the Cost of Money amount calculated from the
settings you specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to
display.
» The other check boxes are used for InEight Estimate Performance
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Cash Flow Display Settings m} X
Cat i
ISe‘mngs: ‘ Default Cost Resources
z Planned [] Resource Utilization
[] Display this text ontcm report title: Estimated As-Built To Date
Labor O - O - O - Summarize resources by: | Resource Type
e Owned Equipment D I I Get data from: ob’s utilize
3 - Rented Equipment [ ] [l O
Period Day | Value Cty Cost AB Gty AB Cost
Cost tems Supplies | ] Ol O [ Labor
[] Construction Equipment
EFFDtaI CDst)L ] Materials O OB O e ] Rented Consiucion Eq
OrEcas
[ Installed Material
Toal Prce B ||secone OB OB O | 5o oo
[curren
[ Supply
Total Cost | ] Fees O O O
(Forecast) - Cash |:| Unigue
Total Price | Allowznce Ol O e O/
{current) - Cash
Cash Flow Custom Categoryl [] O O
et | Urisfive Ol O O Quantity: Cost:
— N !
[ As:Buil: ] e one
Total Cost As-Built Quantity: As-Built Cost
CE-Total Cost
O Earned (to-date) L None None
(3] Cance

13.3.2.1 Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

Step by Step — Cash Flow Display Settings Set Up

1. In the E101 - Training Job, from the Estimate tab, select Cash Flow from the Schedule section.
2. On the Actions tab, select Display Settings = to open the Display Settings window.

3. From the Period drop-down list, select Week.

4. Under the Cost Items section, make sure the following are selected:

e Total Cost (Forecast)

Total Price (Forecast)

Total Cost (Forecast) — Cash

Total Price (Forecast) — Cash

Cash Flow
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¢ Finance Cost

Cost kems

Total Cost
(Forecast)

Total Price
([current)

Total Cost
(Forecast) - Cash

— Total Price
(current) - Cash

| Cash Flow

ol

+| Finance Cost

As-Bult
Total Cost

CE-Total Cost
Earned (to-date)

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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Cost Categories

Labor

Owned Egupment

6. Click OK to close the Display Settings window.

¢ Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

e Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

e Your Total Cost (Forecast) — Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

e Your Total Price (current) — Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

e Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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e Your Finance Cost displays as a blue line on the graph

$8,000.000.00

$6.000,000.00

¥ 5.;_::;;; ....... / =7

$4,000,000.00 23 /-

..............

S200,000.00 - >
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7. To filter your graph by date range, click on the Start drop-down arrow - and select a start date of
your date range filter.

o e i 1;,}
Thursday, December 27, 2013 1 %f-;r
4 February 2014 *

s MO TU WE TH FR  5A

26 27 28 29 30 31 1
2 H 4 9 B 7 3
9 10 11 12 13 14 15 otal Cost
Forecast) - C

e 17 18 19 20 21 2
23 24 25 2w 27 2B 1
2 3 4 ] ] 7 g

Date Ri Clear
Start: _ | Start: | -
End: - | End: -

8. Click on the End drop-down arrow - and select an end date of your date range filter.
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e Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10.

Do the same for the End field.

13.3.3 Resource Utilization

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage times

for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

Resource Type

Resource Code

Description

Organizational Category

Tag1,2,and 3

Quote Group

Account Code and Cost Item Account Code

Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings = in the Tools section of the Actions menu.
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Cash Flow Display Settings - m} *
Settings: | Previous Cost Categories Resources
= 5 Planned Resource Ltilization
[] Display this text as a custom report title: Estimated As-Built To Date h
Labor H O B O [ ] Summarize resources by: | Description ~
(Owned Equipment O O Get data from: @ This jeb’s utilized resources
() Al Library resources
i Rented Equipment [ ] O O
Feried Week x Value Gty Cost ABGty ABCo™
Cost ftems Supplies O - | - O - [] Dozer D&
[] Dump Fees
EI';)taI Cosbt ] Materials Ol O/l O ] Dump Truck
orecas
[ Excavator 225
M o e e e S
[] Feeder Controls
Total Cost B F
[Fnrecauss{) -Cash = U U u E En.ehAggregate
Total Price ] Allowance O Ol O/l inisher
(current) - Cash [ Ratbed Truck
Cash Flow Custom Categoryl  [] O | [] Form Materials v
< >
Fince Cost B e O O O | e ot
M ~ M ~
As-Built ] lane one
Total Cost As-Built Quantity: As-Built Cost:
CE-Total Cost “ i
U Earned (to-date) L] None Mone

OK Cancel

13.3.3.2 Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

Step by Step — Resource Utilization Display Setup

In the E101 - Training Job, from the Estimate tab, select CashFlow from the Schedule section.

On the Actions tab, select Display Settings = to open the Display Settings window.

1
2
3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.
4. Under the Resources section, check the Resource Utilization checkbox.

5

From the Summarize resources by drop-down list, select Description.
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Resources

Resource Utilization

Summarize resources by: | Description v

(zet data from: (@) This job's utilized resources
() All Library resources

6. From the resulting list of Values, select Laborer.
7. Click in the Qty field for the selected value and select a color of your choice.
¢ In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

(et data from: (®) This job's utilized resources
() All Library resources

Value City Cost ABGty ABCo™
[ ] Labor Foreman

Laborer

[ ] Loader 950

[ 11 gwhoy Trailer

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a

Line.
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Value City Cost ABCty ABCo™

[ ] Labor Foreman

tors e
[ ] Loader 950

[ ] Lowboy Trailer

[ ] Manhole Precast 4 Ft
L4 >

Quantity: Cost:

Bar o Line -

10. Click OK to close the Display Settings window.

e The graph now displays the utilization of your Laborer resource, showing the work hours

and costs used over time

$3.500.00 7-35.00

$2.000.00 — —30.00

$2.50000 —25.00

$2.000,00 — 2000

$1.500.00 — —15.00

$1.00000 1000

$500.00 —

$0.00—

Schedule Last Updatad: 122019 1203 AM

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).

InEight Inc. | Release 24.3 Page 237 of 257



Lesson 13 Review Estimate Intermediate User Guide

Lesson 13 Review

1. Under what cash flow form can you set up your revenue and cost timing?
a. Cash Flow Options
b. Display Settings
C. Worksheet
d

. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:
a. Total Cost (Forecast)
b. Total Price (current)
C. Total Cost (Forecast) — Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description
. Resource Type
. Resource Code

b
C
d. Description
€. Wage Zone
f

. Organizational Category

Lesson 13 Summary

As a result of this lesson, you can:
¢ Interpret cash flow and resource utilization on the Cash Flow graph
¢ Select Cash Flow Options

¢ Change Cash Flow Display Settings

Page 238 of 257 InEight Inc. | Release 24.3



InEight’
ESTIMATE

z
m
o
- -
-
&

LESSON 14 — INEIGHT ESTIMATE
CALCULATORS

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:
e Use the Haul Calculator
e Use the Trench Calculator

e Use the In-Field Calculator

Lesson Topics
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14.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

¢ Calculate the number of trucks required to complete the haul in a set amount of time, or
¢ (Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

Step by Step — Haul Calculator - Calculate Quantity of Trucks

1.
2.
3.
4.

Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
Open cost item 4.1 — Furnish & Haul Base Material.
On the Cost Item Record, click the Detail tab.

Right click on the ETDT — Dump Truck row header and select Open Haul Calculator.
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Cost Item Summary | S Detail: $11.54 | # Plug: $0.00 | [ JQuote : $0.00

Drag columns here to group

Row

Number = Code Resource Assembly Description
LT1 Teamster

. ....................................... o
E Open Aggregate Base Rock
9 Delete
#< Cut
= Copy
f:'ﬂ Paste
I+ Fill Down

Link this field to Excel
UnLink from Bxcel

Insert Resource

Insert Resource Assembly

X
€]
X
=)
il
."-_'..-n
b
1]
E Open Haul Calculator
il
-

. Edit Resource Periods...

5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

Haul Calculator Record - Training Job

(® Calculate quantity of ETDT required to complete haul in duration entered below

(O Calculate total duration of haul using quantity of ETDT entered below

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35 Mile/Hour.
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10. For Dump Time (Minutes), type 2.
11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.
12. Enter a Work Efficiency of 90 percent.

Route 1
Quantity (Ton) 45,000.00
Haul Distance - One Way (Mile) 5.00
Average Payload (Ton) 30.00
Total Loads 1,500.00
Load Time (Minutes) 3.00
Travel Speed Full (Mile/Hour) 35.00
Dump Time (Minutes) 2.00
Travel Speed Empty (MilefHour) 45.00
Cycle Time (Minutes) 20.24
Work Efficiency (%) 90.00
Total Hauler Hours 562.17
Hours Per Shift 8.00
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¢ The calculator shows a result of 1.56 concurrent haulers

Results

Quantity of resource ETDT 1.56 0.00 0.00 1.56] Concurrent Haulers
Total duration (Hours) 0.00 0.00 0.00 360.00| Hours
Concl

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

EE::ber B Code Resource Assembly Description ?Lz:gﬁft'gste) deads-tsn% Quantity H’;E;;E
1 LT Teamster 2.00 | Each
2 ETDT Dump Truck 2.00 | Each
3 MBR Aggregate Base Rock 45,500.00 5.00 47,775.00 Ton

Step by Step — Haul Calculator - Calculate Total Duration

1.
2.
3.
4.
5.
6.

Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
Open cost item 4.1 — Furnish & Haul Base Material.

On the Cost Item Record, click the Detail tab.

Change your Teamster and Dump Truck quantities back to 2 each.

Right click on the ETDT — Dump Truck row header and select Open Haul Calculator.

On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

¢ With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours
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@l x

(O Calculate quantity of ETDT required to complete haul in duration entered below
(@ Calculate total duration of haul using quantity of ETDT entered below

Route 1 Route 2 Route 3 TOTAL
Quantity (Ton)| 45,ooo.uo| | o.oo| | u.on| 45,000.00 Ton
Haul Distance - One Way [Mile)| S.Uﬂl | U.UU| | U.DIJ| 5.00 | Mie -
Average Payload (Ton)| 30.00] | 0.00] | 0.00| 30.00 Ton
Total Loads| 1,500.00] | n.00] | 0.00] 1,500.00
Load Time (Minutes)| 3.00] | n.00] | 0.00| 3.00 Minutes
Travel Speed Full (Mile/Hour)| 35.00] | 0.00] | 0.00| 35.00 Mile/Hour
Dump Time (Minutes)| 2.00] | 0.00] | 0.00| 2.00 Minutes
% Travel Speed Empty (Mile/Hour)| 45.00] | 0.00] | 0.00| 45.00  Mile/Hour
Cycle Time {Minutes))| 20.24] | 0.00] | 0.00| 2024 Minutes
Work Efficiency (%) s0.00] | 100.00] | 10000 30.00 %
Total Hauler Hours 562.17 0.00 0.00 562.17 Hours
Hours Per Shift 8.00 8.00 8.00 8.00
Results
Quantity of resource ETDT 0.00 0.00 0.00 200 Concurrent Haulers
Total duration (Hours) 281.08 0.00 0.00 281.08)] Hours
Gance

7. Click OK.
¢ The Hours field on the Production tab updated to 281.08

e Your ETDT Dump Truck quantity remains at 2

14.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

¢ Total excavation volume (neat-line)

e Total excavation volume (including swell/shrinkage)
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¢ Total pipe to purchase
¢ Lift Volume (for up to four beddings)
e Lift Weight (for up to four beddings)
You can use these calculations to define certain cost item setup data:
* You can use the Total Excavation Volume that is calculated as the quantity of the cost item

e You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

* You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

e You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

TIP You can access the Trench Calculator from the Actions tab of a Cost Item Record
MeJ= When copying cost items in a job or from job to job, the Trench Calculator variable data is

included with the data being copied. When a cost item is copied to the clipboard, Trench
Calculator variable data is also included.

14.2.1 Trench Calculator - Trench Tab

The following steps walk through using the Trench Calculator to take-off excavation volume.

Step by Step — Trench Calculator - Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.
3. Add the following three subordinates and update their Units of Measure:

e Excavate Trench: CY

¢ Install Pipe: LF

e Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:
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e LL2 Laborer-1
e LO2 Operator Class2 -1
e EX245 Excavator 245-1
5. Adjust the Production to: 100 CY/Hour.

Cost Item Summary S,Qetail :§1.74 9 Plug : §0.00 Oguobe : §0.00 Allocation Production X
Drag columnsFimdz | [Search For...] = | Saved views: | Previous View - Days: 0.00 *
Row - o Quantity shifs:| 0.0 0.00
Number = T  Code Resource Assembly Description (Less Waste)
1 L2 Laborer
Man-HUurs: 0.00
2 L2 Operator Class 2
Excavator 245 EOWDHOE: 0.00
e CY/Day: 800.00 0.00
CY/Shift: 800.00 0.00
I CY{Hour: 100.00 | I 0.00
cYiMan-Hr:| 50,00 a0 7
" »
- - - . P
' & BB s 8. 2. % &. =

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

Training Job - Estimate

System Integrations Actions
jue (Delta) Resource Fields EE, Edit Resource Periods 'l_'.-| Trench Calculator
jue (Delta) Cost Item Fields E Insert Subordinate ==l shift / Rate Caloulator

Break Cost Allocation Link

Tools

d O Trench Calculator

E(T/O) Qty:  Unit of Measure: IInit Cost: Total Cost: Currend

1.00 | Each 51.74 5174 | U.5. Dg

7. For Trench Length, type 1000.00 feet.
8. For Trench Width (at the bottom) type 4.00 feet.
9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.
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11. Enter a Backslope of 45 degrees.
12. Define the Material Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.
¢ You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

@l Trench Calculator

Trench Fipe Beddings

Variables

Trench length: feet
Trench width (at bottom): ” feet
Trench depth: feet
Hinge elevation: ” feet
Backslope degrees
Material sv.'ell;"shr]i:;l:ogre: (decimal)

Results

Total excavation volume
(neat-line): 240741 oY

Use this volume as the m
quantity on this cost item

Total excavated volume
(including swell/shrinkage): ~ 2/648.15 oY

Use this volume as the
]
quantity on this cost item

Save Configurationto Library Load Configuration from Library Togagle English / Metric Cancel

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

14.2.2 Trench Calculator - Pipe Tab

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.
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Step by Step — Trench Calculator - Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

e Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.
3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.
4. On the Cost Item Record’s Actions tab, select Trench Calculator.
5. Select Load Configuration from Library.
6. Select Trench Example (with your initials).
Drag columns here to group Find: Saved views: | Standard View -
Mame Comments Eiip;neber um 'Ip'iyl.?:e EEZS Agency Last Changed Last Chang
- Mew Trench Configuration (bla... 0.00 inches
24" PVC Sewer at 10' Deep (1) 26.00  inches 7/29/2009 2:13:19PM  wmfarr
ITrEnch Example PB 0.00  inches 2/15/2019 11:55:52 AM PauI.Eennl
7. Click OK.

8. 0On the Trench Calculator, select the Pipe tab.
Enter the following for the size and position of the pipe:

¢ Pipe exterior diameter: 26.00 inches

e Pipe center elevation (from bottom): 19.00 inches

e Waste factor: 10%
10. Click on the resource icon to pull up the Resource Rate Register.
11. Select the Installed Material tab.
12. Select MPP24 Pipe 24” PVC SDR35, then click OK.

¢ The Pipe variables you entered should match the following image:
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[

Trench Fipe Beddings

Variables

Fipe exterior diameter: 26.00| inches
Pipe center elevation (from bottom): 19.00| inches
Waste factor: 10.00| %

Resuilts

Total pipeto purchase: 1,100.00 LF

Usze Total Pipe To Purchase
as the quantity on this MPP24
resource {on this cost item):

| L3

Save Configuration to Library Load Configuration from Library Toagle English [ Metric Cancel

13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

14.2.3 Trench Calculator - Beddings Tab

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

Step by Step — Trench Calculator - Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.
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3. Add the following resources:
e LL2 Laborer -3
e LO2 OperatorClass2 -1
¢ RPC Plate Compactor—1
e EL950 Loader 950 -1
Adjust the Production to 160 CY/Day.
From the Cost Item Record’s Actions tab, select Trench Calculator.
Select Load Configuration from Library
Select Trench Example (with your initials), then click OK.

On the Trench Calculator, select the Beddings tab.

© © N o g &

On the Beddings tab, you can define up to four beddings to backfill the trench
¢ The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

_ Bedding Lift 1 | Bedding Lift 2 | Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00
Additional material needed 5.00 5.00 5.00
Conversion factor 1.60 1.70 1.60

e Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

- Resource Code | Resource Description

Bedding Lift1 MASAND Sand
Bedding Lift2 MAFA Fine Aggregate
Bedding Lift3 MACA1-1/2 Coarse Aggregate

Page 250 of 257 InEight Inc. | Release 24.3



Estimate Intermediate User Guide 14.2 Trench Calculator

Trench | Fipe Beddings |

(@) Bedding Lift1 (O) Bedding Lift2 (O) Bedding Lift3 (O) Bedding Lift4

Variables

Elevation (from trench floor): inches

Additional material needed to o

compensate for compaction: i
Conversion factor (TON per CY):

-

Results
Lift Volume: 77.78 o
Use Lift Volume as the guantity on | 1|
this resource (on this cost item):
Lift Weight: 124.44 Tons
Use Lift Weight as the quantity on | MASAND :|
this resource {on this cost item):
| Save Configurationto Library | | Load Configuration from Library | | Toaggle English / Metric 0K I | Cancel

12. Click OK.

¢ Note that the pipe and bedding materials are added to the cost item with their quantities

Row i - Quantity Waste % . Unit of
Number = T  Code Resource Assembly Description (Less Wasts) Add-on Quantity Measure

1 L2 Laborer 3.00 Each

2 Lo2 Operator Class 2 1.00 Each

3 RPC Plate Compactor 1.00 Each

4 EL950 Loader 950 1.00 Each

5 MASAND Sand 124.44 0,00 12444 Ton

& MAFA Fine Aggregate 593.66 0.00 5a3.66 Ton

7 MACAL... Coarse Aggregate ... 3,327.59 0.00 3,327,539  Ton
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Exercise 14.1 — Trench Calculator

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

N

Give the cost item a quantity and unit of measure of 1640 Linear Feet.

w

Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet
Trench depth 10 feet
Hinge elevation 5 feet
Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)
* Do NOT check the box to bring in volume shrinkage.
5. Select the MPR36 material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.
Bedding lift 1
Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3
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Bedding lift 1

Bedding material resource (Tons) MASAND

Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor)

76 inches
Additional material needed to compensate for compaction 5.00%
Conversions factor (Ton per CY) 1.1
Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results
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Cost Breakdown Structure (CBS) Register Cost Ttem Record @
Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:

1 1
[ ] 1
w2 | \ ‘Undergruund Pipe \ \ 1,aqu‘uu| [iF - £34.59 £56,734.45

CBS Code: Optional Code:  Desuription:

PIAssignment:  PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
] Job Overhead 1,640.00 | Detal -| [Base -
a ; .
Cost Item Summary ‘ £ Detail : $34.59 ‘ Y Plug : $0.00 | £ guote : $0.00 | Allocation | |Prnd||ct|m| x |
Drag columns here to group Find: | [Search For...] Saved views: Qty Driven
Hourly
Row . ) Quantity Waste % ! Unitof Duration Driven Resources Resources
Number = Code Resource Assembly Description (Less Waste) Add-on Quantity Measure
Customize Display
1 MPR35 Pipe RCP 36 In 1,000.00 0.00 1,000.00 | Linear Feet . o .
2| MASAND sand 10111 0.00 10111 Ton
Shifts: 0.00 0.00
> 3 MAFA Fine Aggregate 384.13 0.00 384.13 Ton
4| MACAL.. Coarse Agaregate ... 2,153.15 0.00 2,153.15 Ton LIDUE .o 4 o0
* Man-Hours: 0.00 0.00
Equip-Hours: 0.00 0.00
LF/Day: 0.00 0 v
« >
- a = -
& B 8.2 = 4 =

Congratulations, you have completed this exercise!
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14.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

MeJg= The resulting field value is stored without the arithmetic expression used to calculate the
value.

Step by Step — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
2. Scroll to find cost item 13.3 Sandblast.
3. Click in the Forecast (T/0) Quantity field.

e = poaith - — I e N
= 13 Paint Existing Steel Bridge Structure 1.00  Lump Sum
+ 131 Setup Equipment 1.00  Lump Sum
+ 13.2 Wash-Remove-Dispose of Water 25,000,000 Sgquare Feet
, 5
+ 13.4 Apply Primer 25,000.00 | Square Feet
+ 13.5 Paint Top Coat 25,000,000 | Square Feet

4. Press the = key, then type 10*250.
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2 13 Paint Existing Steel Bridge Structure 1.00 ' Lump Sum
+ 131 Setup Equipment 1.00  Lump Sum
+ 13.2 Wash-Remove-Dispose of Water Square Feet

+ 13.4 Apply Primer 25,000,00  Sguare Feet

5. Press the Tab key and it calculates the result.
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Lesson 14 Review

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks
C. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate values.
a. Trench
b. Pipe
C. Bedding
d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b
C. =
d

Lesson 14 Summary

As a result of this lesson, you can:

e Use the Haul Calculator
e Use the Trench Calculator

e Use the In-Field Calculator
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